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Chapter 1
Introduction

This chapter contains a description of the main features, 
delivery options and software applications provided with 
the TDS800.
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About this manual

This manual contains the following chapters.

Chapter 1: Introduction  contains a general introduction to the Océ TDS800 
system, including a general description of the main features, delivery options 
and software applications provided with the system. Contains a description of 
how to turn the Océ TDS800 on and off.

Chapter 2: Using the Océ TDS800 to print  contains a description of the 
actions that can be performed on the printer operator panel of the Océ TDS800.

Chapter 3 Using the Océ TDS800 to copy  contains a description of the actions 
that can be performed on the scanner operator panel of the Océ TDS800 
including the basic copy functions that are available from the system.

Chapter 4: Using the Océ TDS800 to scan  contains a description of how to 
scan originals to a file.

Chapter 5: Special copy and scan jobs  contains a detailed description of 
special copy functions to be performed on the Océ TDS800.

Chapter 6: Océ Power Logic®: Settings Editor  contains information about the 
Océ Settings Editor. For details about specific settings, refer to the Help on the 
Océ Settings Editor.

Chapter 7: Océ Power Logic®: System Control Panel  contains a description 
of how to view the system status of the Océ TDS800.

Chapter 8: Océ Power Logic®: Queue Manager  contains a description of how 
to view the Océ TDS800 print queue and how to abort the active print, how to 
delete and pause print jobs in the queue and how to restart jobs that are put on 
hold.

Chapter 8: Océ Power Logic®: Remote Logic  contains a description of the 
installation and the functionality of the Océ TDS800 remote controller 
applications.

Chapter 10: Océ Power Logic®: Account logging  contains a description of 
how to use the account logging functionality to track jobs for specific users and 
accounts.
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Chapter 11: Océ Print Exec® LT Web  contains a description of the job 
submission application which allows you to send print jobs to a printer from 
your web browser.

Chapter 12: The folder  contains a description of the folder delivered as an 
optional feature with the Océ TDS800.

Chapter 13: Media and supplies  contains a description of regular maintenance 
tasks, such as loading paper, adding toner, and changing tape in the 
reinforcement unit.

Chapter 14: Maintenance  contains a description of how to clean the glass 
platen, the reference roller and how to maintain the reinforcement unit.

Chapter 15: Problem solving  contains a description of the problems that may 
occur while using the Océ TDS800.

Appendix A: Overview and tables  contains an overview of the system, the 
operator panels, the product specifications for the Océ TDS800, a list of 
available material types and sizes, and a list of formats included in the paper 
series.

Appendix B: Safety information  contains the recommended weight limits, 
instructions for safe use, the available safety data sheets and the applicable 
ENERGY STAR® specifications.

Appendix C: Miscellaneous  contains the notation conventions, a reader’s 
comment sheet and the addresses of local Océ organizations.

Index  indicates where you can find the most commonly used terms in the 
manual.
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The Océ TDS800

The Océ TDS800 is a wide-format, black-and-white, high-volume 
multifunctional system. The Océ TDS800 offers a broad range of print, copy, 
and scan-to-file functionality. The printer prints at a resolution of 400 dpi and 
is highly productive because of its Océ Copy Press technology. See ‘Product 
specifications Océ TDS800’ on page 247 for more information.

[1] Océ TDS800



Introduction 15

Océ TDS800 key concepts

Printer configuration  The Océ TDS800 has six media rolls, a roll loader and a 
horizontal delivery tray. A folder is optional.

Copy functionality  A large number of copy activities can be performed with 
the Océ TDS800 scanner. A wide variety of original- and copy-related settings 
are supported. Users can specify particular layout, media, finishing, feeding 
and quality enhancement options from the scanner operator panel. See 
‘Product specifications Océ TDS800’ on page 247 and ‘Scanner operator 
panel’ on page 246 for more information.

Océ Scan Logic®  The Océ TDS800 offers full hybrid performance with it’s 
optional scan-to-file functionality. Documents are scanned, then stored 
digitally. Ten customizable destinations are supported.

Adobe® PostScript® 3 /PDF  The Océ TDS800 fully supports Adobe® 
PostScript® 3 . For Japanese, 5 extra fonts are optional. They can be enabled 
with a password in the Océ Settings Editor.

Network connectivity  The Océ TDS800 supports a number of popular network 
protocols. This means that it can be used in multiple networking environments 
such as TCP/IP, NetBEUI, and Novell Pserver (IPX/SPX).

Print and copy jobs  Print and copy jobs are sent to the Océ TDS800 Printer 
from a user application (print job) or from the scanner (copy job). Print and 
copy jobs can consist of several sets, which in turn can consist of several pages. 
Sorting of a print or copy job can take place based on sets or on pages.

Set processing  The Océ TDS800 supports set processing. This means that a 
job can consist of several files or originals. You can print or scan these files or 
originals multiple times and in sorted sets. The Océ TDS800 is equipped with 
2 hard disks with a set memory for storing up to 250 A0s each. This allows for 
the creation of identical sets that are sorted either by page or by set. See also 
‘Making a set copy’ on page 105.

Océ Matrix logic®  Océ Matrix Logic® is an Océ TDS800 option which allows 
you to form, in one single operation, different copy sets from one set of 
scanned originals using predefined settings. See ‘Océ Matrix Logic®’ on 
page 106.
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Spool memory  The Océ TDS800 contains a spool memory which provides a 
queuing system for files you want to print. The spool memory allows multiple 
users to send print jobs to the Océ TDS800 at the same time. The print jobs are 
then placed in the print queue, where they await printing. The first job that is 
placed the queue is printed first.

Job recovery  The Océ TDS800 is equipped with a job recovery function that 
safeguards users against data loss in case of a printer failure. After a restart, the 
data submitted to the printer before the crash is automatically processed and 
printed. This means that jobs do not have to be resubmitted after a printer 
malfunction. This saves valuable time for the users.

Green key principle  The Océ TDS800 is a very user-friendly system. The 
scanner, in particular, is very easy to operate. Basic copy jobs can be performed 
by simply pressing the green Start key on the scanner operator panel. You are 
only required to change the default copy settings if you want to perform more 
complex copy jobs, and you can do this with the help of the other settings on 
the scanner operator panel.

User interaction

The user can communicate with the Océ TDS800 both locally on the system 
and from remote locations:

Operator panels  The Océ TDS800 consists of two operator panels for making 
a wide variety of settings for printing and copying. See ‘Printer operator panel’ 
on page 245 and ‘Scanner operator panel’ on page 246 for more information.

Controller applications  The Océ TDS800 controller applications are used for 
making default key operator and system administrator settings (Océ Settings 
Editor). For viewing the status of the jobs in the print queue you use the Océ 
Queue Manager. The Océ System Control Panel shows the status of the entire 
system. 

Océ Scan logic®  With ‘Océ Scan logic®’, you can define all relevant settings 
for scan-to-file. See ‘Océ Scan Logic®’ on page 66 for more information.

Océ Remote Logic®  With Océ Remote Logic® you can perform the following 
actions from any PC connected to the network and with Océ Remote Logic® 
software installed:

� Remotely view system status (Océ System Control Panel).
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� Remotely manage print jobs (Océ Queue Manager).
� Remotely change settings (Océ Settings Editor).

Printer drivers  A number of printer drivers can be used with the Océ TDS800, 
including a Windows® raster driver, AutoCAD® ADI/HDI drivers and a 
PostScript® driver. With these drivers, users in remote locations can print their 
files directly from their applications to the Océ TDS800. More information 
about installing, configuring and using drivers can be found in the 
documentation provided with the drivers. All Océ drivers can be freely 
downloaded from the Internet at www.oce.com.

Easy print submission through FTP  The Océ TDS800 supports printing with 
FTP. You can print files via FTP from a command line prompt, an FTP 
application, or from an Internet browser. The following Internet browsers 
support dragging and dropping of files:

� Netscape® Navigator 4.x
Drag the jobs into the Jobs folder on the FTP site of your Océ TDS800. The 
jobs will appear in the print queue on the Océ Queue Manager.

The following Internet browsers support copying and pasting of files:

� Netscape® Navigator 4.x
� Microsoft® Internet Explorer 5.5
Paste the jobs into the ‘Jobs’ folder on the FTP site of your Océ TDS800. The 
jobs appear in the print queue on the Océ Queue Manager.

Océ Print Exec® LT Web  Océ Print Exec® Light Web is optional software 
which allows you to create and send a set of files to the Océ TDS800. You can 
send jobs from your workstation using your web browser. See also chapter 11, 
‘Océ Print Exec® LT Web’ on page 169. You can use Océ Print Exec® Light 
Web to connect to any Océ TDS printer. 
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Océ TDS800 users

On the Océ TDS800, the following user types can be identified:

System administrator  The Océ TDS800 system administrator is responsible 
for installing and configuring the Océ TDS800 in its environment. He defines 
the printer language settings, pen settings and Automatic Language Sensing 
(ALS) settings. The system administrator can also provide assistance to normal 
users who need to install the printer drivers on their workstations. 
Configuration information can be found in the Océ TDS800 Connectivity 
Manual provided with the Océ TDS800.

Key operator  The Océ TDS800 key operator is responsible for the daily 
maintenance of the Océ TDS800. The key operator adds toner when necessary, 
loads media as needed and defines the default printer settings for recurring 
print jobs. Also, the key operator defines all time settings, such as panel 
time-out and sleep mode time-out. See ‘Océ Power Logic®: Settings Editor’ 
on page 109 for more information. 

Repro operator  The repro operator is responsible for the daily operations on 
the Océ TDS800. The Repro Operator settings are a subset of the Key Operator 
settings. The Repro Operator has no rights to change settings in the Océ Settings 
Editor. In the Océ Queue Manager and the Océ System Control Panel, the repro 
operator has the same user rights as the Key Operator and System Administrator.

Anonymous user  Typically, an anonymous user on the Océ TDS800 can be 
either a PC user who has remote access to the system through one or more 
drivers (Windows® raster driver, AutoCAD® ADI/HDI drivers or PostScript® 
driver) or Océ Remote logic® (Océ Queue Manager, Océ System Control 
Panel and Océ Settings Editor), or a user performing a copy job at the scanner.

Service operator  The Océ TDS800 service operator is responsible for 
installation and maintenance of the Océ TDS800. 
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Océ TDS800 components

The Océ TDS800 is available as a digital network printer, or as a full 
combination with a scanner which can print, copy or scan to file. The Océ 
TDS800 consists of the following components (see figure 1 on page 14):

� Printer
� Scanner
� Océ Power Logic® Controller

These components, in combination with your network, Océ Print Exec® LT 
Web and one or more drivers (Windows® driver, AutoCAD® HDI or 
PostScript®), allow you to use the Océ TDS800 as your default enterprise print 
and copy solution.

See the Connectivity Manual for more details about network settings for the 
Océ TDS800 printer. You can find more information about installing, 
configuring and using drivers in the documentation provided with the drivers.

Note: All drivers for the Océ TDS800 can be freely downloaded from the World 
Wide Web at www.oce.com.

Océ TDS800 printer

The Océ TDS800 printer has the ability to hold six rolls of media. In standard 
configuration the printer delivers your jobs on the output delivery tray.

The Océ TDS800 printer has the following options:
� a folder to fold the output.
� a reinforcement unit to add a reinforcement strip.
� a punch unit to make holes on one edge.
� one or two belts to deliver neatly-stacked folded output for a longer period of 

time (useful for unattended printing).
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Océ TDS800 scanner

You use the Océ TDS800 scanner to copy or to scan to file. 

The optional original delivery tray enables you to stack your originals behind 
the scanner.

Océ TDS800 Power Logic® Controller

The Océ TDS800 is equipped with a Océ Power Logic® Controller which 
helps you to make optimum use of your system. On this Océ Power Logic® 
Controller a number of applications run which allow you to control your jobs, 
make your default job settings and monitor the system status. These 
applications include:

� Océ Queue Manager (QM)
� Océ System Control Panel (SCP)
� Océ Settings Editor (SE)
� Océ Scan Manager and Océ View Station LT (optional)
� Océ Remote Logic®, includes QM, SCP and SE on a remote workstation 

which connects to the Océ Power Logic® Controller. Océ Scan Manager and 
Océ View Station LT do not run on Océ Remote Logic®.

Océ Queue Manager  The Océ TDS800 Océ Queue Manager (QM) application 
provides you with a graphical representation of the print queue. It allows you 
to view the print queue and the status of the print and copy jobs as well as to 
manage the jobs in the queue. With the Océ Queue Manager you can:

� View the print queue.
� View the inbox queue
� View the history queue
� Abort the job currently being printed
� Give jobs a priority in the print queue
� Delete jobs in the print queue, inbox queue, and history queue
� Pause jobs in the print queue
� Restart previously paused jobs in the print queue
� Print jobs from the inbox queue
� Reprint jobs from the history queue
� Change number of sets for jobs in the history queue
� View the properties of jobs in the print queue, inbox queue, and history 

queue.
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See ‘Managing print jobs’ on page 137 for more information about the Océ 
Queue Manager.

Océ System Control Panel  The Océ System Control Panel (SCP) application 
provides you with status information about the printer. This includes:

� Status of the Océ TDS800 printer and scanner
� Set memory monitor to view the available storage space on the controller.
� Overview of the loaded media types and sizes.

See ‘Océ Power Logic®: System Control Panel’ on page 125 for more 
information about the Océ TDS800 System Control Panel.

Océ Settings Editor  The Océ Settings Editor consists of 2 sets of settings, the 
key operator settings and the system administrator settings. 

The key operator settings allow the key operator to configure and set up job, 
printer, system and scanner specific settings. These settings include:

� Format options
� Editing options
� Media-related options
� Finishing options

See ‘Océ Power Logic®: Settings Editor’ on page 109 for more information 
about the Océ TDS800 Settings Editor application.

The system administrator settings allow the system administrator to configure 
and set up all aspects related to the infrastructure of the system. These settings 
include:

� Host information
� Network settings
� Pen settings
� Printer language settings
� General administrator settings

See ‘Océ Power Logic®: Settings Editor’ on page 109 for more information 
about the Océ TDS800 Settings Editor.
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Optional features:  you can order the following options for the Océ Power 
Logic® Controller:
� Océ Scan Logic® consists of Océ Scan Manager and Océ View Station LT. 

With Océ Scan Logic® you can perform scan to file.
� Print Exec® LT Web is a job submission application, which allows you to 

send print jobs to a destination device (Océ printer) from your web browser. 
For detailed information (see ‘Océ Print Exec® LT Web’ on page 169).

� Account Logging. Account Logging is for accounting purposes, the Océ 
Power Logic® Controller is able to keep track of all your jobs. For each job 
the job info and the paper usage is stored.

� Job templates
The job templates on the scanner operator panel give you direct access to five 
different sets of settings. You define the template settings in the Settings 
Editor. You select a template on the scanner operator panel by pressing one 
of the five function keys. The fifth template includes the last used settings on 
the scanner.

� Adobe® PostScript® 3™/PDF
� 5 additional Japanese fonts for Adobe® PostScript® 3™
� Océ Matrix Logic® 

Océ Matrix Logic® allows you to create, in one single operation, different 
copy sets from one set of scanned originals using predefined settings. See ‘Océ 
Matrix Logic®’ on page 106.
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Turning the Océ TDS800 on and off

You must the turn the Océ TDS800 printer, scanner and the Océ Power Logic® 
Controller on and off separately. You do not have to turn the Océ TDS800 
printer, scanner and the Océ Power Logic® Controller on and off in a specific 
order.

Use the key switch on the printer and scanner to turn on and off the printer and 
scanner. Use the On / off button on the Océ Power Logic® Controller to turn 
on and off the Océ Power Logic® Controller.

[2] Power switch with key in the timer position on the printer

[3] Power switch with key in the timer position on the scanner

on

off

timer

ontimer

off
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[4] Power button on the Océ Power Logic® Controller

� Turn the Océ TDS800 printer on and off

1 Turn the key to the ‘on’ position (see figure 2).
The system takes about 20 minutes to warm up. When the system is warmed 
up, the message ‘Ready to...’ appears on the printer operator panel.

2 Turn the key to the ‘off’ position (see figure 2).
Note: Before you turn off the printer, make sure that the printer is not
printing a job.

� Turn the Océ TDS800 scanner on and off

1 Turn the key to the ‘on’ position (see figure 3)
After a few seconds the ‘Ready to print’ message appears on the scanner 
operator panel.

2 Turn the key to the ‘off’ position (see figure 3).

� Start up the Océ Power Logic Controller

1 Turn on the controller and the screen. 
Once the initial system test of the controller has been performed, the 
applications, Océ Queue Manager, Océ System Control Panel, Océ Settings 
Editor and Océ Scan Manager are automatically started and the controller 
applications are ready for operation.
Note: The Océ Settings Editor is minimized to save screen estate.

Take the following actions to turn off the controller:

� Turn off the Océ Power Logic® Controller

1 Go to the Océ System Control Panel application.
2 Select the ‘Shutdown’ option from the ‘System’ menu.
3 Confirm shutdown by clicking on the ‘Yes’ button in the ‘Shut down’ window.
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The system automatically performs the shutdown procedure for the controller. 
Finally, the Windows ‘Shutdown Computer’ window appears, which informs 
you that you can turn off your computer. 
You can now restart the controller by pressing the ‘Restart’ button.
Note: Wait at least 5 seconds before you restart the Océ TDS800.

4 Turn off your computer and display.

Timers

The Océ TDS800 is standard equipped with a number of timers for energy 
saving and automatic turn on and off behavior. The timers can be configured 
in Océ Settings editor. See chapter 6, ‘Océ Power Logic®: Settings Editor’ on 
page 109 and the on-line help on the Océ Settings Editor for details. The Océ 
TDS800 has the following timers

� Low power mode timer
This timer only works for the printer. After the time defined in the Océ 
Settings Editor, the printer uses a little less power and cools down slightly.

Note: You can disable the Low power mode timer in the Océ Settings Editor.

� Sleep mode timer
This timer works for both the printer and the scanner. After the time defined 
in the Océ Settings Editor, the system receives a minimum of power. The 
screens on the operator panels turn off. The printer cools down. When you 
press a key on either of the operator panels, the printer or scanner activates. 
The printer will need to warm up before becoming operational.

Note: Do not define a Sleep mode time-out longer than 120 minutes. When a 
Sleep mode time-out longer than 120 minutes is defined, the system will use the 
factory default time-out.

� Shut-off timer
This timer works for both the printer and scanner. After the time defined in 
the Océ Settings Editor, the system will turn off entirely. This timer only 
works when the keys in the power switch on the printer and scanner are set 
to the timer position.

� Wake-up timer
This timer works for both the printer and scanner. At the time defined in the 
Océ Settings Editor, the system turns on automatically. This timer only 
works when the keys in the power switch on the printer and scanner are set 
to the timer position.
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Figure 5 on page 26 shows the flow of the timers under the following 
conditions:

� The system remains idle for the period defined in the Océ Settings Editor.
� Configure the timers in the Océ Settings Editor.
� The power switches of the printer and the scanner are set to the timer position 

(Shut-off timer and Wake-up timer only)

Under these conditions the timers work in a circular way. When you use this 
automatic flow of the Océ TDS800 timers, the system will be warmed up and 
ready for operation when you need it and will make economic use of power.

[5] The automatic flow of the Océ TDS800 timers.

The Océ TDS800 printer 
and scanner are 
standby

The Océ TDS800 printer 
is in low power mode

The Océ TDS800 
printer and scanner 
are in sleep mode

The Océ TDS800 printer 
and scanner turn 
themselves off

The Océ TDS800 
printer and scanner 
turn themselves on
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� How to configure the automatic shut-off and wake-up timers

1 Use the shut-off, time-out setting in the Océ Settings Editor to define after how 
many minutes of inactivity the printer and scanner should turn off.

2 Use the ‘First working day’ and ‘Last working day’ settings in the Océ Settings 
Editor to define on which days of the week the printer and scanner 
automatically wake up.

3 Use the wake-up ‘Time’ setting in the Océ Settings Editor to define the 
wake-up time of the scanner and the printer on working days.

� How to enable the automatic shut-off and wake-up timers on the printer and 
scanner

1 Turn the key to the ‘off’ position. See figure 2 on page 23 and figure 3 on 
page 23.
The Océ TDS800 turns off.

2 Turn the key to the ‘timer’ position. See figure 2 on page 23 and figure 3 on 
page 23.
The Océ TDS800 turns on at the time and day defined in the Océ Settings 
Editor.

Note: The timers must be enabled separately on both the scanner and the 
printer.

Before you enable the timers, you must first turn the system off by turning the 
key to the ‘Off’ position. When you then turn the key to the ‘timer’ position, 
the system checks the timer settings defined in the Océ Settings Editor and 
determines whether it must wake-up or remain off.

Note: The timer settings are stored local on the printer and the scanner. When 
the controller is turned off, the timers still function as configured on the Océ 
Settings Editor.

Before you enable the automatic shut-off and wake-up timers, it is possible to 
force the system to turn off. 
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� How to force turn off

1 Turn the key to the ‘off’ position. See figure 2 on page 23 and figure 3 on 
page 23.
he Océ TDS800 turns off

2 Turn the key to the ‘timer’ position. See figure 2 on page 23 and figure 3 on 
page 23.
Based on timer settings defined in the Océ Settings Editor the determines 
whether it must wake up or remain off.

3 When the system wakes up, wait until the systems starts warming up.
Press any key on the operator panel to start warm-up.

4 Turn the key to the ‘off’ position. See figure 2 on page 23 and figure 3 on 
page 23.
The Océ TDS800 turns off.

5 Turn the key to the ‘timer’ position. See figure 2 on page 23 and figure 3 on 
page 23
The Océ TDS800 remains turned off regardless of the timer settings defined in 
the Océ Settings Editor. The Océ TDS800 wakes up on the next working day 
at the time defined in the Océ Settings Editor. 
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Chapter 2
Use the Océ TDS800 to print

This chapter contains a description of the Océ TDS800 
printer functionality.
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Before you begin

You must turn on both the Océ TDS800 printer and the Océ Power Logic® 
Controller before you can print. See ‘Turning the Océ TDS800 on and off’ on 
page 23.
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How to print

See ‘User interaction’ on page 16 for information about how to print to the Océ 
TDS800.
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Printer operator panel

The printer operator panel consists of a number of keys and a graphical display 
(see figure 6). At the top of the panel is an attention light which starts flashing 
when operator intervention is required.

[6] Printer operator panel

Select a language

On the operator panel of the Océ TDS800 Printer you can specify which 
language you want to use for displaying printer information, such as status and 
error messages.

By default, you can choose between two languages, which have been defined 
for your system by the key operator. The Océ TDS800 supports a total of 16 
languages. See chapter 6, ‘Océ Power Logic®: Settings Editor’ on page 109 
and the On-line Help on the Océ Settings Editor. 

Note: If the key operator has specified only one language, it will not be possible 
for you to choose. In that case, the language option will not appear on the 
operator panel.

Ready to print

1 A1 Paper
3 A0 Paper
5 36 Paper

2 A2 Paper
4 A3 Paper
6 A0 Paper
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� Selecting a language

1 Press the ‘On-line’ key on the printer operator panel to take the printer 
Off-line. The message ‘Off-line’ is displayed in the status window.

2 Press the left selection key to shift the focus to the Language option.
A shadow effect is used to indicate that the focus is set to this option.

3 Activate the Language option by pressing the right selection key.
The dotted line around the current selection changes to a solid line and the 
small selection triangles next to the specified language are no longer dimmed.

4 Use the arrow keys to switch between the predefined languages.
5 The language-specific elements on the display are immediately customized to 

reflect your language choice. Only the indicator for the language itself is in the 
alternative language. This way you always know what your alternative 
language is.

6 Put the printer On-line again by pressing the ‘On-line’ key. The printer now 
uses the selected language.

Display

The graphical display offers feedback about the current printer status. It 
provides you with the following information: 

� Status information (e.g. ‘Preparing for run’, ‘Ready to print’, ‘Warming up’).
During normal operation, the following message types may appear: 
Status/action message: indicates the actual status of the printer, plus the 
action to be taken, e.g. ‘Roll empty. Feed A2, plain paper’.
Warning message: during a warning message the printer will continue to 
operate, but it is possible that the print quality is not optimal, e.g. ‘Fill E1 
toner’.
A graphical overview of available rolls and manual feeds, including the 
material type and size used by each roll or manual feed.

� An indication that a particular roll is empty.
An empty roll is represented by a dotted roll symbol.

� In the event of an error, a graphical representation of any error location 
(cover or panel) is displayed, along with instructions on how to solve the 
problem.



34 Océ TDS800 User Manual

Counter

On the operator panel of the Océ TDS800 Printer a counter will be displayed 
that gives the user feedback about the progress of the job that is currently being 
printed. The counter, which is located at the bottom of the upper window on 
the operator panel, displays the number of sets and the pages printed. Counting 
starts at 1. The following options are available:

� If no sets are being made, only the current page and the total number of pages 
are displayed (e.g. ‘Page 3 of 5’). At the beginning of a job, while the system 
still does not know the total number of pages, only the current page may be 
displayed (e.g. ‘Page 5’).

� With set input: set counter. In this case, the counter shows the current set, the 
total number of sets and the current page (e.g. ‘Set 3 of 5, Page 10’). At the 
beginning of a job, while the system still does not know the total number of 
sets, only the current set and page may be displayed (e.g. ‘Set 2, Page 5’).

� With set input: multiple sheet counter. In this case, the counter shows the 
current page, the total number of pages and the current copy, e.g. ‘Page 2 of 
12, Copy 5’). At the beginning of a job, while the system still does not know 
the total number of pages, only the current page and copy may be displayed 
(e.g. ‘Page 2, Copy 5’).

� With set input: Océ Matrix logic®. In this case, the counter shows the current 
set, the total number of sets and the current page (e.g. ‘Set 3 of 5, Page 10’). 
At the beginning of a job, while the system still does not know the total 
number of sets, only the current set and page may be displayed (e.g. ‘Set 2, 
Page 5’).

 

Keys

You can use the keys on the operator panel to specify a number of settings for 
the Océ TDS800 Printer, such as the media type and size or the preferred 
language.
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The following keys are available: 

Key types
Key Function

Selection
keys

The selection keys are located immediately below the graphical 
display. The left key can be used to activate one of the main menu 
choices (Language, Folding or
Media) on the left part of the display. 
Note: A shadow highlighting effect is used to indicate the active 
menu option.
The right selection key can be used to activate the options on the 
right part of the graphical display.
Note: To identify the active selection, the dotted line around the 
selection changes to a solid line and the small selection triangles 
next to the specified option are no longer dimmed.
These selection triangles indicate that you can select an option 
from a predefined list with the help of the arrow keys.

Arrow
keys 

These two triangular keys to the right of the graphical display are 
used to display the next or previous option from the selected menu 
choice, and to select the desired option.

On-line key By pressing the On-line key you can take the printer On- or 
Off-line. If the green light above the On-line key is on, the printer 
is On-line; if this light is off, the printer is Off-line.

Stop key The red Stop key is used to stop the present print job. After this 
key is pressed, a dialog box is displayed asking for confirmation.

Note: The printing process does not stop instantaneously, since a 
number of prints may already have been submitted to the printer 
after processing. The prints cannot be stopped.

Extra key This key is reserved for future use.
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Printer operator panel actions

On the Océ TDS800 printer operator panel you can perform a number of 
actions: 
� Set the media type
� Set the media type for manual feed
� Set the media size
� Set a special media indication
� Stop a print job
� Select the preferred languages
� Clean the reinforcement knives

Media types and sizes on the printer

One of the features of the Océ TDS800 printer is the automatic media change 
function. This function enables the printer to switch to another roll of the same 
media when there is not enough media on the current roll to finish the print run.

Specify media type and size after you load media, as described in ‘Media and 
supplies’ on page 189. The Océ TDS800 supports both DIN and ANSI media 
formats.

See ‘List of available material types and sizes’ on page 255 for an overview of 
all materials that can be used on the Océ TDS800 Printer. See‘Overview of 
paper series’ on page 256 for formats included in the paper series.
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� Set media type

1 Press the ‘On-line’ key on the printer operator panel to take the printer 
Off-line. The message ‘Off-line’ is displayed in the status window.

[7] The Printer Operator panel in Off-line mode

The focus shifts to the Media option (indicated by the shadow effect).
2 Use the arrow keys to select the roll or manual feed for which you have just 

loaded new media.
3 Press the right-hand selection key to activate the Mat. (Material) option.

The dotted line around the current selection changes to a solid line and the 
small selection triangles next to the specified material are no longer dimmed.

4 Use the arrow keys to select the material you just loaded.
5 Press the ‘On-line’ key to take the printer On-line again. The printer now 

knows which material is used for the specified roll or manual feed.

� Set media type for manual feed

1 Press the ‘On-line’ key on the printer operator panel to take the printer 
Off-line. The message ‘Off-line’ is displayed in the status window.

2 Press the left selection key to shift the focus to the Media option.
A shadow effect is used to indicate that the focus is set to this option.

3 Use the arrow keys to select the Manual option.
4 Press the right-hand selection key to activate the Mat. (Material) option.

The dotted line around the current selection changes to a solid line and the 
small selection triangles next to the specified material are no longer dimmed.

5 Use the arrow keys to select the material you just loaded.
6 Press the ‘On-line’ key to take the printer On-line again. The printer now 

knows which material is used for manual feed.

Ready to print

1 A1 Paper
3 A0 Paper
5 36 Paper

2 A2 Paper
4 A3 Paper
6 A0 Paper
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� Set media size

1 Press the ‘On-line’ key on the printer operator panel to take the printer 
Off-line. The message ‘Off-line’ is displayed in the status window (see 
figure 7).

2 Press the left selection key to shift the focus to the Media option.
A shadow effect is used to indicate that the focus is set to this option.

3 Use the arrow keys to select the roll or manual feed for which you have just 
loaded new media.

4 Press the right selection key to activate the Size option.
The dotted line around the current selection changes to a solid line and the 
small selection triangles next to the specified size are no longer dimmed.

5 Use the arrow keys to select the size for the media you just loaded.
The printer shows both DIN and ANSI sizes. Select the correct format.

6 Press the On-line key to take the printer On-line again. The printer now knows 
which media size is used for the specified roll or manual feed.

Special media indication

On the Océ TDS800 Printer, you can attach a Special indication (exclamation 
mark:!) to a roll or manual feed which uses special media (for instance colored 
paper). This indication is used to identify the roll or manual feed to the printer. 
For this roll or manual feed the automatic media change option is disabled.

� Set a special media indication

1 Press the ‘On-line’ key on the printer operator panel to take the printer 
Off-line. The message ‘off-line’ is displayed in the status window (see figure 7 
on page 37).

2 Press the left selection key to shift the focus to the Media option.
A shadow effect is used to indicate that the focus is set to this option.

3 Use the arrow keys to select the roll or manual feed for which you have just 
loaded special media.

4 Press the right selection key to activate the ‘Type’ option.
The dotted line around the current selection changes to a solid line and the 
small selection triangles next to the specified type are no longer dimmed.

5 Use the arrow keys to select the Special option for the specified roll or manual 
feed.

6 Press the ‘On-line’ key to take the printer On-line again. The printer now 
knows that the specified roll or manual feed contains special material.
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Stop a print job

The red ‘Stop’ key on the Océ TDS800 Printer operator panel interrupts the 
active print process. You can cancel or continue the current print job.

� Canceling a print job

1 Press the ‘Stop’ key. 
A dialog is displayed informing you that you can press ‘On-line’ to continue 
or press the ‘Stop’ key to cancel the job.

2 Press the ‘Stop’ key again to cancel the current job.
Note: Printing is stopped at the end of a page. Started prints are finished.

� Continue a print job

1 Press the ‘Stop’ key. 
A dialogue is displayed informing you that you can press ‘On-line’ to continue 
or press the ‘Stop’ key to cancel the job.

2 Press the ‘On-line’ key to continue the current print job
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Chapter 3
Using the Océ TDS800 to copy

This chapter contains a description of the interface of the 
Océ TDS800 scanner and the copy functionality on its 
operator panel.
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Before you begin

You must turn on both the Océ TDS800 scanner and the Océ Power Logic® 
Controller before you can perform copy jobs. See ‘Turning the Océ TDS800 
on and off’ on page 23.
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Scanner operator panel

Press the green Start key on the scanner operator panel to start the original 
transport on the scanner. To perform more complex copy jobs, change the 
default settings on the scanner operator panel.

The scanner operator panel is located above the original feed. As you can see 
in figure 8 on page 43. The panel consists of a display in the center surrounded 
by a number of function, section and ‘Arrow’ keys. To the left of the display, 
you will find the Stop and Job interrupt keys and below the display you will 
find the Start, Numeric and Correction keys.

This section consists of two parts. The first part explains the basic use of the 
keys. The second part deals with special uses of the display. It describes how 
to use the soft keys located above and along the sides of the display to define 
your copy settings.

.

[8] Scanner operator panel

1 2
3

4 5

6789121314

10
9
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1 The exposure control
2 The display
3 The Section keys
4 The Arrow keys
5 The Media selection keys
6 The Manual feed key
7 The Auto roll key
8 The Correction key
9 The Stop key

10 The Job interrupt key
11 The Numeric keys
12 The Function keys
13 The numeric display
14 The Start key

Exposure control  The exposure control is located on the left side of the 
operator panel. The scale displays the current exposure rate. Control the 
exposure with the keys. More exposure makes the output darker. Less exposure 
makes the output lighter.

The Media selection keys  There are 6 Media selection keys, one for each roll. 
Press the Media selection key to select the roll with the required format and 
media type.

The Manual feed key  If you want to copy on a material type or size that is not 
available in one of the roll compartments, press the manual feed key. The key 
is located on the right section of the operator panel.

The Auto roll key  If you select auto roll, the Océ TDS800 will try to use a roll 
format that matches the original size. After inserting the original, the roll that 
is used is indicated on the operator panel.

When auto roll is selected, the Océ TDS800 will look for a matching roll of the 
‘Standard’ copy material. If such a roll is not found, it will try to find a 
matching roll of another type of material. The Key Operator can define the 
‘Standard’ copy material.

When automatic zoom is selected on the display of the operator panel, together 
with auto roll, the size of the matching roll does not necessarily have to be the 
same as the size of the original.
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The Correction key  The orange key marked with C is located at the bottom of 
the central section of the operator panel. Press the Correction key one time to 
reset the selected setting to its default value. Press the Correction key two times 
to reset the numeric display to ‘1’. Press the Correction key three times to 
return to the first screen on the display.

The Stop key  Press this red key to Stop the job. For more information see 
‘Stopping a job’ on page 60.

The job interrupt key  You use the Job interrupt key to set extra priority to your 
copy job or to remove extra priority from your copy job. Determine the priority 
of your copy job with the Job interrupt key before you scan your originals. The 
job is placed at the top of the printing queue in the queue manager. The 
interrupt job will start running immediately after the currently printing job is 
completed. No new job is sent to the printer.

The Numeric keys  The keys with numbers on the lower part of the middle 
operator panel are used to specify numbers. Values you can set with the 
numeric keys include: the number of copies or sets up to a maximum of 999, 
zoom factor, user id, and account id.

The ‘numeric display  Displays the number of sets or copies, set with the 
numeric keys.

The Start key  Use the green Start key to start the feeding of the original, to 
restart the scan process or for other purposes such as to mark the end of a set.
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Section, Function and Arrow keys

The operator panel of the Océ TDS800 scanner contains a number of other 
keys in addition to those already mentioned. These include:
� Section keys
� Function keys
� ‘Arrow’ keys.

The Section keys are the four keys located above the display. These keys 
provide access to the ‘Custom’, ‘Original’ and ‘Copy’ sections on the display. 

Each section contains several function cards. These can be accessed with the 
help of the left most Function key.

The five “Function’ keys below the display allow you to select functions or 
subfunctions within a card. 

Finally, the ‘Arrow’ keys can be used, like the Numeric keys, to define numeric 
settings. The ‘Arrow’ keys can be used to increase or decrease the active value 
by 1; the left ‘Arrow’ and right ‘Arrow’ keys can be used to increase or 
decrease the active value by 10. Exception to this rule is the selection of zoom 
values. Here, the left ‘Arrow’ key can be used to browse through the predefined 
reduction steps and the right ‘Arrow’ key to browse through the predefined 
enlargement steps. 

The ‘Arrow’ keys are also used for selecting subfunctions. 
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Sections on the display of the scanner operator panel

The display of the operator panel of the Océ TDS800 scanner consists of the 
following sections:
� Custom
� Original
� Print
� File

Custom section  When the Océ TDS800 scanner is started up, a number of 
default settings are available from the ‘Custom’ section. These settings, which 
can also be found in one of the other two sections, are the most commonly used 
options on the Océ TDS800 scanner. The key operator can change the contents 
of the ‘Custom’ section from the Océ Settings editor on the controller.

By default, the ‘Custom’ section includes the ‘Media’, ‘Input mode’ and 
‘Zoom’ settings, plus one or two others. Depending on your configuration and 
language settings, these could be the ‘Folding’ (if you have a folder), 
‘Language’ (if you work with more than one language) or ‘Exposure’ settings. 
See figure 11 on page 49 for an example of the ‘Custom’ section.

Original section  The ‘Original’ section contains all original-related settings, 
distributed among a number of cards. The following cards are available (top to 
bottom):
� Scanner
� Image
� Sheet
� Feeding

Each card contains a number of specific options, as shown below.

[9] Feeding card of the Original section of the Océ TDS800 scanner
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Print section  The Print section contains all print-related settings divided over 
a number of cards. The following cards are available (top to bottom):
� Image
� Layout
� Finishing
� Sheet

Each card contains a number of specific options, as shown in figure 10 on 
page 48.

[10] Print section of the Océ TDS800 scanner

The File section  The ‘File’ section contains all scan-to-file related settings. 

Note: The file section is only available if you have the scan-to-file option 
installed.

Changing the operator panel language

It is possible to change the operator panel language. You can choose between 
two preferred languages. Define the first and second language on the Océ 
Settings Editor. The Océ TDS800 supports a total of 16 languages. See 
chapter 6, ‘Océ Power Logic®: Settings Editor’ on page 109 and the On-line 
Help on the Océ Settings Editor.

� Selecting a language

1 Open the ‘Scanner’ card in the ‘Original’ section.
2 Press the ‘Language’ function key to specify the required language.
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Settings on the Océ TDS800 scanner operator panel

If job templates are enabled in the Océ Settings Editor, the job templates are 
displayed upon start-up of the Océ TDS800 scanner. If job templates are not 
enabled in the Océ Settings Editor, the ‘Custom’ section (see figure 12) is 
displayed upon start-up.

The custom section  gives access to the settings you defined in the Océ 
Settings Editor. This contains a number of directly accessible settings. The key 
operator defines the custom section in the Océ Settings Editor.

[11] The custom section on the scanner operator panel

The job templates  With the job templates option installed, the top level of the 
user interface is the template level. On the template level the user can select one 
of five Job Templates. Each template corresponds to a predefined set of 
settings. 

One of the Job templates is the ‘last used’ template, which corresponds to the 
settings used for the previous job. ‘Last used’ is only available after the first 
job is completed. ‘last used’ is not available when you turn on the scanner. 

The content of the other four templates can be defined by the Key Operator in 
the Océ Settings editor. In the Océ Settings Editor, the Key Operator can enter 
a name and a description of the job template. The name has a maximum length 
of two lines. The description has a maximum length of four lines. The name 
and description of the job templates, entered in the Océ Settings Editor, are 
shown on the job template level of the user interface of the scanner operator 
panel. 
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[12] The templates on the scanner operator panel

� Defining settings

1 Select a template (only applies when job templates on the scanner operator 
panel are enabled in the Océ Settings Editor).

2 Press one of the Section keys to activate the desired menu.
Note:  The active menu shifts downwards slightly to visually separate it 
from the other menus. In addition, a shadow highlighting effect is used for 
extra highlighting.

3 Press the Selection key to select the appropriate card. You can switch cards 
(from bottom to top) by pressing the key again.
Note: Here, too, the active card is visually separated from the other cards 
and given a shadow highlighting effect for extra highlighting.

4 Select the desired function values in one of the following ways:
� Simple (non-numeric) selection: press the Function key to activate the 

desired (non-numeric) value. The selected value is preceded by a ‘�’ symbol. 
� Long list selection: if you want to select a value from a list of options that 

cannot be fully displayed on the panel, you must first activate the selection 
triangles next to the specified option (the dotted line around this selection 
changes to a solid line and the selection triangles are no longer dimmed), 
which indicate that there are additional options available, and then select one 
of the non-displayed values with the ‘Arrow’ keys. The ‘Original type’ 
setting demonstrated in figure 9 on page 47 is an example of this.

� Numeric selection: activate the selection triangles and select the desired 
value with the ‘Arrow’ keys or with the numeric keys. 

A combination of simple selection and numeric selection is also possible.
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The Correction key  use the Correction key to do the following:

1 Press the Correction key once to return to the default value of the active setting.
2 Press the Correction key twice to set the numeric display to 1.
3 Press the Correction key three times to return to the top layer of the Scanner 

Operator Panel. If job templates are enabled in the Océ Settings Editor, the top 
layer shows the job templates. If job templates are not enabled in the Océ 
Settings Editor, the top layer shows the ‘Custom’ section.

When ‘Automatic feed’ is selected for a single sheet job, this setting stays 
active.

Job interrupt only stays active for one job. You must press the Job interrupt key 
before each new job to which you want to assign interrupt priority.

The Scanner Operator Panel will automatically return to the top layer and the 
default settings after the time defined in the ‘Panel Time-out’ setting in the Océ 
Settings Editor.
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Performing basic copy jobs

On the Océ TDS800 scanner operator panel you perform a number of basic 
tasks. These include:
� Making copies
� Selecting the required media
� Selecting the input mode
� Specifying the zoom factor
� Defining settings for the next original
� Defining delivery of copies
� Stopping a copy job

Making copies

1 Place your original face-up, left aligned along the original guide. Keep the 
legend at your left hand side.
Note: When you feed the original, keep it in place until it is transported 
(about 1 cm) into the machine.

[13] Insert the original

2 Specify the number of copies using the numeric keys. 
3 Specify the ‘Paper series’ on the ‘Sheet’ card in the ‘Original’ section.
4 Specify the desired media on the operator panel. 

If you select ‘Automatic’ the Océ TDS800 will try to use a roll format that 
matches the specified size.
Select a specific roll to use the media you want.
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If you select ‘Automatic’, the Océ TDS800 will use a zoom factor that is 
needed to obtain a copy without loss of information. After inserting the 
original, the zoom factor that is used is indicated by the ‘�’ symbol. 
Note: The zoom factor is based on the selected media size.

5 Specify the desired brightness on the operator panel. 
You can use the ‘Brightness’ setting to correct for a lighter or darker original.

6 Specify a reduction or enlargement factor on the operator panel by using the 
‘Zoom’ function.

7 Specify folding options on the operator panel. 
If the optional folder is installed, you can use the ‘Folding’ settings to get a 
neatly folded copy. 

8 Press the green start key to start the copy job.
Your original will be fed into the scanner. The printer starts.

9 Collecting your output.
Your copy will be delivered to the selected output unit of the print engine.

Select the required media

The ‘Media’ setting can be used to select media and format. The display will 
show you what media rolls are currently loaded. If you select ‘Automatic’, the 
Océ TDS800 will try to use a roll that matches the original size. After inserting 
the original, the roll that is used is indicated by a LED that is on.

Note: The LED remains on until a new original is inserted.

Select the media type and paper series on the scanner operator panel. First 
select the paper series, then select the media size. Only the media in the defined 
paper series are available.

(see table  on page 256).

Attention: Selecting another paper series than is actually loaded on the 
printer can cause information loss on the output.
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� Select the paper series

1 Select the ‘Sheet’ card in the ‘Original’ section
2 Select the required paper series with the ‘Paper series’ function key

[14] Selecting the required paper series

� Selecting the required media

1 Select the one of the six rolls on the scanner operator panel.
The corresponding LED turns on.

Access to
ial

Access to
Page

interrupt
job
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Select the input mode

You can use the ‘Input mode’ setting to specify how a job will be sorted: the 
‘Single sheet’ option treats each sheet as a separate job. ‘Multiple sheets’ 
produces the specified number of copies for each sheet in a job and then 
continues with the next sheet. Graphically, this has the following appearance:

[15] The principle of ‘Multiple sheets’

‘Set’ produces one copy for each sheet in a set and then continues with the next 
copy of the entire set, as follows:

[16] The principle of 'Set’

See ‘Making a set copy’ on page 105.

The input mode Matrix copy enables you to create several print jobs out of one 
scanned set. See chapter , ‘Océ Matrix Logic®’ on page 106.

The current input mode can be closed by pressing the Stop key.

The currently selected input mode is indicated by the ‘�’ symbol.

� Selecting the input mode

1 Select the ‘Feeding’ card in the ‘Original’ section.
2 Select the input mode with the ‘Input mode’ function key.

1 1 1 2 2 2 3 3 3 4 4 4

1 2 3 1 2 3 1 2 3 1 2 3
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[17] Selecting the input mode

Note: You can also select the input mode from the ‘Custom’ section (if this 
setting has been defined for this).

Specify the zoom factor

You can use the ‘Zoom’ setting to select a zoom factor. 

� Selecting the zoom factor

1 Select the ‘Image’ card in the ‘Print’ section.
2 Select Automatic, 1:1, or set the zoom factor on the display of the operator 

panel

� Automatic zoom selection: the system automatically calculates the zoom 
ratio based on the original size and the output media size

� 1:1: Results in an image that is exactly the same size as the original.
� Set the zoom factor on the display of the operator panel: 

Use the ‘Arrow’ keys on the right of the display (see figure 8 on page 43). If 
you press one of the vertical keys, the zoom factor will increase or decrease 
in increments of 0.1%. If you press one of the horizontal keys, the zoom 
factor will increase or decrease with the steps predefined in the Océ Settings 
editor by the key operator.
Use the numeric keys at the bottom of the operator panel. You can specify 
the exact zoom factor in 0.1% increments.
For example, if you want to specify a zoom factor of 25.4%, type 254. If you 
want to specify a zoom factor of 254%, type 2540.
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[18] Selecting the zoom factor

Note: You can also select the zoom factor from the ‘Custom’ section (if this 
setting has been defined for this).
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Define settings for the next original

You can define the settings for each original you want to copy. When 
‘Automatic feed’ is enabled, you should bear in mind that the original is 
automatically pulled into the scanner. If you want to be absolutely sure of the 
settings for a given original, insert the original when the correct settings are in 
effect.

Note: You can turn Automatic feed on the scanner off. This offers you the ability 
to change the settings for the next original, even if you already placed the 
original on the scanner feed table.

� Define settings for the next copy job

1 Select all settings required for the next original.
2 Insert the next original.

If ‘Automatic feed’ is off, press the Start key. 
If ‘Automatic feed’ is on, the original is fed automatically.
Note: You can enable or disable this function from the ‘Scanner’ card in the 
‘Original’ section.

Account logging

For accounting purposes, the system is able to log job information for each job. 
The job identification attributes and the number of print jobs are logged in the 
account file. For more information on account logging see chapter 10 on 
page 155.

Note: The account settings are only available if the accounting option is 
enabled in the system configuration.

[19] Accounting function
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� Select accounting

1 Open the ‘Scanner’ card in the ‘Original’ section.
2 Select ‘Account id’ or ‘User id’ with the section key.
3 Define the needed ‘Account id’ or ‘User id’ with the ‘Arrow’ keys.

Using the manual feed for copy jobs

If you want to copy a job on a media type or size that is not available on one of 
the media rolls, it can be convenient to manually feed cut sheets instead of 
switching media rolls. The manual feed is a special slot just above the roll 
drawers on the print engine. You can insert precut copy material in this slot, 
one sheet at a time.

Note: Only use media as specified in ‘List of available material types and sizes’ 
on page 255. 

� Copying on precut sheets

1 Press the Manual feed key on the Scanner.
2 Select any required other settings.
3 Enter the number of copies using the numeric keys.
4 Feed the original. The printer display looks as follows:

[20] The printer operator panel with manual feed message

5 Press the start key.
6 Take your sheet of copy material to the side of the printer engine that contains 

the Manual feed. 
7 Use both hands to align the copy material in accordance with the format 

indication and the sticker on the manual feed table.
8 Move the copy material forward into the nip of the roller. This should cause an 

noticeable paper bulge over the full width of the page.
9 Hold the paper with both hands until the engine pulls in the first part of the 

sheet.
The bulge will be reduced or will disappear. A few seconds later the complete 
sheet will be pulled in the printer.
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Note: If the copy job requires more sheets, the display will ask you to feed 
the next sheet.

10 Repeat steps 7 to 11 to complete the job.
11 Collecting your output.

Stopping a job

Pressing the Stop key interrupts the original transport. 

� Stopping a job

1 Press the Stop key.
The transport of the original is now stopped and you are prompted to open the 
scanner cover in order to remove the original.

2 Open the cover.
3 Remove the original. 
4 Close the cover. 

You are now ready to start the next copy job.

Job interrupt
Press the Job interrupt key on the scanner operator panel to give extra priority 
to a copy job. When you press the Job interrupt key, your copy job will be 
placed at the top of the printing queue. When you select Job interrupt, a 
message appears on the scanner panel display (see ‘Feedback is displayed on 
the scanner panel when Job interrupt is selected.’ on page 60).

[21] Feedback is displayed on the scanner panel when Job interrupt is selected.

The print process will be interrupted after the current job is printed. The 
transport of originals on the scanner will not be interrupted.
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� Interrupting a copy job

1 Press the Job interrupt key before scanning your documents
2 The new job is placed on top of the print queue and will start when the current 

print job is completely delivered. 

Press the Job interrupt key again before you scan your original to remove the 
high-priority status from your job. The job priority will then return to normal.

Job interrupt only remains active for one job. You must press the Job interrupt 
key before each new job to which you want to assign interrupt priority.

If you wish to always enable job interrupt for the selected template, enable job 
interrupt as a default setting for the template in the Océ Settings Editor. You 
still must press the Job interrupt key before each new job to which you want to 
give interrupt priority.

Note: An interrupt job cannot interrupt another interrupt job.

Managing of interrupt jobs in the Océ Queue Manager  Océ Queue Manager 
displays the interrupt job with the icon . The interrupted job is displayed in 
the Queue Manager with the icon .There can be several new jobs in the 
queue during Job interrupt. They are put in a First-In-First-Out sequence. 
In the Océ Queue Manager you can manage interrupted jobs in following way:

� An interrupted job can be canceled in Océ Queue Manager. 
� An interrupted job can be put on hold. An interrupted job will lose its priority 

position in the queue when put on hold. 
� If there are more interrupted jobs, an interrupted job can be moved to the top 

of the printing queue.
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Chapter 4
Using the Océ TDS800 to scan to 
file

This chapter describes the scan-to-file functionality of the 
TDS800. This chapter contains a description of the 
interface of the Océ TDS800 scanner, and of Océ Scan 
Manager and Océ View Station LT applications on the Océ 
Power Logic® controller
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Before you begin

You must turn both the Océ TDS800 printer and the Océ Power Logic® 
Controller on before you can scan to file. See ‘Turning the Océ TDS800 on and 
off’ on page 23.
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Scanner operator panel

For a description of the scanner operator panel and how to perform actions on 
the scanner operator panel, see the ‘Scanner operator panel’ on page 43.
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Océ Scan Logic®

Océ Scan Logic® is an option which enables you to scan a document to a file 
for later use. You enable scan-to-file with a password in the Océ Settings 
Editor.

You use scan to file to:
� print documents at a later time
� archive documents
� E-mail documents
� reuse the information documents contain in another applications

A scan-to-file is made at the Océ TDS800 scanner. On the scanner operator 
panel you can select at which resolution you want to scan and where you want 
to store your file. 

The result of the scan to file can be stored local on the controller (temporary 
store) or directly on a network destination with SMB or FTP. 

Océ View Station LT® enables you to view the scanned documents. Océ View 
Station LT® starts up from the Océ Scan Manager application. Select Auto 
view to automatically start up Océ View Station LT® after scan-to-file.
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Scan clicks

The Océ TDS800 measures the area of media that you scanned during 
scan-to-file operations. You view the scan click count in the bottom right 
corner of Océ Scan Manager (see figure 22 on page 67).

The scan click count is measured in square feet or square meters. You set the 
measurement unit in the Océ Settings Editor (see chapter , ‘Measurement’ on 
page 89).

[22] Scan click count in Océ Scan Manager
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Make a scan-to-file

Do the following to scan an original to file.

� How to scan to file

1 Place your original face-up, left aligned along the original guide.
2 Select the appropriate original type.
3 Select the ‘Destination’ card in the ‘File’ section.

[23] ‘Destination’ card in the file section

4 Select ‘File mode’ On.
The following status message appears: Ready to scan to file.

5 Select a Destination (see ‘Destinations’ on page 78).
6 Set the correct settings. (see chapter , ‘Settings for scan-to-file’ on page 70)
7 Press the start key .

The original is scanned. 
The following status message appears (see figure 24 on page 68):
‘Scanning job’ ‘Scan job number X’
‘File scan22.tif’

[24] File card on the Scanner operator panel
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8 When ‘System’ - ‘Auto view’ is enabled on the Océ Scan Manager, Océ View 
Station LT® starts automatically, showing the result of the scan (see figure 25).

[25] Océ View Station LT
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Settings for scan-to-file

The settings for scan-to-file on the scanner operator panel are divided between 
two cards: Destination and Image.

Destination card:
� Destination
� File type
� TIFF sub format
� PDF compression

[26] Scanner operator panel: Destination card

Image card:
� Resolution
� Zoom
� Optimization
� Mirror

[27] Scanner operator panel: Image card
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File mode

File mode can be ‘Off’, ‘On’ or ‘On with checkprint’. ‘Off’ means scan-to-file 
is not active. ‘On’ means scan-to-file is active. To scan to file with a checkprint, 
activate both the file mode and the print mode on the scanner operator panel. 
The checkprint quality corresponds to the scan resolution. A checkprint is a 
print of the scanned original, ensuring consistency with a later print of the 
scanned file.

� How to scan to file with checkprint

1 Press the section key above the File section twice
The File mode is switched on

2 Press the section key above the Print section twice
The Print mode is switched on

3 The system is now ready to scan to file with checkprint.

Note: The Océ TDS800 system does not allow you to change the ‘File mode’ 
setting during a set from ‘On’ to ‘Off’ and vice-versa. However changing from 
‘On’ to ‘On with checkprint’ and vice-versa is allowed.

Note: In scan-to-file mode, the automatic functionality is optimized for 
scanning. Turning checkprint on or off does not affect this automatic 
functionality.

Destination

You can store your scan either in temporary storage on the controller or on a 
network destination. You can define up to ten destinations in the Océ Scan 
Manager application. Select the destinations defined in Océ Scan Manager on 
the scanner operator panel. You can only select one destination at a time.

� Selecting a destination

1 Press the function key to select destination.
Note: Define the names of the destinations in Océ Scan Manager (see ‘Create 
a local destination’ on page 78).
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File format

To define the internal organization of the scanned files, choose between TIFF 
(Tagged Image File Format) and CALS-I (Continuous Acquisition and 
Life-Cycle support), or PDF (Portable Document Format).

TIFF  describes image data that typically comes from scanners, frame grabbers, 
and paint- and photo-retouching programs. The purpose of TIFF is to describe 
and store raster image data. A primary goal of TIFF is to provide a rich 
environment where applications can exchange image data. This richness is 
required to take advantage of the varying capabilities of scanners and other 
imaging devices. For example, TIFF supports lossless image compression. 
Though TIFF is a rich format, it can easily be used for simple scanners and 
applications as well because the number of required fields is small.

CALS  is an industry strategy for transition of paper-intensive processes to 
highly automated, integrated processes for defense system acquisition, design, 
manufacturing, and life cycle support. 

PDF  Portable Document Format (Adobe® Postscript® 3™ /PDF) is a file 
format that has captured all the elements of a printed document as an electronic 
image that you can view, navigate, print or forward.

Tiff sub format

Within the ‘Tiff subformat’ option, you can define the ‘Organization’ and 
‘Compression’ of the file.

Organization  can be (select with the arrow keys):
� Striped
� Tiled
� Raw

Note: Only choose ‘Striped’ or ‘Tiled’ if you are sure you will be able to use 
these types later. Choose ‘Raw’ in any other case.

Compression  can be (select with the arrow keys):
� Group 4
� Group 3-1D
� None
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Note: Only choose ‘Group 4’ or ‘Group 3-1D’ when you are sure you can use 
these compressions afterwards. Choose ‘None’ in any other case.

Note: When scanning grayscales or dark originals, use Group 3-1D 
compression. In this instance, Group 4 can increase the file size.

Note: ‘Group 4’ or ‘Group 3-1D’ are compression methods which are 
optimized for text and vector drawings. If you choose these compression 
methods when scanning a photo with many grayscales, a negative compression 
can result: the file size increases instead of decreases. So, use these 
compression types with care.

PDF compress

Within the ‘PDF compress’ option, you can define the ‘Compression’ of the 
file.

Compression  can be (select with the arrow keys):
� Group 4
� None

Note: Only choose ‘Group 4’ if you are sure you will be able to use this 
compression type later. Choose ‘None’ in any other case.

Resolution

The Océ TDS800 scan-to-file option allows you to scan at the following three 
resolutions:

� 200 dots per inch (dpi)
� 300 dpi
� 400 dpi

The higher the resolution, the better the image quality. Higher resolution also 
leads to larger file sizes. The default value is 200 dpi.
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Zoom

The ‘Zoom’ option allows you to scale while scanning to a file. If you set ‘File 
mode’ to ‘On’, the automatic ‘Zoom’ setting will result in ‘1:1’. You can 
change this default setting to one of the following three settings:

Custom  This option lets you specify a custom zoom value. You can enter a 
range from 25% through 400%. This value also shows the zoom value when 
the ‘Automatic’ option is chosen.

1:1  With this option selected, scan-to-file will result in an image that is exactly 
the same size as the original. ‘Zoom’ displays 100%.

Automatic  Selecting ‘Automatic’ always results in a 1:1 scan-to-file. 

Optimization

There are two ways to optimize a scan-to-file

Scan quality  optimizes for the best image quality. The scan resembles the 
original as closely as possible.

File size  optimizes for better compression. This generally results in a smaller 
file size. Image quality can slightly decrease.

Mirror

You can use the ‘Mirror’ option to scan a horizontally mirrored image of an 
original. Mirroring is performed along the vertical axis.
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Océ Scan Manager

The Océ Scan Manager is an application available only locally on the Océ 
Power Logic® controller. With the Océ Scan Manager you can configure the 
destinations for scan-to-file. To increase your productivity, you can define 
automatic file naming. This way you can do batch scans without operator 
intervention on the controller.

During scan to file, Océ Scan Manager displays the file name and the status of 
the file generation process. Once the scan is completed, a view of the scanned 
image is automatically displayed on the controller.

Figure 28 on page 75 shows the Océ Scan Manager application. The left part 
displays a tree view containing folders containing destinations. The right part 
displays a table containing the content of the currently selected folder. In 28 on 
page 75 folder ‘Next Dest(8)’ is selected.

[28] Overview of the Océ TDS800 Océ Scan Manager application

Note: Not all options are available to all users. You must log on to a particular 
user mode to perform specific tasks with Océ TDS800 Océ Scan Manager (see 
‘User modes’ on page 147).
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Tree view

The tree view displays:
� the system name
� the collapsible destination tree
� the collapsible temporary storage tree

If you scan to a particular destination, that destination is displayed bold and 
the corresponding icon changes. The destination to which you last scanned, is 
displayed in bold.

If you select a destination to view its content in the right table view, this 
destination will appear selected.

If for any reason a scan-to-file cannot be sent to the appropriate remote 
destination, the file will be stored in the ‘Unsent’ folder.
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Table view

The table view (on the right side of figure 28 on page 75) displays the file 
names of the files in the opened destination or temporary folder. 

Each file has the following information:
� Name
� Size
� Type
� Modified
� Resolution
� Image size

If the currently viewed destination is the one you are scanning to, the scanned 
file will appear at the end of the table. If you are currently viewing a destination 
other than the one you are scanning to, the scanned-to destination is displayed 
in bold.

There may be more files in the table than can fit on the screen. The most recent 
scanned file appears at the end of the table. Under these circumstances, your 
most recent scanned file may not be visible in the table on the screen. If this is 
the case, you can update the table view.

� Update the table view

1 From the ‘View’ menu, select ‘Refresh’ or click the ‘Refresh’ button on the 
toolbar (see figure 29). If the opened destination is also the one which is 
currently being scanned to, the view is automatically updated.

[29] The ‘Refresh’ button on the toolbar
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Actions in Océ Scan Manager

The Océ Scan Manager enables you to make settings for scan-to-file. You can 
edit and view the destination properties. You can also view the properties of 
scanned files.

Destinations

A destination is a location where you scan your file to. You can create, delete 
and lock destinations. You can also define automatic file naming to ensure your 
files are assigned the desired names.

A destination can also be a file server or an end-user PC. It is better to select 
remote destinations rather than local ones. The local destinations are 
temporary and can only hold a limited number of scan files. Define the ‘Scan 
memory reservation’ in the Océ Settings Editor. See the on-line help on the 
Océ Settings Editor for more details.

� Create a local destination

1 Select ‘Destinations’ in the tree view.
2 Open the ‘File’ menu and select ‘New’ or click on the ‘New’ button on the 

toolbar (see figure 30).

[30] ‘New’ button on the toolbar
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[31] ‘Destination properties’ window

3 Enter a logical name for the destination in the ‘Name’ text box.
This logical name also appears on the scanner panel (see figure 23 on page 68).

4 Select ‘On the controller’ from the ‘Type’ drop-down list box.
5 Enter a path for the target folder in the ‘Path’ text box. You can also click the 

‘Browse’ button to select the path.
Note: This is only possible if you select ‘On the controller’ as ‘Type’ (see 
step 4).

6 Click Ok to accept the destination properties.

� Create a network destination with SMB

1 Create a shared folder on a workstation. For example: c:\Scan
2 On the Océ Scan Manager, open the ‘File’ menu and select ‘New’ or click on 

the ‘New’ button on the toolbar (see figure 30). 
The Destination Properties dialog box appears (see figure 31)

3 Select SMB from the ‘Type’ drop-down list box.
4 Enter the system name of the workstation where you created the shared folder.

Note: Find the system name of the workstation on the control panel of the 
workstation (Control panel - Network - Identification - System name)

5 Enter the path name. This is the name of the shared folder on your workstation.
For Windows NT® and Windows 2000®, use the DOS name of the shared 
folder.
For Windows 95/98®, use the folder name. This is case-sensitive.
Note: You cannot browse. Instead of entering the path name by hand, you 
can use the drop-down list box to select a shared folder available on the 
selected system.

6 If you have set a username and a password for the shared folder on the 
workstation, then enter the username and the password in the required fields.



80 Océ TDS800 User Manual

7 Define the required file-naming properties
8 Click OK

Océ Scan Manager connects to the new SMB destination. Océ Scan Manager 
then shows the contents of the new SMB destination.

� Create a web destination with FTP

1 Create a home directory and a subdirectory on a workstation. For example: 
c:Ftp/Scan

2 Enable FTP on the workstation
3 On the Océ Scan Manager, open the ‘File’ menu and select ‘New’ or click on 

the ‘New’ button on the toolbar (see figure 30). 
The Destination Properties dialog box appears (see figure 31)

4 Select FTP from the ‘Type’ drop-down list box.
5 Enter the system name of the workstation where you created the shared folder.

Find the system name of the workstation on the control panel of the 
workstation (Control panel - Network - Identification - System name)

6 Enter the path name. This is the name of the shared folder on your workstation.
For Windows NT® and Windows 2000®, use the DOS name of the shared 
folder.
For Windows 95/98®, use the folder name. This is case-sensitive.
Note: You cannot browse.

7 For access to the directory on the workstation through FTP, a user name and 
password is set on the FTP server that runs on the workstation. Enter this user 
name and this password in the required fields on the Destination Properties 
dialog box of the Océ Scan Manager.

8 Define the required file-naming properties
9 Click OK

Océ Scan Manager connects to the new FTP destination. Océ Scan Manager 
then shows the contents of the new FTP destination.

Note: You can create up to 10 destinations.
Note: Names in Japanese can only be entered for remote destinations in 
SMB.
A key operator can determine whether a destination can be modified by an 
anonymous user. This is done by locking and unlocking a destination.

� Locking a destination

1 Select a destination.
2 Open the ‘File’ menu and select ‘Properties’.
3 Check the ‘Locked’ check box.
4 Click Ok to accept the destination settings.

The destination properties are now locked.
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Note: This option is only available if you are logged on as a Key operator (see 
‘User modes’ on page 147).

� Unlocking a destination

1 Select a destination.
2 Open the ‘File’ menu and select ‘Properties’.
3 Uncheck the ‘Locked’ check box.
4 Click OK to accept the destination settings.

The destination properties are now unlocked.
Note: This option is only available if you are logged on as a Key operator 
(see ‘User modes’ on page 147).

� Deleting a destination

1 Select a destination.
2 Open the ‘File’ menu and select ‘Delete’ or click the ‘Delete’ button on the 

toolbar (see figure 32).

[32] ‘Delete’ button on the toolbar

The selected destination is deleted.
Note: This option is only available if you are logged on as a Key operator or 
as a Repro operator.

Note: You are not able to delete the last destination.

� Set/Change destination properties

1 Select a destination.
2 Open the ‘File’ menu and select ‘Properties’ or click the ‘Properties’ button on 

the toolbar (see figure 33).

[33] ‘Properties’ button on the toolbar

The ‘Destination properties’ screen appears as in figure 31 on page 79.
3 Change the destination properties as described in ‘Create a local destination’ 

on page 78.
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Prompting for file name

Prompt for file name enables you to create a user-defined file name before you 
scan to file. Before a new scan-to-file job, enter a new file name or replace the 
file name with ###. For SMB and FTP destinations, if the file name is not 
changed after scan-to-file, the next scan-to-file job overwrites the previous 
one.

� Defining a file name

1 Select a destination.
2 From the ‘File’ menu, select ‘Properties’.

The ‘Destination properties’ screen appears (see figure 31 on page 79).
3 Enter a name in the ‘Base name’ text box.

Note: The ‘Base name’ may contain ‘###’ for automatic file naming. The 
‘###’ will be replaced by an ascending number. You can place dots in the 
‘Base name’.

4 Select or clear the ‘Add correct file extension’ check box to add or leave out 
the file extension. Set the file extension in the Océ Settings Editor.

5 Click ‘Apply’ or press Enter to accept the settings.
When you scan, the scanner operator panel displays the file name.(see 
‘‘Destination properties’ window’ on page 79).

Scanned files

The right pane of the Océ Scan Manager contains the scanned files and 
additional information about the files. You can view, print and delete these 
files. You can also view the file properties.

� View a scanned file

1 Select a file in the right pane.
2 Open the ‘File’ menu and select ‘View’ or click the ‘View’ button on the 

toolbar (see figure 34).

[34] ‘View’ button on the toolbar

Océ View Station LT (see ‘Océ View Station LT®’ on page 87) starts up and 
displays the file.
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When you enable ‘Automatic view’ on the Océ Scan Manager, Océ View 
Station LT starts up automatically after scan to file.

Note: When you scan to file, the Océ View Station LT controller starts 
automatically, showing the result of the scan.

� Print a scanned file

1 Select a file in the right pane.
2 Open the ‘File’ menu and select ‘Print’ or click the ‘Print’ button on the toolbar 

(see figure 35).

[35] ‘Print’ button on the toolbar

The selected file will be printed with the default settings as defined in the Océ 
Settings Editor.

� Deleting a scanned file

1 Select a file in the right pane.
2 Open the ‘File’ menu and select ‘Delete’ or click the ‘Delete’ button on the 

toolbar (see figure 36).

[36] ‘Delete’ button on the toolbar.

The selected file will be deleted.

� Viewing properties of a scanned file

1 Select a file in the right pane.
2 Open the ‘File’ menu and select ‘Properties’ or click the ‘Properties’ button on 

the toolbar (see figure 37).

[37] ‘Properties’ button on the toolbar.
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The following window appears (see ‘‘Scanfile properties’ window’ on 
page 84):

[38] ‘Scanfile properties’ window

3 Click Ok to close the ‘Scanfile properties’ window.

� Automatically viewing a file after scanning

You can choose to view a file automatically after scanning:
1 Open the ‘System’ menu and select ‘Auto view’.

When you scan-to-file, Océ View Station LT will automatically start and 
display the scanned file.

Manage the temporary store

If you regularly scan originals to a file, many files will be created in temporary 
storage. You can clean up the temporary storage manually or automatically.

To manually delete  the files in temporary storage, select the ‘Purge’ command 
from the ‘System’ menu.

To automatically delete  the scanned files from the temporary store, you must 
configure disk cleanup in the Océ TDS800 Settings Editor to use this option. 
(see ‘Océ Power Logic®: Settings Editor’ on page 109).

Retrieving scanned files

When you scan to file, your files will be stored in the destination you define. 
This can be on the local controller or on a remote system. You can retrieve your 
files from the local controller with File Transfer Protocol (FTP) (see figure 39). 
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Also, if, during scanning to a remote destination, something goes wrong, you 
can retrieve your files from the local controller.

Files scanned to a local destination are stored in the directory of the controller. 
You can retrieve your files from the local host with File Transfer Protocol 
(FTP). FTP transfer can be performed: 

1 via an Internet browser
2 an FTP application, or
3 via a command line prompt.

[39] Retrieving scanned files

� Retrieve files with an FTP command line prompt

1 Launch an FTP client.
2 Enter the ‘ftp’ command.

A DOS box appears with the FTP prompt.
3 Enter the ‘Open’ command followed by either the registered name of the Océ 

Power Logic® Controller or the IP address (for example: 194.2.66.146) to 
connect to the Controller and press Enter: ‘open 194.2.66.146’.
Note: Instead of performing steps 2 and 3, you could also enter “ftp 
host_name” in the FTP client.
The connection with the Controller is now established and a window appears 
asking you for a user name.

4 Enter your user name ‘anonymous’, and also enter ‘anonymous’ as your 
password. 
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A connection is now set up for the default user ‘anonymous’.
Note: As there is no registered user, simply press Enter to initiate the 
connection.

5 Set the transmission mode to binary by entering ‘binary’.
6 Go to the ‘tempstore’ directory using the following command: ‘cd tempstore\’.
7 Go to the ‘scan’ directory if you want to retrieve a file from a destination on 

the local host, 
or
go to the ‘unsent’ directory if you want to retrieve a file from ‘unsent’ folder 
on the local host.

8 Get the data file (for example: bugatti.tif) via the ‘get’ command: 
‘get bugatti.tif’.
Quit FTP by entering the ‘bye’ command.

[40] The ftp directories on the Océ TDS800
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Océ View Station LT®

With Océ View Station LT you can view your scanned files. This can be 
automatic (see ‘Automatically viewing a file after scanning’ on page 84) after 
scanning or via Océ Scan Manager (see ‘Print a scanned file’ on page 83).

Océ View Station LT has the following menus (see figure 41):
� File
� View
� Preference
� Help

[41] Océ View Station LT
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Menu options

File menu
Command What does it do

Close Closes the active document.

Properties Provides information about the scanned document. Allows the 
operator to change certain properties of the document.

View menu
Command What does it do

Fit Scales the image to fill the window.

1:1 Displays the image at a 1:1 scale factor.

Magnify Zooms into the page.

Reduce Zooms out of the page.

Refresh Redraws all windows displaying the active document.

Invert Reverses the black-and-white parts of the image.

Mirror Mirrors the image.

Rotate 90 CCW Rotates the image 90 degrees counter-clockwise.

Rotate 90 CW Rotates the image 90 degrees clockwise.

Rotate 180 Rotates the image 180 degrees.

Sample When active, displays only a sample of bilevel raster pixels.

Negate Reverses the raster image pixels on display and changes which are 
dominant for scaling. 

Scale to gray When active, displays the active bilevel raster image as though it 
were a grayscale image. 

Monochrome An image or screen having only background and foreground 
colors. Same as black-and-white or bilevel.

Preference menu
Command What does it do

View ribbon View Ribbon displays and removes the ribbon that contains 
buttons. The View Ribbon appears, by default, below the menu bar. 
It serves as a quick way to select certain File, View, and Preference 
menu commands.

Status bar Status Bar displays and removes the Status Bar at the bottom of the 
Océ View Station LT window. The Status Bar displays the pointer 
coordinates and a status line.
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Function buttons

Function buttons appear in a ribbon below the menus. This ribbon can be 
turned on and off (see ‘View ribbon’ on page 88). 

[42] Function buttons in Océ View Station LT

Figure 42 displays the buttons:
1 Invert: Reverses the black-and-white parts of the image.
2 Fit: Scales the image to fill the window.
3 1:1: Displays the image at a 1:1 scale factor.
4 Magnify: Zooms into the page.
5 Reduce: Zooms out of the page.
6 Mirror: Mirrors the image.
7 Rotate 90 CCW: Rotates the image 90 degrees counter-clockwise.
8 Rotate 90 CW: Rotates the image 90 degrees clockwise.
9 Rotate 180: Rotates the image 180 degrees.

10 Measurement: When active, allows you to measure lines and areas on the 
image.

11 Reference. This small floating window displays the entire current page in 
miniature for reference.

12 Displays or removes the Detail window.

Reference Reference displays or removes a small, usually floating window. 
This window displays the entire current page in miniature. The 
crossed box inside the Reference window indicates which part of 
the page is displayed in the document window.
By moving or resizing the crossed box, you change which area of 
the page is displayed.

Detail Displays or removes the Detail window.

Measurement When active, allows you to measure lines and areas on the image.

Help menu
Command What does it do

About Shows information about Océ View Station LT.

Preference menu (continued)
Command What does it do

2 3 4 5 6 8 9 10 11 121 7
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View error

When the memory is almost full, the viewer might not be able to display the 
scanned file. Instead it shows a red border with a red cross (see figure 43).

[43] Error view in Océ View Station LT
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Chapter 5
Special copy and scan jobs

This chapter contains a description of special jobs and 
describes how to improve the output quality.
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Non-standard size originals

The scanner of the Océ TDS800 automatically detects the width of the inserted 
original. For DIN sizes, for example, it detects whether the width is A0, A1, 
A2, A3, A4, 500 mm, or 700 mm. The Océ TDS800 system uses a memory 
table that contains all standard width - standard length combinations to predict 
the length of the original. The scanner also measures the real length of each 
original as it passes through the scanner.

Note: When you scan thick, thin or damaged originals, or originals in a carrier 
sheet, we recommend you use the output at the rear side of the scanner to 
ensure correct delivery (see ‘Define settings for the next original’ on page 58).

Scan width

To prevent the loss of information when you scan a non-standard original, 
select the ‘non-standard’ scan width. The scanned width will then be larger 
than the original width. It is also possible to define the scanned width and 
length manually. 

� Defining the scan width

1 Open the ‘Sheet’ card in the ‘Original’ section.
2 Press ‘Scan width’ to select the required setting:

� Standard. This option must be used to scan a standard-size original.
� Non-standard. This option can be used to scan a non-standard original. The 

scanned width will be larger than the original width (to the next-larger 
standard size), to prevent information loss.

� Numeric. Define the scan width with either the arrow or the numeric keys.

[44] Selecting ‘Non-standard’ scan size
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The copy size

The copy width depends on the selected roll and the custom defined scan 
width. The copy length depends on the selected cut option.

� Copying non-standard size originals

1 Select ‘auto roll’ on the printer operator panel.
The scanner scans wider than the original. No information is lost.

2 Open the ‘Sheet’ card in the ‘Print’ section on the scanner operator panel (see 
figure 45).

3 Press the ‘Cut length’ function key to select the required cut option:
� Standard, the print length corresponds to a standard format, depending on the 

media width. When you use ‘Standard cut’, information loss can occur.
� Synchro, the system cuts at the measured length of the original times the 

zoom factor. The minimum length is 279 mm or 11 inch. When you use 
‘Synchro cut’, information loss will not occur. 

� Custom (numeric), which cuts copies on a specified length. You can define 
the copy length yourself using either the arrow or the numeric keys.

4 Feed the original
5 Press ‘Start’.

[45] Defining the cut length
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Scanning originals with filing strip
Left-hand side  You can adjust the original guide of the scanner to remove a 
filing strip along the left-hand side (face-up in the feed direction). This side can 
be reduced by up to 2.36" (see figure 46).

[46] Example of adjusting the left-hand side of an original

� Copying with removed filing strip along the left-hand side

1 Press the handle underneath the original guide and move it to the right.

[47] Adjusting the original guide to add or remove a filing strip along the left-hand side

2 Define all required settings.
3 Insert the original face-up and aligned to the left with the original guide on the 

original feed table.

Right-hand side  You can also remove the filing strip along the right-hand side 
(face-up in the feed direction) by selecting a specific roll. If the paper width of 
the original is larger than the paper width of the selected roll, the remaining 
portion on the right-hand side will not be scanned.

Left-hand side
- 40 mm (1.57'')

Left-hand side
+ 20 mm 
(0 79'')
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� Copying with removed filing strip along the right-hand side

1 Select one of the roll selection keys on the operator panel.
2 Select the 100% key.
3 Make sure the ‘auto zoom’, ‘auto roll’, and ‘Scan width’ are not selected.
4 Define other settings as required.

Feed the original.

Leading and trailing strip  It is possible to adjust the length of both the leading 
and trailing strip in order to eliminate or add a filing strip. Leading and trailing 
strips can be extended up to 400 mm (15.75'') or shortened up to 400 mm 
(15.75'') (see figure 48).

[48] Example of adjusting the leading and trailing strip of an original

Leading strip
- 400 mm (15.75'')

Leading strip
+ 400 mm (15.75'')

Trailing strip
- 400 mm (15.75'') Trailing strip

+ 400 mm (15.75'')
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� Copying with removed filing strips along the leading and trailing strip

1 Open the ‘Sheet’ card in the ‘Original’ section.
2 Press the ‘Remove strip’ function key.

[49] Removing strip

3 Adjust the values for the trailing strip using the numeric or arrow keys.
4 Press the ‘Remove strip’ function key again.
5 Adjust the values for the leading strip using the numeric or arrow keys.
6 Define other settings as required.
7 Feed the original.

� Copying with added filing strips along the leading and trailing strip

1 Open the ‘Layout’ card in the ‘Print’ section.
2 Press the ‘Add strip’ function key.

[50] Adding a strip

3 Adjust the values for the trailing strip using the Numeric or Arrow keys.
4 Press the ‘Add strip’ function key again.
5 Adjust the values for the leading strip using the Numeric or Arrow keys.
6 Define other settings as required.
7 Feed the original.
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The image quality

Improve the image quality by modifying the exposure or by making use of 
special functions like automatic background compensation or setting the type 
of image you want to copy. 

Brightness

You can change the brightness of a print or copy by modifying the exposure of 
the scanner. The exposure can be set to lighter or darker.

� Setting the exposure

1 Press the Up and Down keys next to the exposure indicator on the scanner 
operator panel to adjust the exposure.

[51] The exposure keys and the exposure indicator
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Automatic background compensation

The automatic background compensation will provide quality output from a 
large variety of originals. The automatic background compensation setting 
ensures the production of background-free output of most line drawings. 

[52] Image settings

� Set the automatic background compensation

1 Open the ‘Image’ card in the ‘Original’ section.
2 Press the ‘Background compensation’ function key if this function is disabled.

When you scan extremely light or dark originals, or originals with uneven 
background density, the result may not meet your requirements (e.g. too much 
background). In such cases you can manually adjust the brightness (see 
figure 51).

Original type  The Océ TDS800 Scanner allows you to adjust the exposure 
setting according to the type of image on the original. There are five original 
types available. Select a suitable mode according to the original (see figure 52 
on page 98).
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� Setting the original type for your image

1 Press the ‘Original type’ function key to select the appropriate image type:
� Press the ‘Original type’ function key to select ‘Lines / text’. Use ‘Lines / 

text’ for originals containing characters and line art. By default ‘Lines / text’ 
is selected when ‘Background compensation’ is enabled.

� Press the ‘Original type’ function key to select ‘Photo’ for the enhanced 
photo mode for originals containing photographic matter. Use ‘Photo’ for 
originals containing picture images.

� Press the ‘Original type’ function key to select ‘Grays&lines’ if the original 
contains many grayscales and lines. Use ‘Grays&lines’ for GIS originals and 
maps.

Note: ‘Background compensation’ is turned off for ‘Photo’ and 
‘Grays&lines’.

� Press the ‘Original type’ function key to select ‘Printed matter’. Use ‘Printed 
matter’ for printed originals containing a raster, for example, those that are 
coming from offset printing. ‘Printed matter’ eliminates the Moiré effect.

� Press the ‘Original type’ function key to select ‘Blueprint’ when you want to 
scan an original with an image in ‘negative’ (image in white on dark 
background). The output will be ‘positive’ (image in black on white 
background).

� Press the ‘Original type’ function key to select ‘Dark original’ when the 
original has an extremely dark background (i.e. low contrast).

2 Define other settings as required.
3 Feed the original.
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Editing functions

The Océ TDS800 Scanner has editing functions. You must set the functions 
before you scan the original.

Note: You can select only one edit function at a time.

Auto align

You can use the alignment functions of the Océ TDS800 scanner to align the 
image automatically to a side of the print. The following types of alignment are 
available (see figure 53):

[53] Auto align options with standard cut option active

Top Left Top Middle Top Right

Middle Left Middle Middle Right

Bottom Left Bottom Middle Bottom Right
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� Selecting default settings for auto shifting with standard cut option

You must enable standard cut length to get output as shown in the illustration 
53 above. With ‘Standard cut’, the print length corresponds to a standard 
format depending on the media width. When you use ‘Standard cut’, 
information loss can occur.

1 Open the ‘Layout’ card in the ‘Copy’ section.

[54] Automatic shift with the ‘Align’ function

2 Press the ‘Align’ function key and select a horizontal alignment value (Left, 
Middle or Right) with the Arrow keys.

3 Press the ‘Align’ function key again and select a vertical alignment value (Top, 
Middle, or Bottom) with the Arrow keys.
Note: If you select ‘Middle’, make sure the original width is properly 
specified as described in the section about ‘Scan width’ on page 92:
� ‘Standard’ if a standard sized original is used
� The exact original width (numeric) if a non-standard sized original is used.

4 Feed your original.

You must enable synchro cut length in order to produce output as shown in 
illustration 61. With ‘Synchro cut’ the system cuts at the measured length of 
the original times the zoom factor. The minimum length is 279 mm or 11 inch. 
When you use ‘Synchro cut’, information loss will not occur.
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[55] Auto shift options with synchro cut option active

‘Shifting the image’ on page 102 contains instructions for defining the exact 
position of your image on the page. 

Shifting the image

In some cases, the margin may be too narrow to accommodate filing strips 
without loss of information. To avoid this, you can shift the image horizontally 
or vertically, as shown below.

[56] Example of image-shifting

Middle Left Middle Middle Right

Bottom Left Bottom Middle Bottom Right

Top Left Top Middle Top Height
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� Shifting the image

1 Open the ‘Layout’ card in the ‘Copy’ section.

[57] Image-shifting

2 Press the ‘Shift’ function key and select a horizontal shift value by pressing the 
numeric or arrow keys until the required distance is set for shifting the image 
to the left or to the right.

3 Press the ‘Shift’ function key again and select a vertical shift value by pressing 
the numeric or arrow keys until the required distance is set for shifting the 
image upwards or downwards.

4 Define other settings as required.
5 Feed the original.

Note: You can use horizontal and vertical shift at the same time.

Mirror image

With the Océ TDS800 Scanner you can make a mirror-image copy of an 
original, as shown in the next figure:

[58] Example of a mirror-image copy
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� Making a mirror-image copy

1 Open the ‘Image’ card in the ‘Print’ section.

[59] Mirror image

2 Press the ‘Mirror’ function key to enable the ‘Mirror’ function.
Define other settings as required and feed the original.
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Making a set copy

Set copy is an input mode which allows you to make one job out of multiple 
originals. It is distinguished from the ‘Multiple sheets’ input mode by the way 
the job is sorted. See page 55 for a description of the input modes.

� Making a set copy

1 Open the ‘Feeding’ card in the ‘Original’ section.
2 Use the ‘Input mode’ function key to select ‘Set‘.
3 Define other settings as required and feed the original.
4 Press the green Start key to start the copy job.

Your original is fed into the scanner. The printer starts.
5 Feed the other originals that make up your set.

When ‘Automatic feed’ is enabled, you do not have to press the green Start key 
each time you feed an original.

6 Once all the originals have been scanned, press the green Start key to close the 
set.

7 If you want to abort your job, press the red Stop key. When you press the red 
stop key, the entire job is deleted.
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Océ Matrix Logic®

Océ Matrix Logic® is an Océ TDS800 option which allows you to create, in 
one single operation, different copy sets from one set of originals using 
predefined settings. Select ‘Matrix copy’ as input mode on the scanner operator 
panel to use Océ Matrix Logic®. Enable matrix copying with a password in the 
Océ Settings Editor.

[60] Workflow of Océ Matrix Logic®

� Make a matrix copy on the scanner

1 Open the ‘Feeding’ card in the ‘Original’ section.
2 Use the ‘Input mode’ function key to select ‘Matrix copy‘.

See page 55 for a description of the input modes.

One scan job is 
scanned in on the 
scanner.

Configurations 
are applied to the 
scan job.

The matrix copy 
jobs are sent to 
the printer.

The printer 
prints the 
matrix jobs
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3 Feed the original.
Note: After you select ‘Matrix copy’ on the scanner operator panel, the 
‘File’ and ‘Print’ card are disabled. The ‘Drawing method’ and ‘Legend 
orientation’ on the ‘original’ card are also disabled.

4 The job is scanned to a special matrix copy destination on the controller.
Note: You can not see the matrix copy destination on the ‘File’ card of the 
scanner operator panel.

5 On the scanner the matrix copy job is processed as a set. See ‘Making a set 
copy’ on page 105.

6 When all originals are scanned, press the green Start key to close the matrix 
copy set.

7 If you want to abort the job, press the red Stop key. When you press the red 
Stop key the entire job is deleted.

[61] Input mode with Matrix copy selected

The Océ Matrix Logic®application

Use the Océ Matrix Logic® application to print the job using different 
configurations. Before you can apply configurations to the job, you must first 
create the configurations in the Océ Matrix Logic® application.

Note: The Océ Matrix Logic® application is not available on Océ Remote 
Logic®.

� Use the Océ Matrix Logic® application to create configurations for the 
matrix copy jobs.

1 Start the Océ Matrix Logic® application from the Application launcher on the 
controller.

2 On the copy configurations tab, click ‘Create’.
A default name is added in the configurations list.

3 Rename the configuration.
4 Click ‘OK’ to validate.
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5 Define the settings to apply to the configuration (See below).
6 Click ‘Save’. A successful save is confirmed with a message.

Note: If you exit the tab without saving the changes in the configuration, a 
message asks you whether you want to save, discard or cancel the 
configuration.

� Use the Océ Matrix Logic® application to define or modify settings within 
the configurations for the matrix copy jobs.

1 On the copy configurations tab, select a configuration in the list.
2 Select the setting to define or modify. The setting is displayed in the Editing 

zone.
3 Select the value to apply to the setting from the scrolling list.
4 Repeat steps 2 & 3 with all the settings you want to edit.
5 Click ‘Save’.

� Use the Océ Matrix Logic® application to apply the configurations to the 
matrix copy job.

1 Start the Océ Matrix Logic® application from the Application launcher on the 
controller.

2 The documents you scanned are retrieved automatically in a list on this tab.
Note: The names displayed correspond to the file names. You cannot 
change these file names.

3 On the matrix composition tab, click ‘Add’
4 On the ‘Select configurations’ window, select the configuration you want to 

apply to your scanned documents.
5 Click ‘OK’ to confirm.
6 Click ‘Print’ to submit the jobs to the printer

After the jobs are printed, all documents are deleted from the memory.

� The Océ Matrix Logic® application also allows you to do the 
following:

� Set the user name of the owner of the job.
� Enter a name for the Matrix copy job.
� Enter a user ID. The user ID is automatically filled in from the previous job. 

You can change it if required.
� Enter an account ID for account logging.
� Prioritize the order of configurations for the print.
� Delete settings from the configurations.
� Delete configurations.

Note: See the on-line help on the Océ Matrix Logic® application for details 
about the Océ Matrix Logic® application.
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Chapter 6
Océ Power Logic®: Settings Editor

This chapter provides information about the Océ Settings 
Editor. For details about specific settings refer to the Help 
on the Océ Settings Editor.
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Introduction

You can use the Océ Settings Editor to define the default settings of the Océ 
TDS800 according to your company's requirements. Two types of users can 
define settings in the Océ Settings Editor: Key Operators and System 
Administrators. You can log on either as a Key Operator or as a System 
Administrator. Key Operators and System Administrators have different rights 
to determine settings.
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Océ Settings Editor

The Océ Settings Editor is one of the controller applications for the Océ 
TDS800. The Océ Settings Editor allows users and operators to view system 
settings. With proper authorization, the system settings can be modified on the 
Océ Settings Editor.

The Océ Settings Editor allows you to configure two groups of settings:
� Key Operator settings (KO settings)

The Key Operator settings allow authorized users to configure default 
settings for the copy jobs, the scan-to-file jobs and the print jobs, default 
off-line fold settings and scan-to-file options. With the Key Operator 
settings, the printer, system and scanner defaults can also be set or modified. 
A subset of the Key Operator settings are the Repro Operator settings. The 
Repro Operator has no rights to change settings in the Océ Settings Editor. 
In the Océ Queue Manager and the Océ System Control Panel, the repro 
operator has the same user rights as the Key Operator and System 
Administrator. See ‘User modes’ on page 147.

� System Administrator settings (SA settings)
The System Administrator settings allow authorized users to configure 
default printer language (PDL) settings and printer pen settings. It also 
allows the System Administrator to configure system and connectivity 
settings.

Note: Toggle between the display of Key Operator settings and System 
Administrator settings in the ‘View’ menu of the Océ Settings Editor.

Setting dependencies  The Océ Settings Editor is used to display and edit a 
specified group of settings. Some settings are related to other settings. If you 
want to change settings which have dependencies with other settings, you will 
be prompted with a message. When a setting is changed, the system 
automatically updates the related settings. 

When you change certain settings, such as measurement unit or paper series, 
all related settings are converted to the new setting (with a bullet for the 
settings that are changed).
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[62] Océ Settings Editor

General structure

The Océ Settings Editor is structured as follows: 
� Menu bar
� Top toolbar
� Left toolbar
� Settings area
� Status bar
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Menu bar

The Océ Settings Editor menu bar contains the following menus:   

File   If you select the ‘File’ menu you can log on as a particular type of user, 
log off from the previously selected user mode, open an existing setting file, 
save the current settings to a file, connect to a different controller (only for 
remote users) or exit the Océ Settings Editor.

Edit  If you select ‘Options’ from the ‘Edit’ menu, a window appears in which 
you can view your default system and the display languages (first and second) 
for the Océ Settings Editor application. The ‘Automatic logon’ option allows 
you to start the Océ Settings Editor application automatically in the specified 
user mode.

View  The ‘View’ menu allows you to switch between the display languages as 
defined in the Edit options window and to toggle between KO settings and SA 
settings. 

Help  The ‘Help’ menu contains the following options:  ‘Contents of Settings 
Editor’ and ‘About Settings Editor’.

[63] Menu bar

Top toolbar

The top toolbar of the Océ Settings Editor contains four control buttons: 
‘Open’, ‘Save as’, ‘Apply’ and ‘Undo’.

[64] Top toolbar

Open  When you click on the ‘Open’ button, you open a saved file. 

Save as  All Key Operator and System Administrator settings can be saved in 
a file. This enables you to have different settings for different customers, 
departments or other situations.
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Note: These settings can only be saved in Key Operator or System 
Administrator mode.

Apply  When you click on the ‘Apply’ button, the changes you have made take 
effect. This button is initially disabled. It is enabled after the first setting is 
changed and disabled again after the Apply action is performed or after an 
Undo action. 

Undo  This button restores the settings to the state they were in the last time the 
settings were applied (and not back to the factory default). The ‘Undo’ button 
is initially disabled. This button is enabled the moment the first setting is 
changed. It is disabled after an apply action is performed or after an undo 
action

� Saving settings to file

1 Open the ‘File’ menu and select ‘Save as’, or press the ‘Save as’ button on the 
toolbar.
You now have two possibilities:
� If the client is a local client, a dialog box is displayed and the user can supply 

a file name. The file is saved in a predefined directory on the system. 
� If the client is a remote client, a dialog box is displayed and the user can 

supply a directory and a file name.
Note: All settings in the current view mode are saved, not only the ones that 
are currently visible. 

� Open a saved file

1 Open the ‘File’ menu and select ‘Open’, or press the ‘Open’ button on the 
toolbar.
A dialog box is displayed, from which you can choose the correct file.

2 Click the ‘Apply’ button. 
The loaded settings are transferred to the system.
Note: This is only possible if the user is logged on as a Key Operator or a 
System Administrator.

A few special files are available:
� Default.kos/Default.sas

These files contain the factory default settings for the Key Operator and 
System Administrator, respectively, and cannot be changed.
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� Backup.kos/Backup.sas
These files contain a previous version of the settings for the Key Operator 
and System Administrator, respectively (before the last Apply).

� Current.kos/Current.sas
These files contain the version of the settings for the Key Operator and 
System Administrator after the last ‘Apply’.

Left toolbar

There are four different buttons available on the left toolbar of the Océ Settings 
Editor. These are ‘Jobs’, ‘Printer’, ‘Scanner’ and ‘System’. Each button 
provides access to a specific group of settings. By clicking on each of these 
buttons, you can get access to the settings related to the selected group.

A shadow highlight is used to indicate which button is activated.

[65] Left toolbar
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Settings area

The settings area consists of two parts: a settings tree and an update area.

Tree structure  Most settings are displayed using a tree structure. By clicking 
on the settings, folders can be opened to show all the entries or closed to hide 
all the entries below these folders.

The settings for system components that are not available are not displayed. 
So, for example, if you do not have a folder, no folder settings are available. 
This means that different configurations result in different tree structures.

Note: When a tree item has been changed, this item will be marked with a 
bullet.

Update area  Select a setting in the tree structure. Edit the setting in the update 
area.

Note: If the user is not authorized for a particular setting, the update area is 
grayed out and no changes can be made.

Note that a few settings, such as basic card and pen settings, are not edited from 
the tree structure, but are accessed directly from the settings area.

The update area contains some additional information about the selected  
setting. This includes a brief description of the setting, as well as the minimum, 
maximum and default values (if applicable). 

[66] Settings area
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Status bar

The Océ Settings Editor has a status bar displaying the following information 
(left to right):

� System status (icon for connected or disconnected)
The following icons are used:  

The Océ Settings Editor is connected to a system. 

The Océ Settings Editor is not connected to a system.

� System name (‘localhost’ if you are working at the controller)
� User mode (Repro operator, Key Operator, System Administrator or 

anonymous)
� View mode (KO settings or SA settings).

How to access the Océ Settings Editor

In order to perform special Key Operator functions, you must log on to the Océ 
Settings Editor as a Key Operator.

As these functions are restricted to a dedicated Key Operator, a password is 
required to access them. The service engineer will provide this password to 
you upon installation.

Note: Only one user at a time is allowed to log on as a user authorized to 
modify settings (Key Operator, System Administrator, Service Engineer). When 
a second user tries to log on, an error message is displayed. Multiple users at 
one time are allowed to view settings. 
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Start the Océ Settings Editor

You can run the Océ controller applications on the controller as well as on a 
remote workstation

Note: Océ Scan Manager only runs locally on the controller.

� Start Océ Settings Editor on the Océ Power Logic® Controller

1 Select the 'Launcher' application.
2 Select Settings Editor. Océ Settings Editor starts.

� Start Océ Settings Editor on a remote workstation

Note: You must first install Océ Remote Logic® as described (see 
‘Installation procedure for Microsoft® Windows systems’ on page 141).

1 Select 'Océ Remote Logic' from the 'Start' menu.
2 Select the 'Launcher' application.
3 Select Settings Editor. Océ Settings Editor starts.

Performing actions from the Océ Settings Editor

You can perform a number of activities from the Océ Settings editor. These 
activities include:

� Saving settings to file
� Loading settings from a file
� Specifying the custom card

Saving and loading settings  All Key Operator and System Administrator 
settings can be saved in a file or loaded from a file. This enables you to have 
different settings for different customers, departments or other situations.

Note: These settings can only be saved in Key Operator or System 
Administrator mode. 

� Saving settings to file

1 Open the ‘File’ menu and select ‘Save as’.
You now have two possibilities:
� If the client is a local client, a dialog box is displayed and the user can supply 

a file name. The file is saved in a predefined directory on the system. 
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� If the client is a remote client, a dialog box is displayed and the user can 
supply a directory and a file name.

Note: All settings in the current view mode are saved; not only the ones that 
are currently visible

A few special files are available here:
� Default.kos/Default.sas

These files contain the factory default settings for the Key Operator and 
System Administrator, respectively, and cannot be changed.

� Backup.kos/Backup.sas
These files contain a previous version of the settings for the Key Operator 
and System Administrator, respectively (before the last apply).

� Current.kos/Current.sas
These files contain the version of the settings for the Key Operator and 
System Administrator after the last apply.

When an apply is performed, first the contents of the current settings are copied 
to the backup file. There are two versions of this file, one for KO settings and 
one for SA settings. These files are always stored on the system.

� Loading a settings file

1 Open the ‘File’ menu and select ‘Open’.
A dialog box is displayed, from which you can choose the right file.

2 Click the ‘Apply’ button. 
The loaded settings are transferred to the system.
Note: This is only possible if the user is logged on as a Key Operator or System 
Administrator.

� Specifying the custom card

Use the custom card on the scanner panel to set high priority settings in 
addition to the five default settings on the basic card.

Add or delete current settings on the custom card. In the left window, all the 
available setting groups are displayed. All the current settings are displayed in 
the right window. You can use the two arrow buttons between the two windows 
to add settings to, or remove settings from, the custom card.
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1 Click the ‘Scanner’ button. 
2 Select the ‘Custom card’ tab. 
3 Press the upper arrow button to add settings to the custom card. The maximum 

number of settings that can be added to the custom card is five.
4 To change the order of the settings on the card, click on one of the buttons to 

the right of the ‘Custom card’ window.
5 Click the ‘Apply’ button to save any changes you have made.
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Key Operator settings

The Key Operator is responsible for correct default settings of the system. 
These settings include the default settings, and groups of default printer 
settings for the print jobs, the scan-to-file jobs and the copy jobs.

The Key Operator can define all timer settings, such as the panel time out and 
the sleep mode time out.

Note: Only one Key Operator or System Administrator can log on to the Océ 
Settings Editor at a time.

In order to perform special Key Operator functions, you must log on to the Océ 
Settings Editor as a Key Operator.

As these functions are restricted to a dedicated Key Operator, a password is 
required to access them. The service engineer will provide this password to 
you upon installation.

Note: When you are finished, make certain you log off from the Key Operator 
mode of the Océ Settings Editor to prevent unauthorized use of the Océ 
TDS800.

� Defining Key Operator settings in the Océ Settings Editor

1 Maximize the Océ Settings Editor on the screen.
2 log on as Key Operator.
3 Click on one of the top buttons to display the desired group of settings.
4 Select the setting you want to update in the tree structure.
5 Update the setting in the update area as required.

Note: A few settings, such as the defaults for the Custom card, are defined 
directly from the tree structure area.

6 Click on the ‘Apply’ button.
The new value is now applied to the setting
Log off from log off the Key Operator mode when you have finished updating 
the settings.
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System Administrator settings

The Océ TDS800 System Administrator is responsible for: 

� Dithering matrix and Poker settings
� Printer language controller settings
� Pen settings
� Automatic Language Selection (ALS) settings
� Controller identification settings
� Set memory reservation settings
� Connectivity settings 

To modify the System Administrator settings, you must access the SA settings 
in the Océ Settings Editor.

There are two categories of System Administrator settings (see figure 67):

� Printer
� System

.

[67] System Administrator settings in the Settings editor

In order to perform special System Administrator functions, you must log onto 
the Océ Settings Editor as a System Administrator (see ‘User modes’ on 
page 147).

Note: When you are finished, be sure to log off from the System Administrator 
mode of the Océ Settings Editor to prevent unauthorized use of the Océ 
TDS800.
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� Define System Administrator settings in the Océ Settings Editor

1 Maximize the Océ Settings Editor on the screen.
2 log on as System Administrator. 

See ‘User modes’ on page 147 for more information about logging onto the 
Settings Editor.

3 Click on one of the top buttons to display the desired group of settings.
4 Select the setting you want to update in the tree structure.
5 Update the setting in the update area as required.

Note: A few settings, such as the default pen settings, are made directly 
from the tree structure area.

6 Click on the ‘Apply’ button.
The new value is now applied to the setting

7 log off from the System Administrator mode when you are finished updating 
settings.
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Chapter 7
Océ Power Logic®: System 
Control Panel

This chapter describes how to view the status of the Océ 
TDS800 system on the Océ System Control Panel.
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Introduction

The Océ System Control Panel (SCP) application provides you with status 
information about the system. This includes:
� Machine status of the printer
� Overview of the loaded media types and sizes
� Machine status of the scanner
� Status of the system
� Memory usage

Note: If you do not have a scanner, the scanner status is not available. If you 
only have a scanner, the machine status of the printer and the overview of the 
loaded media are not available. 

Structure

The Océ System Control Panel window is divided into the following parts (see 
figure 68 on page 128):

The menu bar  which contains the following menus:
� File - Logon, Logoff, Connect to and Exit.
� Edit

If you select this option, a window is displayed in which you can view the 
default system for the Océ System Control Panel application. The Automatic 
logon option allows you to automatically start the application in the specified 
user mode.

� View
The View menu allows you to switch between the display languages as 
defined in the Edit options window and to enable or disable Océ System 
Control Panel subwindows.

� System
The System menu allows you to dump your configuration settings, make a 
demo print, clear the system and shut down the system.

Help options: Contents of Océ System Control Panel, About Océ System 
Control Panel.
� Toolbar

The toolbar of the Océ System Control Panel contains the following buttons:
Printer: to hide or to show the status of the printer.
Media: to hide or to show media information.
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Scanner: to hide or to show the status of the scanner.
Controller: to hide or to show the status of the controller.
Memory: to hide or to show the amount of set memory in use.

Note: If operator intervention is required for a device, the corresponding 
button flashes.

The Printer status display  Displays the current status of the Printer. Any error 
messages displayed on the printer control panel also appear in the printer status 
window of the Océ System Control Panel.

The Media display  Provides graphical information about the status of the rolls 
and sheet feeders (available, empty or disabled) of the printer and information 
about the available media (size and type).

Note: If the Media type is polyester, the thickness is displayed in mail (0.001"), 
otherwise the weight is displayed in g/m2 or lbs. bond. 

When a roll or tray is disabled, the roll or tray icon is dimmed and the media 
information is replaced by the text “-disabled-” (see ‘Icons’ on page 128).

Note: Special media are excluded from the automatic functionality of the Océ 
Power Logic® Controller.

The Scanner status display  Displays the current status of the scanner. Any 
error messages displayed on the scanner control panel will also appear in the 
scanner status window of the Océ System Control Panel.

The set memory meter  Indicates how much of the set memory is occupied. 
The information is displayed in the form of a meter which is divided into three 
zones:
� Green: safe, you have enough space left to print large jobs/many small jobs
� Orange: pay attention, you might be approaching the set memory limit
� Red: the set memory is (nearly) full; you should remove files or wait until 

files have been printed and automatically removed or flushed from memory. 
No more print jobs are accepted. Copy jobs can still be made.

Note: A percentage is displayed at the right of the set memory meter, indicating 
the amount of set memory currently being used.

Set the threshold values for the orange and red zones in the Océ Settings Editor.
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The following are displayed below the Océ System Control Panel main 
window:

[68] Océ System Control Panel window

Icons

The Océ TDS800 Océ System Control Panel uses a number of icons to display 
information about the media available on the printer. The following icons are 
used:

The material is available and the roll is ready for printing.

The roll is disabled.

The roll is enabled but empty.

Access to
ial

Access to
Page

Interrupt
job
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User actions

The Océ System Control Panel allows you to perform the following actions:
� Make a demo print
� Print your system configuration
� Clear the system
� Shut down the system

� Making a demo print

1 Select the ‘Demo print’ option in the ‘System’ menu.
A demo print is made on the printer.

� Printing your system configuration

1 Select the ‘Print settings’ option in the ‘System’ menu.
A list is printed of the current settings on the Océ Power Logic® Controller.

� Clear the system

1 Select the ‘Clear system’ option in the ‘System’ menu to delete all jobs. 
You can access this option in the event a corrupt job can not be deleted with the 
help of the Océ Queue Manager. 
Note: This option is only available in repro operator, key operator and 
system administrator mode. It is not possible to clear the system in 
anonymous user mode.

� Shutting down the system

1 Select the ‘Shut down’ option in the ‘System’ menu to shut down the system.
Note: It is not possible to shut down the system in anonymous user mode.
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Chapter 8
Océ Power Logic®: Queue 
Manager

This chapter describes how to view the Océ TDS800 System 
print queue, history queue and inbox queue. This chapter 
also contains a description of how to manage jobs in the 
Océ Queue Manager.
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Introduction

The Océ Queue Manager application provides you with a graphical 
representation of the print queue. It allows you to view the print queue and the 
status of print jobs, as well as manage the jobs in the queue. With the Océ 
Queue Manager you can:
� Abort the job currently being printed
� Delete jobs in the queue
� Put jobs in the queue on hold
� Print jobs from the history queue
� Print jobs form the inbox queue
� Move jobs to the top of the queue
� Restart jobs that were previously put on hold in the queue

� Start Océ Queue Manager on a remote workstation

Note: You must first install Océ Remote Logic® in ‘Installation procedure 
for Microsoft® Windows systems’ on page 141.

1 Select 'Océ Remote Logic®' from the 'Start' menu, or
2 Select the 'Launcher' application.
3 Select Queue Manager. Océ Queue Manager starts.

Note: To start more than one Océ Queue Manager, Océ System Control 
Panel or Océ Settings Editor you should use the Launcher.

Structure
The Océ Queue Manager window is divided into the following parts (see 
figure 69 on page 134):

� The standard menu bar.
The menu bar for the Océ Queue Manager contains the following menus:

� File: ‘Logon’, ‘Logoff’, ‘Connect to’, ‘Close’
� Edit: set the default printer and ‘Auto logon’.
� View: selecting the language, switching between queues, and configuring the 

view of the queues.
� Help: About Océ Queue Manager, Help contents
� The toolbar

The toolbar for the Océ Queue Manager contains the following icons:
� ‘Hold’, ‘Resume’, ‘Move to top’, ‘Delete’ and ‘Print’.
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� The active print job window.
This window displays the job currently being printed on the Océ TDS800.

� The print queue window.
This window has a tabular format and shows the jobs waiting to be printed. 
The jobs are displayed in the order in which they are expected to be printed.

Note: Set the copy priority setting in the Océ Settings Editor in order for 
copy jobs to have priority over print jobs. 
� Inbox queue

The inbox queue contains print jobs which have been sent to the inbox on the 
controller. You can print these jobs, view their properties and delete these 
jobs.

� History queue
The history queue contains print and copy jobs which have been printed. You 
can print these jobs, view, edit some of their properties and delete these jobs. 
The Océ Settings Editor allows you to define how long and how many jobs 
are kept in the history queue.

Note: You can not view the history queue and inbox queue at the same time. 
Select either the history queue or the inbox queue from view menu on the 
toolbar. They will be visible in the right pane of the queue manager window.

Note: The Inbox queue and History queue are not active when advanced 
Queue Management is disabled

� Status bar
The Océ Queue Manager has a status bar displaying the following 
information:

� System status (connected, not connected)
� The connected system
� The job status e.g. ‘printing job.A0.hp’
� User mode

The following information is displayed for each job:
� The current status and schedule of the job in the form of an icon. See ‘Icons’ 

on page 136.
� The name of the print job.
� The type of job (print job / copy job)
� The name of the user who has submitted the print job.
� The number of sets and pages.
� Any remarks (e.g. 'Manual Feed').
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You can resize the columns in the main queue window by dragging the table 
header separators. It is also possible to change the order of the columns by 
dragging a specific column to a new position.

Note: You can sort the inbox queue and history queue. You cannot sort the 
printer queue.

[69] Océ Queue Manager window
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print  queue
window
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Modes

The Océ TDS800 Queue Manager has the following modes: 
� Anonymous user mode
� Repro operator mode
� Key operator mode
� System administrator mode
� Service operator mode

These different modes are designed to limit access to specific functions to 
authorized users only. 

The anonymous user mode offers only view access to the queue. In this mode 
the buttons and menu items are disabled.

The repro operator, the key operator and the system administrator modes allow 
you to perform a number of activities on the jobs in the queue, with the help of 
the Abort, Delete, Resume and Hold buttons. The service operator mode is 
meant for Océ technicians.

Note: In the Océ Queue Manager and the Océ System Control Panel, the repro 
operator, the key operator and the system administrator have the same user 
rights. In the Océ Settings Editor, however, the user modes offer different 
rights.

Access  Access to the key operator, repro operator, system administrator and 
service operator modes is password-protected to allow only authorized 
personnel to use particular functions. You can enter these modes by selecting 
the Logon option from the File menu and by specifying the correct password 
when prompted for it, (see ‘Logging on’ on page 148). 

From the ‘File’ menu, select ‘Close’ to exit the Océ Queue Manager.

Job priority  The priority of print and copy jobs in the Océ Queue Manager is 
determined by the order in which they are submitted to the Océ TDS800. 
However, there is a setting in the Océ Settings Editor which allows you to give 
copy jobs priority over print jobs.
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Icons

The Océ TDS800 Queue Manager uses a number of icons to display 
information about a job in the queue. The following icons are used:

[70] Receiving the job

[71] Received the job

[72] Processing / processed the job

[73] The job in progress

[74] Printing the job

[75] Delivering the job

[76] The delivered job 

[77] The deleted job

[78] A job that requires manual feed

[79] The job has been placed on hold by the user or the system.

[80] Attention, needs operator attention (e.g. a media request).
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Managing print jobs

� Viewing the print queue

The Océ Queue Manager displays all jobs sent to the print queue in a list sorted 
according to the order in which they are to be printed. 

The order can be changed by: 
� deleting jobs
� putting jobs on hold
� restarting jobs currently on hold
� moving jobs to top (not when advanced Queue management is disabled)
This list will automatically be updated.

Note: Queue operations can only be performed by those with proper 
authorization. Before you can use the Océ Queue Manager in a different 
mode, you must first enter the required password in order to have access. 
See ‘User modes’ on page 147.

� Deleting print jobs

1 Select the desired jobs by clicking on them.
You can select a consecutive list of jobs to be deleted by clicking on the first 
job, holding down the Shift key and clicking on the last job. You can select a 
non-consecutive list of jobs to be deleted by clicking on each desired job while 
holding down the Ctrl key.
Note: To delete a job from a remote client, you need repro operator-, key 
operator- or system administrator-rights.

2 Click on the Delete button. 
A cross icon is displayed in front of the job to be deleted. After the job is 
actually deleted, the job is removed from the queue. 
Note: Use careful consideration when using the Delete button. A delete 
operation cannot be undone.
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� Putting print jobs on hold

1 Select the desired jobs by clicking on them.
You can select a consecutive list of jobs to be put on hold by clicking on the 
first job, holding down the Shift key and clicking on the last job. You can select 
a non-consecutive list of jobs to be put on hold by clicking on each desired job 
while holding down the Ctrl key.

2 Click on the Hold button. 
A job that is put on hold will retain its position in the print queue. Once it 
reaches the top of the queue, the job that is on hold will stay there until it is 
restarted or deleted. While a job is on hold, other jobs will be printed, even if 
they were behind the job on hold in the queue. The active job and the jobs in 
printing state can not be put on hold by the Océ Queue Manager.

� Restart jobs that are put on hold

1 Select the desired jobs by clicking on them.
You can select a consecutive list of jobs to be restarted by clicking on the first 
job, holding down the Shift key and clicking on the last job. You can select a 
non-consecutive list of jobs to be restarted by clicking on each desired job 
while holding down the Ctrl key.

2 Click on the Resume button. 
The selected jobs are now restarted.

� Moving jobs to the top

Note: Not when advanced Queue Management is disabled.
1 Select the desired jobs by clicking on them. 
2 Click on the Move to top button on the toolbar.

If more than one job is selected, then the first selected job will be on top, the 
second below that one, and so on.



139

Océ TDS800

User Manual

Chapter 9
Océ Power Logic®: Remote Logic

This chapter describes how to install and use Océ Remote 
Logic®.
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Introduction

Océ Remote Logic® enables you to:
� View system status (Océ System Control Panel)
� Manage print jobs (Océ Queue Manager)
� Change settings (Océ Settings Editor)

Océ Remote Logic® has five different user modes (see ‘User modes’ on 
page 147). These user modes are meant to limit access to the special functions 
to authorized users. Log on to get access to one of the user modes.

Change the display language, to operate the Océ Remote Logic® in your 
language. Use the help system if you do not know how to work with the 
applications.

Océ Remote Logic® is available on the local host and as a remote version. Océ 
Scan Manager is only available on the local host.

The Océ Remote Logic® applications can be run separately. If you start the 
applications separately, you must log on and select a language in each 
application. If you start the applications with the Application Launcher, the 
language is selected automatically.

Note: The default language is English UK
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Installation procedure for Microsoft® 
Windows systems

Before you install Océ Remote Logic®, you must make note of the following 
minimum system requirements for the remote system. The system must be a 
Pentium® 233 with 32 Mb RAM running Windows® 95, 98, NT (service pack 
3) or Windows® 2000.

Océ Remote Logic® (Océ Queue Manager, Océ System Control Panel and 
Océ Settings Editor) are on the Océ TDS800 CD-ROM and on the Océ Power 
Logic Controller® CD-ROM provided with the system. The installation 
procedure for Océ Remote Logic® is quite simple and self-explanatory. When 
you select the ‘Install remote applications’ option on the CD-ROM, a Wizard 
guides you through the installation process. Once the installation process is 
complete, you do not have to restart your system.

Note: Océ Remote Logic only works when TCP/IP is enabled on your system. 
Refer to your system administrator for assistance with the TCP/IP installation 
procedure.
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� Installing Océ Remote Logic®

1 Insert the Océ TDS800 CD-ROM or the Océ Power Logic® Controller 
CD-ROM into the CD-ROM drive of your PC.

2 Select the ‘Install remote applications’ option. 
The installation Wizard starts and asks you to select a setup language.

[81] Choosing a setup language

3 Indicate the required language and click ‘OK’. 
4 Follow the on-screen instructions to complete the installation of ‘Océ Remote 

Logic®’.

The programs are now installed. Each application is installed separately and as 
part of a combined version called Application Launcher.

When the installation is complete, you can start the ‘Application Launcher’ by 
selecting it from the specified folder in the ‘Start’ menu. 

To work with the Application Launcher you must first connect to an available 
Océ TDS800 machine. The method for connecting is described in ‘Using the 
remote system’ on page 153.

If you plan to work with more than one of the available remote applications, 
you are advised to use the Application Launcher. The Application Launcher 
uses less system resources than the individual applications.
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Installation procedure for Unix systems

Note: A system administrator must install ‘Océ Remote Logic®’ on a UNIX 
system.

Océ Remote Logic® is set up to be platform independent. It runs on a variety 
of operating systems, provided that a Java™ runtime environment is available 
for that platform. The Java™ runtime environment must be installed by a user 
with system administrator privileges. It is also assumed that Océ Remote 
Logic® has been installed by an experienced user.

General installation instructions

� Installing ‘Océ TDS800 Remote logic®

1 Make sure that a Java™ runtime environment (JRE) has been installed on the 
system. The preferred version is JRE 1.1.8. Some links to JRE’s for various 
UNIX platforms are given below.

2 Unpack the contents of the file ‘Océ Remote Logic_vX.tar’ to a subdirectory 
on the system. 

3 Use ‘tar xvf RemoteLogic_vX.tar’ to unpack.
4 Set the environment variable ‘RL-VM-HOME’ to point to the installation of 

the JVM.

UNIX versions and the required JRE
UNIX version OS version JRE Default installation directory

IBM AIX 4.1.5 1.1.6 /usr/jdk_base

IBM AIX 4.2.1 1.1.8 /usr/jdk_base

IBM AIX 4.3.3 + fix 1.2.2 /usr/jdk_dev2

IBM AIX 4.3.3.10 + fix 1.3.0 /usr/jdk_java130

SUN Solaris® 2.6 1.1.6

HP-UX 10.20 1.1.3

LINUX 1.0 1.1.3

LINUX 1.2 1.1.8

Note: OS = Operating System, JRE = Java™ Runtime Environment
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5 Edit this file so that it points to the JRE of the system. (instructions are supplied 
in the file).

6 Save the file ‘clientstart’.
7 Run the file ‘clientstart’ with the applications as parameters. (e.g. clientstart 

QM SCP SE to start the three applications), or run ‘Application Launcher’ to 
start the applications, (alternately modify the file ‘clientstart’).

IBM AIX

For the various versions of IBM AIX, Java™ runtime engines can be 
downloaded from:
http://www.ibm.com/java

The preferred version of the Java™ runtime engine for use with Océ Remote 
Logic® is the 1.1.8 version.

HP-UX

For HP-UX 10.20 and 11.00, the runtime engine can be downloaded from: 
http://www.unix.hp.com/java
The preferred version of the Java™ runtime environment for HP-UX 
environment 10.20 and HP-UX environment 11.00 is version C.01.18.xx.

Linux

IBM has a runtime engine available for Linux, which can be downloaded from: 
http://www.ibm.com/java
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Installation procedure for Apple 
Macintosh®

Apple also has a Java™ runtime environment for the Macintosh®. The Mac 
OS Runtime for Java™ (MRJ) can be obtained at: 
http://www.apple.com/

Installation instructions for Apple Macintosh® are not available at this time. 
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Using Océ Remote Logic®

Océ Remote Logic® enables you to:
� View the system status (Océ System Control Panel).
� Manage print jobs (Océ Queue Manager)
� Change settings (Océ Settings Editor)

Océ Remote Logic® has five different user modes (see ‘User modes’ on 
page 147). These user modes are meant to limit access to the special functions 
to authorized users. Log on to get access to one of the user modes.

Change the display language to operate Océ TDS800 in the language of your 
selection. Use the on-line help system if you do not know how to continue with 
the applications.

The Océ TDS800 applications operate separately. You must log on and select 
a language in each application.

Start the Océ TDS applications in the ‘Start’ menu or with the Application 
Launcher application.

� Start Océ TDS800 on a remote workstation

1 Select 'Océ TDS800' in the ‘Start’ menu.
2 Select Application Launcher.
3 Select the required application. 
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User modes

The following user modes are available:
� Anonymous user mode
� Repro operator mode
� Key operator mode
� System administrator mode
� Service operator mode

The anonymous user mode only offers monitoring capabilities. You are not 
allowed to change anything.

The repro operator, the key operator and the system administrator modes allow 
you to perform a number of user actions.

In the Océ Queue Manager and the Océ System Control Panel, the repro 
operator, the key operator and the system administrator have the same user 
rights. The repro operator, the key operator and the system administrator 
modes allow you to perform a number of activities on the jobs in the queue, 
with the help of the Abort, Delete, Resume and Hold buttons. 

In the Océ Settings Editor, however, the user modes offer different rights. In 
repro operator mode, the operator is allowed only to view settings in the key 
operator and system administrator views. 

In key operator mode, the operator is allowed to view and change settings in 
the key operator view. The key operator is also allowed to view system 
administration settings, but is not able to change them.

In system administrator mode, the operator is allowed to view and change 
settings in the system administrator view. The system administrator is also 
allowed to view key operator settings, but is not able to change them. 

The service operator mode is meant for the use of Océ technicians.

If you are not authorized to perform a certain action, that action is grayed out.

Note: The status bar at the bottom displays the active user mode.
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Logging on

Access to the key operator, repro operator, system administrator and service 
operator modes is password-protected to allow only authorized personnel to 
use particular functions.

The default password for the System Administrator is: SysAdm.
The default password for the Key Operator is: KeyOp.
The default password for the Repro Operator is: ReproOp.
Note: The default passwords are case-sensitive. Change the passwords after 
your first logon. 

� How to log on

1 From the ‘File’ menu, select ‘Log on’.
2 Select the correct user name.
3 Enter the Password. 
4 Click ‘OK’.

Note: Log on to all Océ TDS800 programs to operate with all the 
applications.

Logon is restricted to one user only. If a second user attempts to log on, an error 
message will appear (see figure below).

[82] If a second user attempts to log on, an error message will appear.

Log off

You must log off to leave the key operator, repro operator and system 
administrator modes.

� How to log off

1 From the ‘File’ menu, select ‘Log off’.
You return to anonymous user mode.
Note: Log off from all Océ Remote Logic applications separately.
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Changing the password

You can change your password on a standard base. You can change the 
password for each user mode (except anonymous user mode, for which no 
password is required and service operator) by taking the following steps:

� Changing the password:

1 From the ‘File’ menu, select ‘Log on’.
2 Click the Password button. 
3 Select the correct user name in the ‘User name’ drop-down list box.
4 Enter the old password in the ‘Password’ text box.
5 Enter the new password in the ‘New password’ text box.
6 Enter he new password in the ‘Confirm new password’ text box and click ‘OK’ 

to confirm the new password.

Automatic logon

If you do not want to log on each time you start an application, you can select 
the automatic logon function. This option allows you to start an application 
automatically in the indicated user mode.

� Enabling automatic logon

1 From the ‘Edit’ menu, select ‘Options’.
The Options window appears.

2 Select the ‘Enable automatic logon’ check box.
3 Select the correct user mode and enter your password for that user mode.
4 Click ‘OK’.

Automatic logon is now enabled.
Note: Enable Automatic logon in all four Océ Remote Logic applications 
separately.
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Language

From the ‘View’ menu, select ‘Language’ to select one of the supported 
languages. 

Note: The check mark in front of the language indicates that this is the active 
display language.

� Setting the languages

1 From the ‘View’ menu, select ‘Language’.
To change the language in the scanner and printing operator panels, change the 
display language setting in the Océ Settings Editor.

Help

� Displaying help information

1 Open the ‘Help’ menu and select ‘Contents’. 
Here you find help information for all applications and functions of the Océ 
TDS800 applications.

Command line parameters

Six command line parameters are provided in order to start remote applications 
faster.

configfile=<config_file>  Sets the configuration file to be used.

server=server  Sets the specified server as the server to connect to.

language1=lang   Specifies the first language in combination with the 
parameter ‘country1=country’.

country1=country  Specifies the first language in combination with the 
parameter ‘language1=language’.

language2=lang  Specifies the second language in combination with the 
parameter ‘country2=country’.

country2=country  Specifies the second language in combination with the 
parameter ‘language2=language’.
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Note: You must always use a matching combination of ‘lang’ and ‘country’.

The parameters can be applied to the following applications:
� QM.exe (Océ Queue Manager)
� SCP.exe (Océ System Control Panel)
� SE.exe (Océ Settings Editor)
� Launcher (Océ Queue Manager, Océ System Control Panel, and Océ Settings 

Editor)

Note: These applications are usually located in ‘C:\Program Files\OceRemote 
Logic\Bin’.

The easiest way to do this is by creating a short-cut for an application and then 
adding the command line properties.

Example command line parameter  Below is an example of how to start the 
Océ TDS800 applications with the configuration file ‘Myconfig.cfg’, 

Language parameters
Language parameter 

(lang)
Country

Danish da DK

Czech cs CZ

Spanish es ES

Finnish fi FI

Hungarian hu HU

Italian it IT

US English en US

UK English en GB

Dutch nl NL

German de DE

French fr FR

Portuguese pt PT

Norwegian no NO

Swedish sv SE

Polish pl PL

Japanese ja JP

Chinese 
Simplified

cn CN

Chinese 
Traditional

cn TW
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connected to the ‘MyTDS800’ server. The first language is set to US English 
and the second to French:
‘C\Program Files\Remote Logic\Bin\AL.exe -configFile=Myconfig.cfg 
server=MyTDS800 language1=en country1=US language2=fr country2=FR’.



Océ Power Logic®: Remote Logic 153

Using the remote system

Start up the Océ Remote Logic applications (Océ Settings Editor, Océ Queue 
manager, Océ System control panel) on a remote client after you installed the 
software (see ‘Installation procedure for Microsoft® Windows systems’ on 
page 141). In order to use the functionality you first must add an Océ TDS800 
system and then connect to an available Océ TDS800 system.

� Add an Océ TDS800

1 Open the ‘File’ menu and select ‘Connect to’. 
A dialog box will appear with a drop-down list box containing the already 
added Océ TDS800 systems. 

2 Click ‘Edit...’. The ‘Edit systems’ dialog box appears.
3 Enter the IP address or the name of the Océ TDS800 system you want to 

connect to, in the ‘Systems’ text box.
4 Click ‘Add’. The system is added to the list. You can add as many systems as 

you wish.
Note: You can also remove an Océ TDS800 system. Select one from the list 
and click ‘Remove’.

5 Click OK twice to return to the application.

Note: Before you can add an Océ TDS800 system, the system has to be 
installed and configured by a system consultant or a technician.

� Connecting to an Océ TDS800 system

1 Open the ‘File’ menu and select ‘Connect to’. 
A dialog box will appear containing a drop-down list box with the available 
Océ TDS800 systems. 

2 Select one of the available Océ TDS800 systems and click on ‘OK’. When you 
connect to another system, all settings must be retrieved. This may take some 
time.
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Chapter 10
Océ Power Logic®: Account 
logging

This chapter describes what Account logging is and how 
you use it.
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The account logging functionality

For accounting purposes, the Océ Power Logic® Controller is able to keep 
track of all your jobs. For each job, the job information and the paper usage is 
stored. For scan-to-file with checkprint, two records are generated, one for the 
scan-to-file and one for the checkprint. 

All this data is stored in a file: the account log file. The account file contains a 
record for each copy, print, or scan-to-file job.

Account logging consists of the following steps:
1 Enable the Account logging option
2 Set the file format properties
3 Specify the correct account for a job
4 Retrieve the generated Account logging file
5 Use the generated Account logging file

Enabling the Account logging option

Account logging is an option. You enable this option in the Océ Settings Editor 
with a password.

The account log file
File format  The account logging information is stored in a file. The format of 
the file is either ASCII (using the ISO Latin-1 encoding) or UTF-16. The 
format depends on the Logging file format setting. The file format is either 
YYYYMMDD.csv (for ASCII files), or YYYYMMDD.txt (for UTF-16 files). 
Set the file name in the Océ Settings Editor.

File content  The content of the account log file is based on a text file 
consisting of a sequence of lines of text. A line of text is an ordered sequence 
of characters. Records consist of a sequence of fields separated by a field 
separator character. Each line of text forms a record. The records can be of 
different types, as indicated by a record type identifier which is the first field 
in a record.
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Storage  The account log file is stored on the controller. Each day the 
controller generates an account log file. You can determine how long the 
accounting log file is kept on the controller. Set the file age in the Océ Settings 
Editor.

File field separator  The items of a record in the account log file are separated 
by the file field separator. The file field separator depends on the regional 
settings of your operating system. By default, the file field separator is set to 
‘semicolon’. Make sure you specify the same file field separator in the Océ 
Settings Editor as is specified in your regional system settings. For Windows® 
operating system you can find this under: Start - Settings - Control Panel - 
Regional Setting - Number - List separator.

Escaping method  If the text in the field separator contains the field separator 
character, end of line or double quote, then the text in the field changes as 
follows:

1 An occurrence of a double quote is replaced by two double quotes.
2 The resulting text is surrounded by double quotes.

Note: The escaping method is compatible with MS® Access and MS® Excel.

Specify the correct account for a job

� Setting the accounting for a copy or scan-to-file job

1 Open the ‘Scanner’ card in the ‘Original’ section.
2 Press the ‘Account’ function key to toggle between ‘User ID’ and ‘Account 

ID’.
3 Enter the correct ‘Account id’ or ‘User id’ with the numeric keys, or use the 

arrow keys on the scanner operator panel.

� Setting accounting for a print job

1 For a print job, you must specify the ‘Account ID’ and the ‘User ID’ in the 
printer driver, in Print Exec® LT web or in Print Exec® LT.
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Retrieving the account files

The account log files are stored in the logging directory of the controller. You 
can retrieve your files from the local host via File Transfer Protocol (FTP). FTP 
transfer can be performed: 

1 with an internet browser or
2 with a dos box.

� Retrieve the account log file with FTP in an internet browser

1 Start an internet browser.
2 Enter the ftp address of the TDS800 system.

Note: Set the name of the system in the Océ Settings Editor.
The browser shows the FTP directories on the Océ TDS800 system (see 
figure 83).

3 Browse to the ‘Accounting’ directory.
The accounting log files are shown (see figure 84).

4 Save the accounting log files to any destination on your system. This is usually 
done by right-clicking on the file and then selecting the ‘save’ option.

[83] The FTP directories on the Océ TDS800 system
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[84] The accounting directory with the account log file on the Océ TDS800 system

� Retrieve the account log file with FTP in a dos box

1 Launch an FTP client.
2 Enter the ‘ftp’ command.

A DOS box appears with the FTP prompt.
3 Enter the ‘Open’ command followed by either the registered name of the Océ 

Power Logic® Controller or the IP address (for example: 194.2.66.146) to 
connect to the Controller and press Enter: ‘open 194.2.66.146’.
Note: Instead of performing steps 2 and 3, you could also enter “ftp 
host_name” in the FTP client.
The connection with the Controller is now established and a window appears 
asking you for a user name.

4 Enter your user name ‘anonymous’, and also enter ‘anonymous’ as your 
password. 
A connection is now set up for the default user ‘anonymous’.
Note: As there is no registered user, simply press Enter to initiate the 
connection.

5 Set the transmission mode to binary by entering ‘binary’.
6 Go to the ‘logging’ directory using the following command: ‘cd logging\’.
7 Get ‘20001011.csv’ or ‘20001110.txt’ depending on the file format setting.
8 Quit FTP by entering the ‘bye’ command.
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Using the generated accounting file

After retrieving the accounting file, you can view and use the data that are 
stored in the records. You can import the account log file into, for example, 
Microsoft® Excel or Microsoft® Access.

� Importing the account log file into Microsoft® Excel

1 Start Microsoft® Excel.
2 Open the account log file that is on your system.

Microsoft® Excel displays the content of the account log file (see figure 85).
Now you can process the data in the account log file.

[85] The account log file in Microsoft® Excel
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Account information in the log file

For each output page, an account log record (1 line) is generated. A job that 
consists of several output pages will have several account log records. In 
addition, each scan (scan-to-file jobs) generates an account log record.

All records that are part of a single job will have the same value as the ‘Job 
Unique ID’ field. This field is part of each record and is unique for each job in 
the file. This field is for collecting records that are part of a single job and for 
calculating the totals for the entire job.

Account information for the media format

If a standard output media format is chosen in a print, scan-to-file or copy job, 
the media width and height for the output media reported in the account log file 
will be exactly as specified in the following table. Any deviation from these 
values (even by 1 unit) implies that a non-standard media format was chosen 
in the job.

Note: For output in landscape orientation the width and height values are 
switched.
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Account information for media weights

In the account log file, media weight is represented by the values ‘LIGHT’, 
‘NORMAL’ and ‘HEAVY’. The following table specifies the mapping for 
actual media for the values in the account log.

Measurements for Standard Output Media Format
Format name Width

(units of 1/72 inch)
Height
(units of 1/72 inch)

A0 2384 3370

A1 1684 2384

A2 1191 1684

A3 842 1191

A4 595 842

E 2448 3168

D 1584 2448

C 1224 1584

B 792 1224

A 612 792

E+ 2592 3456

D+ 1728 2592

C+ 1296 1728

B+ 864 1296

A+ 648 864

B1 2004 2835

B2 1417 2004

B3 1001 1417

B4 709 1001

30x42 2160 3024

jis B1 2064 2920

jis B2 1460 2064

jis B3 1032 1460

jis B4 729 1032

jis B5 516 729
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Structure of the account file

The Océ TDS800 supports two different record types: 6110 and 6111. The first 
record in each account log file is type 6110 and contains a list of abbreviated 
field names that occur in type 6111. The first record is always the same in each 
account log file and is used as a comment. For example, to clarify the meaning 
of the fields if the file is imported in an application like MS® Excel.

The actual account log information is in type 6111 records (the second up to 
the last record in the account log file). The fields of that record are described 
in the table ‘All Parameter descriptions’ on page 164.

Note: For the Océ TDS400 these numbers are 6310 and 6311. For the Océ 
TDS600 these numbers are 6210 and 6211.

Description of all the parameters in the account log file

Note: The table below lists the fields in their order of appearance in the 
account log file.

Mapping for Actual Media for the Values in the Account Log
Actual material Value in log file

Plain paper 64g (16 lb. bond) LIGHT

Plain paper 75g (19 lb. bond) NORMAL

Plain paper 110g (24 lb. bond) HEAVY

Transparent 75g (Japan) (19 lb.bond) LIGHT

Transparent 90g (23 lb. bond) NORMAL

Transparent 110g (27 lb. bond) HEAVY

Vellum NORMAL

Polyester 3P5 Mil NORMAL

Polyester 4P5 Mil NORMAL

Translucent NORMAL
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All Parameter descriptions
Parameter Type Length 

(max)
Description

Record type num 4 Record type identifier = 6111.
Note: each account log file starts with a 
type 6110 record. This is a constant record 
which only contains the abbreviated field 
names used in type 6111 records.

Account ID text 255 Account ID, escaped according to 
escaping rules.
Empty field if not available. Note: numeric 
account ID from the scanner panel is 
converted to its textual representation 
(without any prefix). 

User ID text 255 User ID of submitter of job, escaped 
according to escaping rules.
Empty field if not available. Note: numeric 
user ID from the scanner panel is converted 
to its textual representation (without any 
prefix).

Job ID text 255 ID of job (e.g. job name) as specified in a 
job ticket, escaped according to escaping 
rules. Empty field if not available.

Machine ID text 255 Unique ID of the printer. If there is only a 
scanner, then the unique ID of the scanner. 
For the Océ TDS800 this is implemented 
as the serial number of the printer/scanner.

Record version num 2 Version number of this record type. 0 for 
this version.

Job Unique ID num 8 Controller-generated unique job ID. Is 
unique for each job in the log file.

Record number num 6 Sequence number of this record in the 
account log for this job. Starts at 0.

Job submission 
source

text 255 Host name or IP address of the source of 
the job.
Empty field if not available.

Channel type text Protocol used for job submission: LP, 
SMB, PSERVER, FTP, CENTRONICS

Receive date year num 4 Year when source page was received. E.g. 
2000

Receive date 
month

num 2 Month when source page was received. 
1-12
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Receive date day num 2 Day of the month when source page was 
received. 1-31

Receive time 
hours

num 2 Hour when source page was received. 0-23

Receive time 
minutes

num 2 Minute when source page was received. 
0-59

Receive time 
seconds

num 2 Second when source page was received. 
0-59

Source location text 255 Location of the input file or set:
For files in the input stream: F1 to F999 
(for the first until the 999th file in the input 
stream of this job).
For referenced files: the URL of the file.
For scans, the input set number to which 
the page belongs: S1 to S999 (for the first 
until the 999th input set). Note: The Océ 
TDS800 only supports 1 input set.

Source page 
number

num 6 Page number of the input page in the 
source set/file. First = 1

Source type text Type of source page:
For PDL’s: TIFF, CALS, PDF, PS, NIRS, 
HPGL, HPGL2, C4, CALCOMP, ASCII
For scans: SCANF (scan of front of page), 
SCANB (scan of back of page)

Source width num 6 Native width of source page in points (1/72 
inch)

Source height num 6 Native height of source page in points 
(1/72 inch)

Output width num 6 Actual width of output page in points (1/72 
inch)

Output height num 6 Actual width of output page in points (1/72 
inch)

Width scale num 4 The scaling factor applied to the width of 
the original. In percentages. 

Height scale num 4 The scaling factor applied to the height of 
the original. In percentages.

Mirroring text 2 Mirroring applied to the original.
LR (left and right switched) or TB (top and 
bottom switched). Empty if no mirroring 
applied.

All Parameter descriptions (continued)
Parameter Type Length 

(max)
Description
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Rotation angle num 3 Counter-clockwise rotation angle of the 
scaled (and possibly mirrored) original. 
Possible values: 0, 90, 180, 270. An angle 
of 0 implies that the orientation of the 
source and output image is the same.

Process type text Type of processing that was done for this 
page:
PRINT, COPY, STF (scan to file), CHK 
(checkprint), ICOPY (interrupt copy), 
INTRNL (internal job), HEADER (header 
page), TRAILER (trailer page), 
ERRPAGE (error page), REPLOT (from 
history queue)

Process 
completion

text Process completion for this page: DONE 
(normal termination), ABRT (job aborted 
by user), ERR (error occurred).
In case an error occurred or the job was 
aborted, the last page that was correctly 
delivered has value DONE and an extra 
record with value ABRT or ERR is 
generated for the page that did not come 
out due to the error.

Delivery date year num 4 Year when source page was delivered. E.g. 
2000

Delivery date 
month

num 2 Month when source page was delivered. 
1-12

Delivery date day num 2 Day of the month when source page was 
delivered. 1-31

Delivery time 
hours

num 2 Hour when source page was delivered. 
0-23

Delivery time 
minutes

num 2 Minute when source page was delivered. 
0-59

Delivery time 
seconds

num 2 Second when source page was delivered. 
0-59

Output page 
number

num 6 Page number of the output page in this job. 
First = 1. Physical output pages are 
numbered separately from digital output 
pages.
Digital output pages are numbered 
separately for each separate output file.  

All Parameter descriptions (continued)
Parameter Type Length 

(max)
Description
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Output media type text Type of the output medium in case of 
physical output: PAPER (plain paper), 
TRANSPARENT, FILM, POLYESTER, 
VELLUM, TRANSLUCENT. Empty if no 
physical output. 

Output media 
special

text 1 Indicates if special output media is 
selected. Y or N.
Empty if no physical output

Output media 
weight

text Output media weight in case of physical 
output: LIGHT, NORMAL, HEAVY. 
Empty if unknown or if it is only a digital 
output.

Output media 
source

text Source from which the output media was 
taken in case of physical output: ROLL1, 
ROLL2, ROLL3, ROLL4, ROLL5, 
ROLL6, TRAY1, TRAY2, TRAY3. 
MANUAL (manual feed slot). Empty if no 
physical output.

Output fold 
method

text Folding method applied to the output 
media in case of physical output:
For folding in two directions: AFNOR, 
ERICSSON, DIN.
For folding in one direction: AFNOR1, 
ERICSSON1, DIN1.
Empty if no physical output or not folded.

Output binding 
method

text Specifies the binding method for the output 
media. STRIPONLY (only binding strip), 
REINFORCE. Empty if no physical output 
or no binding method.

Output media 
destination

text Output media destination in case of 
physical output: BELT1, BELT2, BELTS, 
CDT, IRT, FIRSTFOLD, STACKER.
Empty if no physical output.

Output file type text Type of output file in case of digital output: 
TIFF, CALS, PDF. Empty if no digital 
output.

Output file 
compression

text Compression method of output file in case 
of digital output: GROUP3, GROUP4, 
PACKBITS, LZW. Empty if no digital 
output or no compression.

All Parameter descriptions (continued)
Parameter Type Length 

(max)
Description
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Output file size num 9 Size of the output file in bytes (including 
all pages of multi-page output files) in case 
of digital output. Empty if no digital 
output.

Output file 
destination

text 255 Nickname of the destination for the output 
file as used in the Océ Scan Manager in 
case of digital output. If multiple pages in 
one job have the same destination file, a 
multi-page file is generated. Empty if no 
digital output.

Output resolution 
(width direction)

num 4 Resolution of output in width direction in 
dpi

Output resolution 
(height direction)

num 4 Resolution of output in height direction in 
dpi

Completion Id num 8 Indicates the instance number of the job. 
First instance is one. More than one job 
instance occurs when jobs are restarted 
from the history queue.

All Parameter descriptions (continued)
Parameter Type Length 

(max)
Description
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Chapter 11
Océ Print Exec® LT Web

The Océ Print Exec® LT Web is a job submission 
application which allows you to send print jobs to the Océ 
TDS800 from your web browser.
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Introduction to Océ Print Exec® LT Web

Océ Print Exec® Light Web is optional software which allows you to create 
and send a set of prints or drawing files to the Océ TDS800 printer. You can 
send the settings for these jobs from your workstation, using your web browser.

Basic concepts

Océ Print Exec® LT Web allows you to:
� Get information on the printer configuration
� Get information on the available media
� Get information on pending jobs in the printer queue
� Assemble documents in a job
� Prepare the settings which are used for the printer
� Submit the job to the printer

Requirements for the user browser software

� Microsoft® Internet Explorer® 4.02(Service Pack 2) or higher
� Netscape® Navigator® 4.08 or higher
� Java Virtual Machine version 3802 must be installed and enabled on your 

web browser.

Requirements for the network infrastructure

� TCP/IP network, which connects the printer and the end user workstation
� Port 8001 must not be filtered.

Connecting to the Print Exec® LT Web

� Connect to the Print Exec® LT Web

1 Enable Print Exec® LT Web in the Océ Settings Editor.
2 Type the following URL in your browser: http://Printername



Océ Print Exec® LT Web 171

Note: The ‘Printer name’ is the domain network server (DNS) name or IP 
address of the printer (see figure 86 on page 171).

[86] Océ Print Exec® LT Web

Creating new jobs

Océ Print Exec® Light Web allows you to create print configuration templates 
for your jobs. Océ Print Exec® Light Web provides 2 ways to submit jobs: 
Basic and Advanced. 

Print configuration allows you to do the following:

� Create print configuration templates
� Edit existing print configuration templates
� Delete existing print configuration templates
� Show the print configuration templates for the current user only
� Show all the print configuration templates

Basic job submission allows you to do the following:

� Create a job
� Add up to 10 documents to the job
� Remove documents
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� Define job and document basic settings (number of copies, zoom, collate, 
reverse order, send to inbox, media type, weight and size, rotation, fold and 
print mode)

� Specify a name for the job (optional)
� Specify a job owner
� Specify a user ID (optional)
� Specify an account ID (optional)
� Print the job

Advanced job submission allows you to do the following:

� Create a job
� Add up to 100 documents to the job
� Define all settings for each document in the job
� Apply the print configuration templates to the jobs
� Specify a name for the job
� Specify a job owner
� Specify a user ID
� Specify an account ID
� Remove documents
� Print the job
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� Creating print configurations

1 Click on the 'Print configurations' button at the bottom of the screen.
A form appears as shown in figure 87 on page 173.

2 Click ‘Create’ to create a print configuration template.
3 Give a name to your print configuration template.

Note: The user name is added to the configuration name in the header.
4 Click ‘OK’
5 Define the settings to apply to the configuration
6 Click ‘Save’. A successful save is confirmed with a message.

[87] Print configurations

For more information, please consult the on-line help.



174 Océ TDS800 User Manual

� Creating a new job - Basic

1 Click on the 'New job - Basic' button at the bottom of the screen.
A form appears as shown in figure 88 on page 174.

2 Click ‘Browse’ to add documents.
3 Click ‘Submit’ when you are ready.

[88] Basic job composition

For more information, please consult the on-line help.
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� Creating a new job - advanced

1 Click on the 'New job- Advanced' button at the bottom of the screen.
A form appears as shown in figure

2 Click ‘Browse’ to add documents.
3 Select a print configuration template to apply to your job
4 Click ‘Submit’ when you are ready.

[89] Advanced job composition

Note: Java must be enabled on your browser to use the advanced job 
submission.

For more information, please consult the on-line help.
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Welcome page

When Océ Print Exec® LT Web is not enabled on your system, Océ Print
Exec® LT Web shows a welcome page. This page has information about how
to enable Océ Print Exec® LT Web and a link to a demo version.



177

Océ TDS800

User Manual

Chapter 12
The folder

This chapter describes:
� The folder
� The reinforcement unit
� The belt unit
� The punch unit
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Introduction

If you have a folder installed on your Océ TDS800 system, the following 
optional features are available:
� Reinforcement unit
� First belt unit
� Second belt unit
� Punch unit
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Folder

The Océ TDS800 can have a folder to fold your output. The output is folded 
according to the selected folding width and length with the drawing method. 
Set the drawing method in the Océ Settings Editor. 

Note: You can only fold paper. Polyester, transparent or vellum media cannot 
be folded. If you try to fold polyester, transparent or vellum media, a media jam 
will occur.

Standard folding settings  By default, the standard folding settings defined for 
your Océ TDS800 system by the key operator is used. The following settings 
are available:

� Set folded copy delivery

1 Click on the ‘Finishing’ card in the ‘Print’ section.
2 Click on the function key ‘Folded copy delivery’.
3 Select ‘Stacker’ or ‘Belt’.

� Set folding legend

1 Click on the ‘Feeding’ card in the ‘Original’ section.
2 Click on the function key ‘Legend location’.
3 Select ‘Leading’ or ‘Trailing’.

Note: In the drivers this setting is called the ‘Folding orientation’, with the 
options ‘Portrait’, ‘Landscape’ and ‘Automatic’.

� Setting the drawing method

1 Click on the ‘Feeding’ card in the ‘Original’ section.
2 Click on the function key ‘Drawing method’.
3 Select ‘Standard’, ‘Ericsson’ or ‘Afnor’.

� Setting the folded package width

1 Click on the ‘Finishing’ card in the ‘Print’ section.
2 Click on the function key ‘Folded package’.
3 Select ‘Width’. 
4 Enter a range between 186 - 230 mm or 7.3 - 9 inch, in steps of 1 mm or 0.1 

inch; default 210 mm or 9 inch.
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� Setting the folded package length)

1 Click on the ‘Finishing’ card in the ‘Print’ section.
2 Click on the function key ‘Folded package’.
3 Select ‘Length’. 
4 Enter a range between 276 - 310 mm or 10.9 - 12.2 inch., in steps of 1 mm or 

0.1 inch; default 297 mm or 12 inch

� Setting the binding strip

1 Click on the ‘Finishing’ card in the ‘Print’ section.
2 Click on the function key ‘Binding’.
3 Select binding enabled or disabled.
4 If you selected enabled enter a range between 15 - 30 mm or 0.6 - 1.2 inch, in 

steps of 1 mm or 0.1 inch; default 20 mm or 0.8 inch.

� Setting the reinforcement

1 Click on the ‘Finishing’ card in the ‘Print’ section.
2 Click on the function key ‘Binding’.
3 Select ‘Reinforce’ enabled or disabled.

Note: Reinforcement is only possible with the Standard folding method

You can override the standard folding program with settings from the printer 
driver or the scanner operator panel. 

Find more information about Océ printer drivers in the on-line help. 
Procedures for defining folding settings on the Océ TDS800 Scanner panel are 
described below.

See ‘Standard folding settings’ on page 179 for complete information about 
defining default folding settings.

� Fold settings from the Océ TDS800 scanner operator panel

1 Open the ‘Feeding’ card in the ‘Original’ section and press the ‘Legend 
location’ function key to select the required legend location (‘Leading’ or 
‘Trailing’).
Note: Make certain that your legend is always located on your left-hand 
side to ensure correct positioning of the legend during folding.

2 Click on the ‘Drawing method’ function key to select ‘Standard’, ‘Ericsson’ or 
‘Afnor’ fold.
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[90] Fold options from the scanner operator panel

3 Open the ‘Finishing’ card in the ‘Print’ section.
4 Click on the ‘Folding’ function key to select ‘Full’ or ‘First fold only’ (see 

figure 91).
5 Click on the ‘Folded package’ function key and change the length and/or width 

of the folded package, as required, by using the arrow  or the numeric keys.
6 If required, click on the ‘Binding’ function key.

Set the required binding strip using the arrow or the numeric keys.
7 Define other settings as required.
8 Feed the original.

[91] Folding options from the scanner operator panel

You can also select a drawing method and, if needed, a folding length, folding 
width and binding strip. When you change the folding length and/or folding 
width, and the folder has a belt, you must also adjust the side guides of this 
unit.
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Maximum folding length  There are maximum values for different kinds of 
paper. The tables below show the maximum values for three different weights 
of paper and the possible folded output for 110-gram (27 lb. bond) paper.

Maximum output lengths for folding 
First fold output Stacker 2nd fold Stacker 2nd fold Belt 2nd fold

Paper weight 
[g/m2] (lb. 
bond)

1st fold
[mm / inch]

2 folds
[mm / inch]

3 folds
[mm / inch]

2folds
[mm / inch]

60 1220 / 48 1220 / 48 1220 / 48 1220 / 48

75 6000 / 236 2500 / 98 2000 / 79 1220 / 48

110 2500 / 98 1220 / 48 not possible 1220 / 48

Folding settings 110 grams (27 lb. bond)
Output length Delivery

‘Stacker’ or ‘Belt’
selected

 < 1220 mm (48'')
(3 folds)

Delivered in first fold delivery

 < 1220 mm (48'')
(2 folds)

Delivered on stacker or belt

 > 1220 mm (48'')
< 2500 mm (98.5'')

Delivered in first fold delivery

> 2500 mm (98.5'') Unfolded, delivered in copy delivery 
tray

‘First fold only’ selected < 2500 mm (98.5'') Delivered in first fold delivery

> 2500 mm (98.5'') Unfolded, delivered in copy delivery 
tray
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Reinforcement unit

If you install a reinforcement unit, output can be delivered with a prepunched, 
self-adhesive strip (see figure 92). 

[92] Example a of reinforcement strip

With this strip the output can be stored in a binder without running the risk of 
tearing out the punch holes. You can unfold a folded map in a binder without 
opening the binder mechanism (see figure 93). 

[93] Example of a folded map with a reinforcement strip

Protection sheet
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The optional reinforcement unit supports all media sizes larger than A4 (letter 
size). However, A4 (letter) size media can also be reinforced if you enable A4 
reinforcement in the Settings Editor. 

Note: Reinforcement is only possible with the Standard folding method.

See ‘Reinforcement unit’ on page 183 for more information about inserting a 
new tape roll and other maintenance issues.

� Enable reinforcement

1 Click on the ‘Jobs’ key in the Océ Settings Editor.
2 Select the ‘Copy’ tab if you want to enable folding reinforcement for copy jobs 

or select the ‘Print’ tab if you want to enable folding reinforcement for print 
jobs.

3 Open the ‘Defaults’ folder.
4 Open the ‘Finishing’ folder.
5 Select the ‘Folding reinforcement’ option.
6 Enable folding reinforcement in the right part of the window. 
7 Click on the ‘Apply’ key to save any changes you have made.
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Belt unit

The belt units offer a large capacity and more flexibility. On the belt unit, 170 
folded A0 prints can be delivered offset stacked. You can adjust the side guides 
of the belt depending on the width of the folded package.

Note: The belt unit can also be selected from the drivers or the scanner 
operator panel. The remote command overrules the key operator setting.

� Selecting belt as folded copy delivery on scanner operator panel

1 Open the ‘Finishing’ card in the ‘Print’ section of the scanner operator panel.
2 Click on the ‘Folding’ function key to select full folding.
3 Click on the ‘Folded copy delivery’ function key to select the belt.

You have 3 options (depending on your configuration): the upper belt, the 
lower belt of both belts.

� Adjusting the side guides of the belt

1 Loosen the nuts (see figure 94).

[94] Adjust the side guides of the belt

2 Adjust the plate in accordance with the width of the fold package.
3 Tighten the nuts.

Note: If you change the folding width or the folding length, you have to adjust 
the punch unit.
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� Adjust the punch unit

1 Open the front door of the high capacity output unit of the folder.
2 Turn the black knob to adjust the folding width (see figure 95). Refer to the 

sticker inside the unit.

[95] Knob to adjust the folding width in the punch unit

3 Loosen the screw and place the plate according to the folding length (see 
figure 96).

[96] Nut to adjust the folding length in the punch unit

4 Tighten the screw. 
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Full belt detection

The Océ TDS800 has full belt detection on both belts. The attention light on 
the printer operator panel will go on if the belt is full. The system can switch 
belts when the first belt is full. You can define the number of jobs required to 
make the belt full. 
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Chapter 13
Media and supplies

This chapter describes how to:
� Load paper
� Add toner
� Change tape in the reinforcement unit
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Loading rolls of media

The Océ TDS800 has three paper roll compartments, each with two rolls. Rolls 
one, three and five have a roll loader. Each of the rolls can be loaded with 
media of a different size or type. The operator panel displays the width and the 
type of media on each roll.

If you load new media, you must indicate to the system which type of media 
you have loaded: paper, transparent, vellum or polyester. The roll width is 
detected automatically.

The definition of the new media is important when ‘Automatic roll switch’ is 
on.

� Loading paper

1 Open the correct paper roll compartment (see figure 97).

[97] Open the correct paper roll compartment

2 If necessary, clear the chip tray (see ‘Clear the chip tray’ on page 195)).
3 Remove the roll holder from the paper roll compartment.
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4 Press the green knob inside the roll holder to release the locking mechanism 
and remove the core from the holder (see figure 98). 

[98] Removing the core from the holder

Note: You can place the new roll in the groove on the manual feed of the 
printer. See the arrow on picture 97 on page 190.

5 Press the locking mechanism down and slide the roll holder from the left into 
the core of the new roll.

6 Position the roll between the correct format indicators and release the locking 
mechanism (see figure 99).

[99] Placing a new roll on the holder



192 Océ TDS800 User Manual

7 Use both hands to put the holder in the paper roll compartment. First, position 
the left-hand side of the holder in its notch, then position the right-hand side in 
its notch (see figure 100).

[100] Put the roll into the paper roll compartment

8 If the new roll does not have a straight leading strip you can cut it manually.
9 Press the correct button inside the paper roll compartment and feed the paper 

between the input guide plates as indicated by the arrow (see figure 101). The 
material is fed into the machine. 
Note: Also, see the stickers inside the roll compartments on how to feed 
paper.

[101] Button to feed the paper

10 Close the paper roll compartment. The material is cut. The size of material is 
indicated on the operator panel.
Note: If you have loaded another media type, you must define the type (see 
‘Define the media type’ on page 194).
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� Use the roll loader to load a roll

1 Fully open the roll compartment.
The roll loaders are installed in the drawer. The roll loaders consist of a metal 
frame with a lever and a green knob in the middle of the lever.

2 Pull the horizontal lever to the right in order to place the roll loader in vertical 
position.

3 Pull the lever completely forward. The roll holder is lifted (see figure 102).

[102] Roll loader in vertical position

4 Remove the roll holder from the paper roll compartment using both hands.
5 Press the green knob inside the roll holder to release the locking mechanism 

and remove the core from the holder.
Note: You can place the new roll in the groove on top of the manual feed of 
the printer. See the arrow on picture 97 on page 190.

6 Slide the roll holder in the new roll of material while you press the green knob.
7 Align the roll with the correct size indicator on the roll holder and release the 

locking mechanism.
8 Use both hands to place the holder in the roll loader (see figure 100).
9 Place the holder back in the roll compartment by returning the roll loader lever 

to its vertical position.
10 Press the correct button inside the paper roll compartment and feed the paper 

between the input guide plates as indicated by the arrow (see figure 101). The 
material is fed into the machine. 
Note: Also, see the stickers inside the roll compartments on how to feed 
paper.

Attention: Be careful when you lift the lever to avoid damaging the roll 
compartment.

1

2
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11 Use both hands to slide the material under the metal paper guide until it makes 
contact, follow the procedure ‘Loading paper’ on page 190.

� Define the media type

1 Press the ‘On-line’ key on the printer operator panel to take the printer 
Off-line. The message ‘Off-line’ is displayed in the status window.

2 Press the left selection key to shift the focus to the media selection.
3 Use the arrow keys to select roll 1 to 6 (see figure 103).
4 Press the right selection key to select the setting you want to define.
5 Use the arrow keys to define the settings.

Note: The system detects the media size. Media sizes of both the DIN and 
ANSI paper series are available. Use the Arrow buttons to select either a 
DIN or ANSI format.

6 Put the printer On-line again by pressing the ‘On-line’ key.

[103] Setting the correct media

7 When you are ready, you can continue your job.

Ready to print

Selection keys
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Clear the chip tray

If the chip tray is full, you must clear the paper chips.

� Clearing the chip tray

1 Open the upper paper roll compartment.
2 Take out the chips (see figure 104).

[104] The chip tray

3 Close the paper roll compartment.
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Adding the toner

If the toner is empty the display shows: ‘Out of toner’ (see figure 105). You can 
add toner even while you print a job. You can finish your current job. 

Note: If you do not add toner in time, the system will stop.

[105] ‘Out of toner’ message

� Adding toner

1 Shake the toner bottle.
2 Loosen the cap.
3 Open the front top cover.

Note: Only use E1 toner.
4 Open the toner refill opening.

Note: Do not remove the seal of the bottle opening.
5 Place the bottle with the ridge into the notch of the fill opening and push it 

down (see figure 106).

[106] Place the toner bottle into the fill opening

The seal at the bottle opening is cut at the opening of the toner reservoir, 
allowing the toner to get out of the wide bottle.
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6 Hit the bottom of the bottle.
Note: Only add one bottle at a time.

7 When the bottle is empty, remove the bottle.
8 Closing the fill opening
9 Lift top cover and pull the hinge towards you to close the top cover (see 

figure 107).

[107] Closing the top cover

10 Fasten the cap on the empty toner bottle. The Océ service engineer takes the 
empty toner bottles with him on his next visit.

Attention: If you have spilled some toner, (see ‘Safety data sheet Océ E1 
toner’ on page 263) for information about disposal and cleaning.
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Changing the tape roll in the reinforcement 
unit

When the tape roll of the reinforcement unit is empty while the printer is in 
sleep mode, one of these messages appear on the display:

� ‘Reinforcing not possible: out of tape’ for copy jobs.
� ‘Load reinforcement tape’ for print jobs.
� ‘No tape in reinforcement unit’ for copy and print jobs while the printer was 

running when the roll ran out of tape.

When a tape roll is empty while the printer runs, this message has a picture of 
the printer with the side door of the Reinforcement Unit flashing (see 
figure 108).

[108] No tape in reinforcement unit
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� Removing an empty tape roll

1 Open the side door of the reinforcement unit (see figure 109).

[109] Opening the side door of the reinforcement unit

2 Turn the two guide plates away from the pin roller into their fixed opened 
position (see figure 110).

[110] Open the guide plate
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3 Remove the trailing strip from the old tape (see figure 111).

[111] Remove the trailing strip from the old tape.

4 Remove the screw of the front side plate of the roll holder with the green nut 
and remove the old kernel.

Note: Clean the reinforcement knives before you put in a new roll

� Inserting a new tape roll

1 Place the new roll and close the side plate. Place the roll with the holes to the 
back and the protection sheet to the front (see figure 112).

[112] Placing the new roll



Media and supplies 201

2 Release the end of the roll and lead the tape over the large guide roller (see 
figure 113).

[113] Guiding the tape around the guide roller

3 Lead the tape between the upper and lower knife and over the pin roller (see 
figure 114).

[114] Lead the tape between upper and lower knife
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Note: Make sure at least 200mm (7.87'') (2 strip lengths) of tape is past the 
knife section (see figure 115)

[115] tape past the knife section

4 Align the holes in the tape to the hole pattern on the label on the frame plate of 
the reinforcement unit (see figure 116). If the alignment is not correct, lift the 
tape from the pin roller and push the tape between the two knives until the 
holes are aligned.

[116] Adjust the holes on the tape
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5 Close the guide plates of the pin roller (see figure 117)

[117] Close the guide plates

� Preparing the tape roll for operation

1 Peel the protection sheet off the tape (see figure 118).

[118] Peel off the protection sheet
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2 Lead the protection sheet back between the upper and lower knife (see 
figure 119).

[119] Lead the protection sheet between upper and lower knife

3 Lift the guide and lead the protection sheet between the protection sheet 
rollers, pulling the protection sheet tight (see figure 120).

[120] Leading the protection sheet between the rollers



Media and supplies 205

4 Insert the leading strip of the tape into the closed section of the slide (see 
figure 121).

[121] Inserting the tape into the closed section of the slide

5 Hold the upper guide plate down and cut the tape at the knife section and pull 
the strip up so that the tape is cut by the upper knife. (see figure 122).

[122] Cut the tape at the knife section

6 Close the side door of the reinforcement unit.
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Chapter 14
Maintenance

This chapter describes:
� Maintenance of the reference roller
� Maintenance of the reinforcement unit
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Cleaning the reference roller

If the reference roller is dirty or has a static charge, you must clean it.

Attention: Whenever you clean the reference roller, be careful not to 
damage the sensors on the scanner.

� Cleaning the reference roller

1 Turn off the scanner.
2 Press the grip at the right hand side, below the original feed table, to open the 

top cover of the scanner (see figure 123). 
Note: Make sure that you hold the top cover of the scanner.

[123] Open the top cover of the scanner
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3 Clean the white reference roller over its entire circumference with a soft cloth 
with a small amount of Cleaner A.
For safety information see ‘Safety data sheets’ on page 260.

4 Press at the left and right side of the scanner to close the top cover (see 
figure 124).

[124] Close the top cover of the scanner

5 Turn the scanner on.
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Maintenance of the Reinforcement Unit

Maintenance of the Reinforcement Unit includes:
� Clearing the waste box
� Cleaning the reinforcement knives

Attention: To prevent damange to the Reinforcement Unit, only use original 
Reinforcement Strips from Océ.

Clearing the waste box

If a reinforcement unit is installed, the protective sheet from the reinforcement 
tape is stored in a waste box.

Note: You can clear the waste box while you print.

� Clearing the waste box

1 Open the waste box by pulling it to the left-hand side and towards you (see 
figure 125).

[125] Opening the waste box

2 Clear the box.
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3 Push the waste box forward and push it to the right-hand side to close it (see 
figure 126).

[126] Closing the waste box

Cleaning the reinforcement knives

The knives of the reinforcement unit get sticky from the glue on the 
reinforcement tape. Clean the knives whenever you insert a new tape roll (see 
‘Changing the tape roll in the reinforcement unit’ on page 198) or whenever an 
error occurs in the Reinforcement Unit.

Place the knives into a position that enables you have access to all parts. 

Attention: To avoid damaging the Reinforcement Unit, only use the original 
Cleaner K and Fixing Unit Cleaning Oil (silicon oil) from Océ.

� Cleaning the reinforcement knives

1 Press the on-line key on the printer operator panel to take the printer off-line. 
The ‘Off line’ message is displayed in the status window.

2 Press the left selection key to shift the focus to ‘Clean reinf. knife’. A shadow 
highlight effect is used to indicate that the focus is set to this menu.

3 Select the right selection key ‘Clean’. The reinforcement knives are placed in 
the correct position.

4 The machine stops and the yellow indicator on the printer goes ON. 
5 A picture of the printer appears on the display with the side door of the 

reinforcement unit flashing.
6 To see the text, press the ‘text’ key.

Note: If a job is running, the ‘Job interrupted’ message appears. The 
machine will stop once it has correctly finished the prints that were already 
in the printer.

7 Open the side door of the reinforcement unit (E).
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8 Clean the upper and lower knives with Cleaner K (see figure 127).

[127] Clean the upper and lower knives

9 Oil the felt with Fixing Unit Cleaning Oil (silicon oil).

[128] Oiling the felt

10 Close the side door of the reinforcement unit. 
The knives are placed back in their home position. The picture on the display 
disappears. The message ‘Press start to resume job’ or ‘Ready to print’ 
appears, depending on whether or not a job was interrupted to clean the knives. 

11 The yellow indicator goes OFF.
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� Emptying the waste basket

1 Open the front door of the folder (see figure 129).
2 Lift and remove the waste tray (see figure 130).
3 Empty the waste basket.
4 Place the waste basket back in its original position. Make sure you feel it snap 

into place.

[129] Open the front door of the folder

[130] Removing the waste tray

1 Removing the waste tray
2 Put it back. Allow the magnetic attraction to help you place the waste tray into 

position.
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Chapter 15
Problem solving

This chapter describes how to solve problems which can 
occur when you use the Océ TDS800.
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Introduction

Problems that can occur include:
� Original jams
� Paper jams
� Problems with the Reinforcement Unit
� Problems which you can correct if you follow the instructions on the display
� Other problems

Whenever an error occurs, the display provides the following information:
� What the problem is
� Where the problem occurred
� How to correct the problem

Normally, the paper moves through the system without problems. On the 
graphic display, a cover or door indicates in which part of the system the paper 
has stopped. 

Stickers on some parts of the system indicate which green handles, green 
knobs, green bars and covers, etc. you have to lift, press or open to remove any 
jammed paper.

The display guides you through a sequence of steps to correct the problem. If 
a jam occurs in more than one location, the display will continue to instruct you 
until all jammed paper has been removed.

After you corrected the error, the display gives you instructions on how to 
continue the job.
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Clearing original jams

When you scan and an original jams, the message ‘Original jam’ appears on 
the scanner display. You must remove the original from the scanner.

� Removing a jammed original

1 Press the handle under the original feed table to open the top cover of the 
scanner (see figure 131).

[131] Open the top cover of the scanner

2 Remove the original.
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3 Press the left-hand and right-hand side of the scanner down to close the top 
cover of the scanner (see figure 132).

[132] Close the top cover of the scanner

4 Smooth out and then feed the original.

If original jams occur often:
� Check whether you have used the correct type of original. 
� Check whether you inserted the original along the guide.
� Check whether the original is damaged before you insert it.
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Clearing paper jams

When paper jams, the printing stops and the message ‘paper jam’ appears in 
the display. The error location is shown by flashing covers or doors.

When paper jams:
� Follow the instructions on the display.
� Leave the main power turned on to prevent data loss and correct the paper 

jam as described in the equivalent chapter.
� Remove all the pieces of paper from the machine.

If paper jams occur often, make sure:
� The paper is refilled correctly (see ‘Loading rolls of media’ on page 190).
� The correct paper is used (see ‘Overview of the Océ TDS800 system’ on 

page 244).
� All the pieces of paper are removed from the paper path

Paper jams can occur in:
� The manual feed
� The fuser section
� The roll feed section
� The folder
� The reinforcement unit
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[133] Paper jam section

Paper jam in the manual feed

� Clearing a paper jam in the manual feed

1 Pull the manual feed table toward you to open (see figure 134).
Note: Make sure that you open the manual feed table completely.

[134] Opening the manual feed table

B: roll feed section (see page 225)

C: fusing section (see page 221)

A: manual feed
(see page 220)

D: folding section
(see page 229)
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2 Lift the green lever to open the plate.

[135] Removing the paper

3 Remove all the paper.
4 Lower the plate.
5 Push the manual feed table back into its original position.

Paper jam in the fuser section

� Clearing a paper jam in the fuser section

Caution: When removing paper from the fuser section, always wear the 
heat-resistant gloves. The heat-resistant gloves are in the left hand cover of 
the paper output unit.

1 Remove the output delivery tray (see figure 136).

[136] The output delivery tray
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2 Open the top cover at the rear side (see figure 137).

[137] The top cover at the rear side

3 Pull the green lever toward you to open the output transport unit (see 
figure 138).
Note: If you cannot open the transport unit, you must cut and remove the 
paper.

[138] The lower cover
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4 Pull the green bar of the fuser section toward you to open the fuser section.(see 
figure 139)

[139] The bar of the fuser section

5 Take the crank found on the right-hand cover of the paper output unit.
6 Insert the crank into the slot and turn to the right. The paper is delivered from 

the paper output unit.

[140] The crank

7 If the paper keeps coming, it is not cut and you must cut it manually. 
8 Cut the paper and turn the crank to the right to deliver the paper.
9 Remove the crank and return it to its original position.

10 Pull handle 1 towards you to open the pre-heater section (see figure 141 on 
page 224).

11 Pull green handle 2 towards you and release handle 1 (see figure 141 on 
page 224).
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12 Pull green bar 3 toward you (see figure 141).

[141] The pre-heater section

Do the following to close:
13 Push bar 3 back.
14 Press handle 1 downwards.
15 Press handle 2 back.
16 Close the bar of the fuser section.
17 Close the lower cover of the output unit.

Caution: Do not hold your hand between the green lever and the lower 
cover when you close the cover. The lever moves toward the cover and can 
cause personal injury.

18 Unlock the green bar and close the top cover. 

1
2

3

1

2

3
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If you can't correct the problem, you can open the output transport unit and 
remove the paper (see figure 142 on page 225). If the fuser section covers 
continue to flash on the display, check the fuser section again.

[142] Opening the transport output unit

Paper jam in the paper roll compartments

� Clearing a paper jam in the paper roll compartments

Note: Make sure that you corrected all the problems in the fuser section 
before you correct the problem in the roll feed section.

1 Completely open the correct paper roll compartment. 
2 Remove any jammed paper:

� Behind the chip tray
� Underneath the plate
� Underneath roll 2, roll 4 or roll 6's feed plate

3 Reload the roll if necessary.
4 Close the paper roll compartment.
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Paper jam behind the chip tray

� Removing the paper behind the chip tray

1 Turn the green knob of the chip tray (upper compartment) or the vertical 
transport unit (lower compartment) (see figure 143).

[143] Knob of the chip tray or vertical transport unit

2 Remove all the pieces of material.
or,

3 Lift the chip tray and pull the tray toward you to open the tray (see figure 144).

[144] Opening the chip tray

4 Remove all the pieces of material.
5 Push the chip tray into its original position.
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Paper jam in the vertical transport unit

� Removing the paper in vertical transport unit

1 Open the vertical transport in the lower and middle paper roll compartment 
(see figure 145).

[145] The vertical transport in the lower and middle compartment

2 Turn the green knob to remove all the pieces of material from the vertical 
transport unit.

3 Close the vertical transport.
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Paper jam underneath roll 1, roll 3 and roll 5's triangular feed unit

� Removing paper from underneath roll 1, roll 3 and roll 5's triangular feed 
unit

1 Remove roll 1 (upper compartment) or roll 3 (middle compartment) or roll 5 
in the lower compartment.

2 Pull the feed unit underneath the roll holder and towards you to remove the unit 
(see figure 146).

[146] The triangular feed unit

3 Remove all the pieces of material.
4 Return the triangular feed unit to the correct position. 
5 Close the paper compartment.

Note: If the covers continue to flash on the operator panel, check the roll feed 
section again.
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Paper jam in the first fold section of the folder

� Clearing a paper jam in the first fold section of the folder

1 Open the cover of the first fold section (see figure 147).

[147] The cover of the first fold section

2 Pull the green guide plate lever (A) to the first fold section in order to open this 
section (see figure 148).

[148] Guide plate A of the first fold section

A
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3 Remove all the pieces of material.
4 Open the next guide plate (B) (see figure 149).

[149] Opening guide plate B

5 Remove all the pieces of material.
6 Close guide plate B.
7 Lock guide plate A into the first fold section with the green lever.
8 Close the cover of the first fold section.

� Clearing a paper jam in the folder transport section

1 Open the cover of the transport section to the first fold delivery at the left side 
(see figure 150).

[150] The cover of the transport section to the first fold delivery

2 Remove all the pieces of material.
3 Close the cover of the transport section.

B
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� Clearing a paper jam in the second fold section

1 Open the front door of the second fold section (see figure 151).

[151] The front door of the second fold section

2 Remove all the pieces of material at the bottom of the second fold section.
3 Close the front door of the second fold section.
4 Open the delivery unit (see figure 152).

[152] Opening the delivery unit
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5 Open the guide plate with the green lever (see figure 153).

[153] The guide plate with the green lever

6 Remove all the pieces of material.
7 Open the vertical transport with the green lever (see figure 154).

[154] The vertical transport

8 Remove all pieces of material.
9 Close he vertical transport.

10 Close the guide plate.
11 Close the delivery unit.
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Clearing a paper jam in the high-capacity output unit of the folder

� Clearing a jam in the high capacity output unit of the folder

1 Open the upper and lower doors of the output unit.
2 Press the two knobs and open the plate (see figure 155).

[155] Open the plate

3 Remove all pieces of material.
4 Fasten the plate.
5 Close the top and lower door.
6 Open the lower door. 
7 Press the two knobs on the upper plate and lower the plate (see figure 156).

[156] Lowering the plate
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8 Remove all pieces of material.
If it is not possible to remove the jammed media:

9 Loosening the nuts and removing the plate

[157] Loosen the nuts and remove the plate.

10 Remove all pieces of material.
11 Replace the plate and tighten the nuts.
12 Close the lower door.
13 Open the front door.
14 Lift and remove the waste tray (see figure 158).

[158] Removing the waste tray
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15 Lift the next plate (see figure 159).

[159] Lifting the plate

16 Remove all pieces of material.
17 Open the cover behind the delivery tray for the second fold (see figure 160).

[160] Opening the cover behind the delivery tray for the second fold

18 Remove all pieces of material.
19 Close the cover, lower the plate and position the waste tray.
20 Close the front door.
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Problems with the Reinforcement Unit

If a Reinforcement Unit is installed, the following errors can occur:
� Paper jams
� Tape jams
� No reinforcement strips on the output

This section explains how you can correct these errors.

Clearing paper jams in the Reinforcement Unit

When a paper error occurs, the following message appears: ‘Paper jam’. A 
picture of the printer appears on the display with three flashing doors (see 
figure 161).

[161] Example of a paper jam
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� Clearing a paper jam

1 Open the transport cover of the First Fold delivery and remove all paper inside 
it (see figure 162).

[162] The folder transport section cover 

2 Close the folder transport section cover.
3 Open the front door of the Reinforcement Unit (see figure 163).

[163] The front door of the Reinforcement Unit
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4 Open the top cover of the Reinforcement Unit and remove all pieces of 
material inside the unit (see figure 164).

[164] The top cover of the reinforcement unit

5 Close the top cover and the front door of the Reinforcement Unit.

Clearing tape jams in the Reinforcement Unit

When a tape jam occurs, one of the following messages appears on the display:
� ‘Reinforcing not possible: tape jam’ for copy jobs 
� ‘Re-feed reinforcement tape’ for print jobs.
� ‘Tape jammed in reinforcement unit’ for print and copy jobs while the printer 

was running.

If a tape jam occurs while the printer is running, the message includes a picture 
of the printer. The picture shows  the side door of the Reinforcement Unit 
flashing (see figure 165).

sa

[165] Tape jam in reinforcement unit
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� Clearing a tape jam

1 Open the front door of the Reinforcement Unit (see figure 166).

[166] Opening the front door of the reinforcement unit

2 Turn the two guide plates away from the pin roller into their locked opened 
position (see figure 167).

[167] The two guide plates
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3 Remove all tape between the rollers and knives (see figure 168).

[168] Removing the tape

4 Insert a new trailing strip of tape between the rollers and the knives. For 
complete information refer to ‘Changing the tape roll in the reinforcement 
unit’ on page 198.

No reinforcement strips on the output without an error message

This error occurs when there are no reinforcement strips on the output, even 
though reinforcement is selected. This can happen when the file header 
(Remote Control Format or Océ Job Ticket) contains instructions to have no 
reinforcement.

Note: If you want to process A4 (letter-size) formats, reinforcement can be 
disabled for this format.

� To solve this error

1 Press the Stop key on the operator panel twice.
2 Open the side door of the Reinforcement unit.
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3 Check whether there are loose reinforcement strips in the unit with the 
protection sheet still on(see figure 169).

[169] Situation A: No mechanical error Situation B: Mechanical error

4 If yes, remove the tape strips in the Reinforcement Unit.
If the protection sheet is not on the reinforcement strip (see situation A in 
figure 204), there is no mechanical error and you should insert a new tape roll 
as described in ‘Inserting a new tape roll’ on page 143. If this error occurs 
frequently, you should call the Océ service organization (see ‘Other problems 
(call service)’ on page 184).

5 Removing all tape between the rollers and knives (see figure 170)

[170] Removing the tape

6 Wire a new trailing strip of tape between the rollers and the knives (see 
‘Changing the tape roll in the reinforcement unit’ on page 198).



242 Océ TDS800 User Manual

Other problems 

If you have a problem that you can not correct, call the Océ service 
organization. If this occurs, turn the system off with the main switch and leave 
the system in its current state.
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Overview of the Océ TDS800 system

[171] The Océ TDS800 system

1 The monitor
2 The scanner
3 The scanner operator panel
4 The printer operator panel
5 The printer
6 The folder and stacker unit
7 The output delivery tray
8 The first fold unit
9 The original delivery tray

10 The controller cabinet

1 2 3
4

5 6

7

8

9
10
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Printer operator panel

Ready to print

On-line
key

Stop key

Selection
keys

Arrow
keys

The display
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Scanner operator panel

1 The Exposure control
2 The display
3 The Section keys
4 The Arrow keys
5 The Media selection keys
6 The Manual feed key
7 The Auto roll key
8 The Correction key
9 The Stop key

10 The Job interrupt key
11 The numeric keys
12 The Function keys
13 The numeric display
14 The Start key

1 2
3

4 5

6789121314

10
9



247

Product specifications Océ TDS800

The Océ TDS800 is a wide-format, black-and-white, high-volume 
multifunctional system. The Océ TDS800 offers a broad range of print, copy, 
and scan-to-file functionality.
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Printer
Technology Océ Copy Press with organic photoconductor and LED 

exposure

Resolution 400 dpi

Speed 13 meters p/min. (512'' p/min.) or approx. 10 A0 /min.

Media sources 6 rolls (maximum capacity 200 m (7874'') per roll).
Manual sheet feed from A4 to 36”.
Roll widths 297 mm - 914 mm (11.7'' - 36'')

Output sizes DIN and ANSI formats from A4 to A0 and 36”, up to 200 
meters long (7874'').

Media types Plain, transparent, fluorescent and colored papers; films 
and vellums

Output reception Output Delivery Tray (ODT) for 150 prints

Warm-up time 17 minutes

Electrical requirements 50 Hz / 230 V 3 : 16/12/11 A
50 Hz / 400V 3 : 11/6/7 A
50 Hz / 415V 3 : 11/6/6 A
50 Hz / 200V 3 : 17/12/12 A

60 Hz / 240 V 21 A
60 Hz / 200 V 3 : 18/13/12 A
60 Hz / 208 V 3 : 17/12/12 A
60Hz / 220 V 3 : 17/12/11 A
60 Hz / 240 V 3 : 15/12/9 A
60 Hz / 380 V 3 N: 11/6/6 A
60 Hz / 415 V 3 N: 12/6/6 A

Dimensions Printer 68'' (W) x 45'' (H) x 55'' (D)

Weight 939 kg (2508 lb.)
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Safety approvals TüV GS, CETECOM, CE, UL, (c)UL, CB, FCC Class B

Functionality Multiple prints: up to 999
Automatic Language Sensing (ALS)
Auto roll selection and switching
Print handling: auto-positioning, rotation, auto-scaling
File spooling on the controller
Set memory: send once, process once, print many; capacity 
to store up to 250 A0s and create identical sets sorted by 
page or by set
Concurrent receiving, processing, printing and finishing of 
digital jobs
Sophisticated local and remote user communication 
system with:
Océ Queue Manager application: view status for each job 
and cancel or hold and restart the entire job. Inbox and 
history functionality.
Océ System Control Panel application: view status and 
settings of system components
Océ Settings Editor application: customize system settings

Printer (continued)
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Océ Power Logic® Controller
Platform Océ Power Logic® Controller with embedded Windows 

NT®

Memory 512 MByte RAM standard

Disk space High-speed hard disk dedicated to file spooling. 
High-speed hard disk dedicated to set memory offering at 
least 250 A0 storage capacity.

File formats HPGL, HPGL2, HPRTL, TIFF 6.0, CALS type 1, NIRS, 
EDMICS (C4), CalComp 906/907/951, Adobe® 
PostScript® 3™

Interfaces Standard: Ethernet 10/100 Mbits/s with RJ45
Optional: Ethernet 10 Mbits/s with BNC and SubD; Token 
Ring 4/16 Mbits/s.

Network protocols TCP/IP, NetBEUI (SMB), Novell (IPX, SPX)

Account logging 
(optional)

Records print, copy and scan-to-file jobs by user and 
account number. Information stored in a (ASCII or 
UTF-16) file for later re-use

Job templates (optional) Gives direct access to five different sets of settings on the 
scanner operator panel.

Océ Remote Logic® Applications
Model Local and remote user communication system

Applications Océ Settings Editor:
customize system settings
Océ Queue Manager:
view and edit status for each job, history queue, inbox 
queue.
Océ System Control Panel:
view status and settings of system components

Supported platforms Windows® 95/98/2000 and NT4.0. Apple Macintosh® 
OS, Unix (including Linux, HP-UX 10.20 and 11.00, 
and IBM AIX)

Scanner
Model Free-standing console

Optional: Original delivery tray

Technology CCD, Océ Image Logic® real-time image processing 
hardware

Speed 10 linear meters (394") per minute or approximately 8 A0s 
per minute

Original feed Face-up, and aligned to the left
Automatic feed off/on



251

Originals Automatic original size detection
Width A4 to 36”
Length up to 15 m (591'')

Maximum thickness 1 mm (0.04'')

Exposure control Automatic, manual fine adjustment
Special modes: Lines & Text (default), Photo, Grays & 
lines, Dark Original, Blueprint

Media selection Manual or automatic, based on original size (autodetect) 
and zoom factor.
Auto format detection of ISO and ANSI standard sizes.

Reproduction scale Zoom: 25% - 400% (adjustable in 1% and 0.1% steps)
8 programmable fixed steps
Auto zoom to paper size

Input mode Single sheet
Set (sets processing/set collation)
Multiple sheets

Functionality Concurrent scanning and printing
Multi-copy mode: 1-999 copies (scan once print many)
Pre-programming of next job
Programmable default settings
Programmable custom card
Automatic roll selection
Automatic reduction/enlargement
Standard cut, synchro cut and custom cut modes
Leading and trailing strip adjustment (up to +/- 400 mm, 
15.75'')
Two languages available

Image editing Image align: Horizontal left, middle, right
Image align: Vertical top, middle, bottom
Image shift: horizontal/vertical up to +400 mm (15.75'')
Image mirroring

Noise level 65 dB (A) operating, <45 dB (A) in stand-by

Electrical requirements 50 Hz / 100 V 2.5 A
50 Hz / 230 V 1 A

60 Hz / 100 V 2.5 A
60 Hz / 120 V 2 A
60 Hz / 230V 1 A

Dimensions 52'' (W) x 25'' (D) x 49'' (H)

Weight 166 kg (365 lb.)

Scanner (continued)
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Océ Scan Logic® (optional)
Applications Océ Scan Manager®, integrated scanning solution

platform Océ Power Logic® Controller with embedded Windows 
NT®

Scan destinations 10 programmable destinations
Scan to controller
Scan to network directory
File Transfer Protocol (FTP)

Resolution 200, 300, 400 dpi

Data formats Tiff (G3, G4, uncompressed, tiled, stripped, raw) with 
optimization to filesize or quality
CALS type 1
Optional: Adobe® PostScript® 3™/PDF (G4, 
uncompressed). 5 additional Japanese fonts for 
Adobe® PostScript® 3™ are available as an option.

Scan modes Single scan, stream feed productive batch scanning

File naming Automatically generate unique file names for each scan. 
Determine file name before scanning.

Check print Single/multiple check prints

Viewing View scans at point of scanning

Océ Image Logic® Optimum scan quality with six special original modes. 
“Right first time” productive scanning for larger volumes.

Ease of use Scan to file from scanner panel, scan directly to destination

Options Océ View Station: Edit and enhancement software
Océ Batch Processor: Automated editing software
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Océ Matrix Logic® (optional)
Applications Océ Matrix Logic®, integrated Matrix Copy solution

Platform Océ Power Logic® Controller with embedded Windows 
NT®

Functionality Allows you to form, in one single operation, different copy 
sets from one set of originals

Drivers and job submission software
Océ ADI driver For AutoCAD® 12, 13, 14,

Windows® 3.x, 95/98/2000 and NT 4.0

Océ HDI driver For AutoCAD® 2000
Windows® 95/98/2000 and NT 4.0

Océ Windows driver Windows® 95/98/2000 and NT 4.0

PostScript Level 3
drivers

For Windows® 95/98/2000 and NT 4.0
Macintosh® OS 7.x/8.x

Océ Print Exec LT® Single seat job submission software for Windows® 
95/98/2000, NT 4.0, and Millennium

Océ Print Exec LT Web® Multi-seat job submission and back channel 
communication software using standard web browsers: 
Internet Explorer® 4.02 SP2 or higher and Netscape® 4.08 
or higher

Optional: Integrated Folder and reinforcement unit
Folding methods Standard (DIN), Ericsson, Afnor-like

Fan fold or fan fold & cross fold
Length: 276 - 310 mm (10.9'' - 12.2'')
Width: 186 - 230 mm (7.3'' - 9'')
Binding strip: 15 - 30 mm (0.6'' - 1.2'')

Paper size Width: 279 - 914 mm (11'' - 36'')
Length: 210 - 2500 mm (8.3'' - 98.4'')
210 - 2,500 mm (8.3'' - 98.4'') for fan fold and cross fold at 
75 grams (19 lb. bond),
up to 6000 mm (236'') fan fold only at 75 grams (19 lb. 
bond)

First fold exit Extra bin for fanfold

Noise level < 67 dB(A) operating; 0 dB(A) stand-by

Dimensions 96'' (W) x 1560, 61'' (D) x 55'' (H) (excluding 
reinforcement unit including printer)
1-1'' (W) x 61'' (H) x 55'' (D) (including reinforcement unit 
and printer)
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Weight 124 kg (273 lb.) unpacked excluding reinforcement unit
154 (339 lb.) unpacked including reinforcement unit

Optional features Reinforcement unit
Punch unit
2 Belt delivery trays for 100 A0

Optional: Original/Output delivery tray
Model Wheeled delivery tray with blower unit

Capacity Up to 200 prints or originals (media type dependent)

Electrical requirements 100-120 / 200-230V, 0.3A, 50/60Hz

Types of media Plain paper, transparent paper, film, vellum and polyester

Dimensions 46'' (W) x 84'' - 53'' (H) x 40'' (D)

Weight 44 kg (97 lb.)

Optional: Delivery Belt Unit
Single belt unit Delivery belt with offset stacking

Belt capacity: approximately 170 folded A0s at 75 g/m2 
(19 lb. bond)

Optional features Second delivery belt
Belt capacity: 170 folded A0s at 75 g/m2 (19 lb. bond)
Punching unit Europe (2 or 4 holes)
Punching unit USA (3 holes)

Mains supply From printer

Dimensions Required floor space: 68'' x 67''

Weight 125 kg (275 lb.) (one belt unit without puncher)
40 kg (88 lb.) (second belt)
10 kg (22 lb.) (puncher)

Optional: Integrated Folder and reinforcement unit (continued)
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List of available material types and sizes

Océ machines and materials are matched for optimal quality and performance. 
We therefore recommend you use only approved Océ materials in the Océ 
TDS800.
A full list of Océ materials suited for use in the Océ TDS800, including plain 
paper, transparent paper, colored papers and various polyester films is 
available from your Océ representative.

Material types  The following material types are available for the Océ TDS800:

Overview of print material that can be used
Plain paper 60 to 110 g/m2 (15 to 27 lb. 

bond)

Transparent paper 80 to 110 g/m2 (20 to 27 lb. 
bond)

Vellum 16 - 20 lbs

Polyester film 3.5 or 4.5 mil

Top label ECF 60 g/m2 (15 lb. bond)

Special colored paper, etc.

Minimum Maximum

Width 210 mm (8.27'') 914 mm (36'')

Length 279 mm (11'') 15 m (591'')
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Material sizes  The following material sizes are available for the Océ TDS800:

Attention: Avoid storing paper in rooms where temperature and humidity 
are high. Also, avoid dust and direct sunlight. Wrap unused paper in plastic 
in order to prevent it from absorbing moisture.

Overview of material sizes that can be used
Format Width Length Format Width Length

ISO range ANSI range

A4 portrait 
with manual 
sheet feed

210 mm 297 mm A portrait 8.5” 11”

A3 297 mm 420 mm B 11” 17”

A2 420 mm 594 mm C 17” 22”

A1 594 mm 841 mm D 22” 34”

A0 841 mm 1189 mm E 34” 44”

Format Width Length Format Width Length

ANSI PLUS 
range

Others

A+ portrait 9” 12” 30” 30” 42”

B+ 12” 18” B1 700 mm 1000 mm

C+ 18” 24” B1+ 707 mm 1000 mm

D+ 24” 36” B2 500 mm 700 mm

E+ 36” 48” B2+ 500 mm 707 mm

Overview of paper series
Paper series Formats included

ANSI Mixed 8.5” 
- 9”

11” 
- 
12”

17” 
- 
18”

22” 24” 30” 34” 36”

ANSI Small 8.5” 11” 17” 22” 24” 30” 34” 36”

DIN Carto A4 A3 A2 B2_700 A1 B1_700 A0 36”

DIN A4 A3 A2 B2_707 A1 B1_707 A0 36”
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Reinforcement strips

Information about the different reinforcement strips is available from your Océ 
representative.

Attention: Only use the original reinforcement strips from Océ to avoid 
damaging the reinforcement unit.
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General safety information

For questions about Océ products which are related to health, safety and the 
environment, please contact your Océ organization at the address listed in the 
last appendix of this manual.

Radio interference

Note: This equipment has been tested and found to comply with the limits for a 
class A device, pursuant to part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the user manual, may cause harmful interference 
to radio communications. Operation of this equipment in a residential area is 
likely to cause harmful interference in which case the user will be required to 
correct the interference at his own expense.

FCC = Federal Communications Commission.

Symbols

Stickers with the following illustrations are used in this machine to indicate 
parts which should not be touched due to high voltage or extreme heat, or parts 
which require extra attention:

Symbol Meaning

Caution, high voltage

Caution, high temperature

Caution
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Instructions for safe use

Attention: Products designed by Océ are developed and tested in 
conformance with the strictest international safety standards. However, to 
help assure the safe operation of these products, it is important that:

� You carry out maintenance only as far as prescribed in this manual.
� You observe the following safety recommendations:

Maintenance  

� Do not remove any screws from fixed panels.
� Do not place any liquids on the machine.
� Use maintenance materials or other materials for their original purpose only. 

Keep maintenance materials away from children.
� To avoid damage and the risk of personal injury, all modifications to Océ 

equipment are strictly reserved for properly qualified and trained service 
technicians.

Power connection  

� Do not move the machine yourself, but contact your Customer Service. 
� If unforeseen circumstances force you to re-install the machine without the 

assistance of Océ Service, make sure that the machine is connected to a 
power outlet which is equipped with a fuse or circuit breaker with the 
appropriate capacity.

� Do not bridge any mechanical or electrical circuit breakers.
� Do not use an extension cord to connect the machine.
� It is recommended to connect only those copy-control products (or other 

products) which meet the (inter)national product safety and radio frequency 
interference standards, and to use an attachment cable as specified by Océ.

� This equipment is not designed for connection to an IT power system. (An 
IT power system is a voltage network in which the neutral wire is not 
connected to earth.)

� For equipment connected via a wall outlet: place the machine close to an 
easily accessible wall outlet.

� For equipment connected to the electrical system via a permanent 
connection: make sure that the disconnect device in the permanent 
connection is easily accessible.
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Ventilation and location  

� Do not block the ventilation openings of the machine.
� Make sure that the machine is placed on a level, horizontal surface which is 

strong enough to bear the full weight of the machine. See the Océ TDS800 
safety data sheet in this appendix for information about the weight of the 
machine. 

� Make sure that there is sufficient space around the machine. This facilitates 
both proper loading of materials and equipment maintenance.

� Do not place the machine in a room which is subject to excessive vibration.
� Do not place the machine in a room that is too small and insufficiently 

ventilated. See the Océ TDS800 safety data sheet in this appendix for 
information about space and ventilation requirements.

General  

� Always use materials recommended by Océ and developed for this Océ 
machine. Materials not approved by Océ may cause damage to your 
machine.

� Do not use the machine if it is making unusual sounds. Remove the plug from 
the power outlet or turn off the switch in the fixed connection to the electrical 
system and contact Service.

Note: This is a class A product. In a domestic environment this product may 
cause radio interference in which case the user may be required to take 
adequate measures
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Safety data sheet for the Océ TDS800

Disclaimer  This safety data sheet was compiled as a compact guide to safe 
product handling and operation, and to the best of our knowledge contains the 
most complete and accurate information possible. We reserve the right to 
revise this safety data sheet as new information becomes available. It is the 
user’s responsibility to determine the suitability of this information for the 
adoption of the appropriate safety precautions for his organization, and to 
contact Océ to make sure that he is in possession of the latest version of the 
sheet. If and insofar as limitation of liability is permitted under the applicable 
laws, we accept no liability for any inaccuracies in this safety data sheet.
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Safety data sheet Océ TDS800 print engine

The content of this safety data sheet is subject to the disclaimer of liability on 
page 263 of this manual.

PRODUCT SAFETY DATA SHEET

Number E-730-a-US
Date January 2001

Copyright © 2001 Océ-Technologies B.V., Venlo, NL

Model Océ TDS800 printer engine

Description Electrophotographic printer, console model, plain paper, organic photoconductive drum,
powder toner .

Max. process speed 13 m/min

Dimensions Width 1720 mm
Depth 1146 mm
Height 1400 mm

Weight 939 kg

Voltage 240 V 240 V 208 V 220 V 380 V 415 V
Frequency 60 Hz 60 Hz 60 Hz 60 Hz 60 Hz 60 Hz
Current-rated 21 A 15/12/9 A 17/12/12 A 17/12/11 A 11/6/6 A 11/6/6 A
Power consumption, low power 495 W
Power consumption, stand by 820 W
Power consumption, operation 4100 W
EPA ENERGY STAR ®
* Power consumption sleep mode 13 W (without controller)
Mains connection Cables with plug
Safety class I (IEC 536) Protective earth connection
Protection class IP 20 (IEC 529)

Sound pressure level
(at bystander position)

Standby In operation
43 dB(A) main body 53 dB(A)

impulse Li = 1 dB(A)
Sound power level 59 dB(A) main body 70 dB(A)
Radio interference Complies with Directive 89/336/EEC and FCC rules and regulations, part 15 Class A.
Radiation Below the Threshold Limit Values for UV, Visible and IR radiation (TLV list of ACGIH)
Heat emission Standby 820 W; at continuous operation 4,1 kW
Ozone emission 0,02 mg/min at continuous operation

Room volume Recommendation: min. 75 m3

Room ventilation Recommendation: min. 37,5 m3/h (natural ventilation)
For heat evacuation extra ventilation may be necessary

Use simulation at random
operation

Room volume and ventilation as recommended
Daily copy volume (much more than average) 1200 m2

Total worktime 8 h
Ozone concentrations:
- Time weighted average < 0,001 mg/m3 (<0,0005 ppm)
- Peak 0,0015 mg/m3 ( 0,0008 ppm)

Threshold Limit Value/Occupational Exposure Limit
(Time Weighted Average) for ozone 0,2 mg/m3 (0,1 ppm)
Odour Perception Limit for ozone 0,04 mg/m3 (0,02 ppm)

Consumables Océ9800 OPC (OcéSafety Data Sheet E-194)
OcéE1 Toner (OcéSafety Data Sheet E-198)
OcéCopying Materials

Additional safety information The ozone filter does not have to be replaced to keep the ozone concentration in the
workplace below 0,04 mg/m3 (i.e. the life of the filter equals that of the apparatus).

Listed according to standard UL 1950 and CAN/CSA-C22.2 No.950 EPA ENERGY STAR ®

LISTED 927F
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Safety data sheet Océ TDS800 scanner

The content of this safety data sheet is subject to the disclaimer of liability on 
page 263 of this manual.

PRODUCT SAFETY DATA SHEET

Number E-729-a-US
Date January 2001

Copyright © 2001 Océ-Technologies B.V., Venlo, NL

Model Océ TDS800 Scanner

Description Freestanding scanner, maximum original size 1036 mm x 6000 mm
Max. process speed 10 m/min

Dimensions Width 1320 mm
Depth 640 mm
Height 1235 mm

Weight 147 kg

Voltage 120 V 230 V
Frequency 60 Hz 60 Hz
Current-rated 2 A 1 A
Power consumption,stand by 165 W
Power consumption, operation 180 W at continuous operation
EPA ENERGY STAR ®
* Power consumption low power 7 W
Mains connection Cable with plug
Safety class I (IEC 536) Protective earth connection
Protection class IP 20 (IEC 529)

Sound pressure level
(at operator position)

Standby In operation
43 dB(A) main body 53 dB(A)

impulse Li = 9 dB(A)
Sound power level 56 dB(A) main body 68 dB(A)
Radio interference Complies with Directive 89/336/EEC and FCC rules and regulations, part 15 Class A.
Radiation Below the Threshold Limit Values for UV, Visible and IR radiation (TLV list of ACGIH)
Heat emission Standby 165 W; at continuous operation 180 W
Ozone emission Not applicable

Room volume No special requirements
Room ventilation

Consumables Not applicable

Additional safety information None

Listed according to standard UL 1950 and CAN/CSA-C22.2 No.950 EPA ENERGY STAR ®

LISTED 927F

INFORMATION
TECHNOLOGY
EQUIPMENT

E 69871
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EPA ENERGY STAR®

Océ-Technologies B.V. has joined the ENERGY STAR® Program of the United 
States Environmental Protection Agency (EPA). The purpose of the ENERGY 
STAR® Program is to promote the manufacturing and marketing of 
energy-efficient equipment, thereby potentially reducing combustion-related 
pollution.

As an ENERGY STAR® Partner, Océ-Technologies B.V. has determined that the 
below-mentioned configurations of the Océ TDS 800 meet the ENERGY 
STAR® guidelines for energy efficiency:
� Océ TDS 800 Printer, consisting of printer engine, controller and monitor.
� Océ TDS 800 Copier, consisting of printer engine, scanner, controller and 

monitor.
� Océ TDS 800 Scanner.

The ENERGY STAR® Criteria involve below-mentioned features.

The use of the power management features prevents unnecessary power 
consumption and offers economical and environmental benefits.

low power mode  The Océ TDS 800 Copier and Multifunctional Digital 
System enter automatically the low power mode 15 minutes after the last 
copy/print is made. The low power default time can be adjusted by the key 
operator to between 15 and 240 minutes.

sleep mode   The Océ TDS 800 Printer, Copier and Multifunction Device enter 
automatically the sleep mode 90 minutes after the last copy/print is made. The 
sleep default time can be adjusted by the key operator to between 15 and 240 
minutes.

During the sleep mode of the Océ TDS 800 the controller remains in operation.

It is suggested to determine the appropriate default times for your work pattern 
by changing the setting in steps of 30 minutes and testing each setting for at 
least a week.

Only if this limit of 240 minutes still causes sizable inconvenience, due to your 
particular work pattern, the key operator can disable the sleep mode. 
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power consumption data   The controller in below-mentioned products is a 
functionally integrated computer.

Note: (1) Without controller, as defined for Tier 1 in the Printer/Fax MOU 
Version 3.0.

Note: (2) As defined in the MFD MOU Amendment #1, the sleep mode power 
of an ENERGY STAR® computer (35 Watts) has been subtracted from the 
measurement result of 115 Watt.

Note: (3) MDS = Multifunctional Digital System, consisting of printer engine, 
scanner, controller and monitor.

ENERGY STAR® is a U.S. registered mark.

Power data
Low Power 
mode
(Watts)

Low Power 
recovery  time 
(seconds)

Sleep Mode
(Watts)

Océ TDS 800 Printer N.A N.A.  13 (1)

Océ TDS 800 Copier 752 35  80 (2)

Océ TDS 800 MDS (3) 752 35 115
Océ TDS 800 Scanner    7 N.A. N.A.
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Notation conventions

There are a number of notation conventions used in this manual. This 
consistent style enables you to quickly become conversant with the use of this 
manual and consequently the Océ TDS800.

Description  Each section or subsection contains a description of the feature or 
operation identified in the title. It might also include possible applications, as 
well as any guidelines that you should bear in mind.

Procedures  A description is followed by a procedure. A procedure always 
begins with a phrase which briefly describes the procedure, followed by a 
series of numbered steps that take you, step by step, through all phases of 
performing the operation. 

Figures and tables  Figures and tables are titled and numbered sequentially 
throughout this manual. Figures include pictures of product components, 
screenshots, examples, and diagrams of concepts discussed in the description.

Attention getters  There are several types of information to which we draw 
your attention. This information is classified as follows:

Note: In a ‘Note’, information is given about matters that ensure the proper 
functioning of the machine or application, but useful advice concerning its 
operation may also be given.

Attention: The information that follows ‘Attention’ is given to prevent 
something (your copy or original, the copier or printer, data files etc.) from 
being damaged.

Caution: The information that follows ‘Caution’ is given to prevent you 
from suffering personal injury. 
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Reader's comment sheet

Have you found this manual to be accurate?
❏ Yes
❏ No

Could you operate the product after reading this manual?
❏ Yes
❏ No

Does this manual provide enough background information?
❏ Yes
❏ No

Is the format of this manual convenient in size, readability and arrangement 
(page layout, chapter order, etc.)?
❏ Yes
❏ No

Could you find the information you were looking for?
❏ Always
❏ Most of the times
❏ Sometimes
❏ Not at all

What did you use to find the required information?
❏ Table of contents
❏ Index

Are you satisfied with this manual?
❏ Yes
❏ No

Thank you for evaluating this manual. 
If you have other comments or concerns, please explain or suggest 
improvements on the back of this sheet or on a separate sheet.
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Comments:

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------
Date:

This reader's comment sheet is completed by: 
(If you prefer to remain unknown, please fill in your occupation)

Name:

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to:

Océ-Technologies B.V.
For the attention of ITC User Documentation.
P.O. Box 101,
5900 MA Venlo
The Netherlands

Send comments by E-mail to : itc-userdoc@oce.nl

For the addresses of local Océ organizations, see: www.oce.com
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Addresses of Océ organizations

Océ-Australia Ltd.
P.O.Box 363
Ferntree Gully MDC VIC 3165
Australia

Océ-Österreich GmbH
Postfach 95
1233 Vienna
Austria

Océ-Belgium N.V./S.A.
Avenue J.Bordetlaan 32
1140 Brussels
Belgium

Océ-Brasil Comércio e Industria Ltda.
Caixa Postal 3187
01060-970 Sao Paulo, SP
Brazil

Océ-Canada Inc.
4711 Yonge Street, Suite 1100
Toronto, Ontario M2N 6K8
Canada

Océ Office Equipment (Beijing) Co Ltd.
No. 138 Wan Fu Jong Dajie
T1-719 Sun Dong An Plaza
Beijing 100006
China

Océ-Česká republika s.r.o.
Hanusova 18
14021 Praha 4
Pankrác,
Czech Republic

Océ-Danmark A.S.
Vallensbaekvej 45
DK 2605 Brøndby
Denmark

Océ-France S.A.
32, Avenue du Pavé Neuf,
93161 Noisy-le-grand, Cedex
France

Océ-Deutschland GmbH
Postfach 101454
45414 Mülheim an der Ruhr 
Deutschland

Océ (Hong Kong China) Ltd.
12/F 1202 The Lee Gardens
33 Hysan Avenue, Causeway Bay
Hong Kong

Océ-Hungária Kft.
P.O.B. 237
1241 Budapest
Hungary

Océ-Italia S.p.A.
Strada Padana Superiore 2/B
20063 Cernusco sul Naviglio (MI)
Italia

Océ Systems (Malaysia Sdn. Bhd.)
#3.01, Level 3, Wisma Academy
Lot 4A, Jalan 19/1
46300 Petalig Jaya
Malaysia



274 Océ TDS800 User Manual

Océ-Nederland B.V.
P.O.Box 800
5201 AV 's-Hertogenbosch
The Netherlands

Océ Norge A/S
Postboks 53, Grefsen
0409 Oslo 4
Norway

Océ-Poland Ltd.
ul. Łopuszańska 53
02-232 Warszawa
Poland

Océ-Lima Mayer S.A.
Av. José Gomes Ferreira, 11
Ed. Atlas II Miraflores
1495-139 Algés
Portugal

Océ (Far East) Pte. Ltd./
Océ (Singapore) Pte. Ltd.,
#03-00 Wisma Gulab
190 MacPherson Road
Singapore 348548

Océ España SA
Business Park MAS BLAU
C/Osona 2, 2-3a Planta
08820 El Prat del Llobregat (Barcelona)
Spain

Océ-Svenska AB
P.O.box 754
S-191 27 Sollentuna
Sweden

Océ-Schweiz AG
Sägereistrasse 29
CH8152 Glattbrugg
Switzerland

Océ (Taiwan) Ltd.
No. 99-24 Nan Kang Road Sec.2
Taipeh, Taiwan
Taiwan, RO

Océ (Thailand) Ltd.
16th Floor, B.B. Building
54 Asoke Road, Sukhumvit 21
Bangkok 10110
Thailand

Océ-U.K.Ltd.
Langston Road
Loughton, Essex IG10 3SL
United Kingdom

Océ-USA Inc.
5450 North Cumberland Av.
Chicago, Ill. 606556
U.S.A.
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Index

A
account logging 58, 156

retrieve the account log file 159
adobe postscript 3 /pdf 15, 22
applications

queue manager 20
settings editor 21
system control panel 21

arrow keys 46
auto align 100
auto roll 44
automatic logon 149
available material types and sizes 255

B
background compensation 98
belt unit 178, 183, 185

side guides 185
binding strip 180
brightness 97

C
cancel a print job 39
checkprint 71
chip tray 190, 195
clearing the system 129
command line parameters 150
connecting to a controller 153
continue a print job 39
controller

start-up 24
copy jobs 52

define settings 58
next original 58
non-standard size originals 92
special originals 92

copy size 93

custom card 119

D
delete a scanned file 83
deleting a destination 81
deleting print jobs 137
destination card 70
drawing method 179

E
editing an image 100
exposure 44, 53

F
folded package length 180
folded package width 179
folder

belt unit 178, 183
folding settings 179
punch unit 178
reinforcement unit 178

folding 47, 53
folding length

maximum 182
folding method 179
folding settings 179, 182
ftp 84

printing 17
retrieve the account log file 159
retrieving files 85

function keys 46

G
green key principle 16

H
history queue 133
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I
import the account log file 160
inbox queue 133
installing remote logic 141

apple macintosh 145
microsoft windows 141
unix 143

J
jams 219
japan support

fonts 15
japanese support

destination names 80
fonts 22

job interrupt 45, 51, 60
job recovery 16

K
key operator settings 111

L
loading a roll 193
loading paper 190
loading rolls of media 190
locking a destination 80
log file 156
log off 148
log record 161
logging on 148

M
managing print jobs 137
manual feed 44

copy jobs 59
manual feed 59
matrix logic 106
media display 127

media selection 44, 53
mirror image 103
moving a job to the top 138

N
non-standard size 92
non-standard sized originals 92

O
original type 99

P
paper jam 219

high capacity output unit of the folder 233
manual feed 220

paper series 52, 54, 194
password 149
pdf 15, 22, 72

compression 73
print a scanned file 83
print configurations 173
print exec lt web 17
print exec lt web 169

creating a new job - advanced 175
creating a new job - basic 174
welcome page 176

print queue 133, 137
printer 14, 29

counter 34
graphical display 33
keys 34

on-line 35
selection keys 35
stop 35, 60
up/down keys 35

media selection 194
operator panel 32
select a language 32
setting media types and sizes 36

printer operator panel actions 36
printer settings
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media types and sizes 36
setting a special media indication 36

printer status display 127
problems

original jam 216
other 216, 242
paper jam 216
reinforcement unit 216

product specifications 247
prompting for file name 82
properties of a scanned file 83
punch unit 178, 186

Q
queue manager

active print job window 132
deleting print jobs 137
functionality 20, 132
history queue 133
inbox queue 133
introduction 20
menu bar 132
moving jobs to top 138
pausing print jobs 138
print queue 133
putting print jobs on hold 138
remote workstation 132
restarting jobs that are put on hold 138
restarting paused print job 138
structure 132
user modes 135
view print queue 137
window 134

R
reference roller 208
reinforcement unit 178, 183

inserting a new tape roll 198
maintenance 210
problems 236
waste box 210

remote logic
add a controller 153

applications 140
command line parameters 150
connecting to a controller 153
help 150
how to use 153
language 150

repro operator settings 111
restarting a paused print job 138
restarting jobs that have been put on hold 138
retrieve the account files

ftp 158
retrieving scanned files 84

ftp 84
retrieving the account files 158
roll holder 190, 193
roll loader 193

S
safety information 261
scan clicks 67
scan jobs

filing strip 94
image quality 97
leading and trailing strip 95

scan logic 66
scan manager 75

deleting a destination 81
destination 76

lock 80
unlock 81

destination properties 81
file properties 77
local destination 78

retrieving files with ftp 85
network destination 79
table view 77
temporary store 84
tree view 76
web destination 80

scan width 92
scanned files 82
scanner

display
image card 98
original section 98

exposure control 44
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input mode 55
keys

auto roll 44
correction key 45
job interrupt 45
manual feed 44
numeric keys 45
start key 45
stop key 45

media selection 52
mirror an image 74
numeric display 45
operating panel 43
operator panel

change language 48
destination card 70
file section 71
image card 70
sections 47

reference roller
clean 208

zoom 56
scanner

keys
media selection 44

scanner status display 127
scan-to-file 66, 68

destination 68, 71
ftp 80
local 78
smb 79

enable 66
file format 72

cals 72
pdf 72
tiff 72

file name 82
file properties 77
local destination

retrieving files with ftp 85
optimization 74

file size 74
scan quality 74

resolution 73
settings 70
zoom 74

section keys 46
set copy 55, 105

set memory meter 127
setting dependencies 111
settings

scanner operator panel 50
settings editor

access the settings editor 117
apply 114
menu bar 113
settings area 116
status bar 117
tree structure 116
undo 114
update area 116

shifting the image 102
special media indication 38
spool memory 16
standard cut 101
start key 53, 105
stop a copy job 60
stop a print job 39

stop key 39
synchro cut 101
system administrator settings 111
system control panel 126

icons 128
structure 126

T
templates 50
temporary store 84
tiff subformat 72

compression 72
organization 72

timers 25, 121
toner 196

add 196
turn on and off 23

U
unlocking a destination 81
user interaction 16
user modes 117, 147
users 18
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anonymous user 18
key operator 18, 21
repro operator 18
service operator 18
system administrator 18, 21

V
view a scanned file 82

automatically 84
view station lt 66, 87

view a scanned file 69
view error 90

W
warm-up 24
waste box 210


	Table of Contents
	Chapter 1 Introduction
	About this manual
	The Océ TDS800
	Océ TDS800 key concepts
	User interaction
	Océ TDS800 users
	Océ TDS800 components
	Océ TDS800 printer
	Océ TDS800 scanner
	Océ TDS800 Power Logic® Controller
	Turning the Océ TDS800 on and off
	Timers

	Chapter 2 Use the Océ TDS800 to print
	Before you begin
	How to print
	Printer operator panel
	Select a language
	Display
	Counter
	Keys
	Printer operator panel actions
	Media types and sizes on the printer
	Special media indication
	Stop a print job

	Chapter 3 Using the Océ TDS800 to copy
	Before you begin
	Scanner operator panel
	Section, Function and Arrow keys
	Sections on the display of the scanner operator panel
	Changing the operator panel language
	Settings on the Océ TDS800 scanner operator panel
	Performing basic copy jobs
	Making copies
	Select the required media
	Select the input mode
	Specify the zoom factor
	Define settings for the next original
	Account logging
	Using the manual feed for copy jobs
	Stopping a job
	Job interrupt

	Chapter 4 Using the Océ TDS800 to scan to file
	Before you begin
	Scanner operator panel
	Océ Scan Logic®
	Scan clicks
	Make a scan-to-file
	Settings for scan-to-file
	File mode
	Destination
	File format
	Tiff sub format
	PDF compress
	Resolution
	Zoom
	Optimization
	Mirror
	Océ Scan Manager
	Tree view
	Table view
	Actions in Océ Scan Manager
	Destinations
	Prompting for file name
	Scanned files
	Manage the temporary store
	Retrieving scanned files
	Océ View Station LT®
	Menu options
	Function buttons
	View error

	Chapter 5 Special copy and scan jobs
	Non-standard size originals
	Scan width
	The copy size
	Scanning originals with filing strip
	The image quality
	Brightness
	Automatic background compensation
	Editing functions
	Auto align
	Shifting the image
	Mirror image
	Making a set copy
	Océ Matrix Logic®
	The Océ Matrix Logic®application

	Chapter 6 Océ Power Logic®: Settings Editor
	Introduction
	Océ Settings Editor
	General structure
	Menu bar
	Top toolbar
	Left toolbar
	Settings area
	Status bar
	How to access the Océ Settings Editor
	Start the Océ Settings Editor
	Performing actions from the Océ Settings Editor
	Key Operator settings
	System Administrator settings

	Chapter 7 Océ Power Logic®: System Control Panel
	Introduction
	Structure
	Icons
	User actions

	Chapter 8 Océ Power Logic®: Queue Manager
	Introduction
	Structure
	Modes
	Icons
	Managing print jobs

	Chapter 9 Océ Power Logic®: Remote Logic
	Introduction
	Installation procedure for Microsoft® Windows systems
	Installation procedure for Unix systems
	General installation instructions
	IBM AIX
	HP-UX
	Linux
	Installation procedure for Apple Macintosh®
	Using Océ Remote Logic®
	User modes
	Logging on
	Log off
	Changing the password
	Automatic logon
	Language
	Help
	Command line parameters
	Using the remote system

	Chapter 10 Océ Power Logic®: Account logging
	The account logging functionality
	Enabling the Account logging option
	The account log file
	Specify the correct account for a job
	Retrieving the account files
	Using the generated accounting file
	Account information in the log file
	Account information for the media format
	Account information for media weights
	Structure of the account file
	Description of all the parameters in the account log file

	Chapter 11 Océ Print Exec® LT Web
	Introduction to Océ Print Exec® LT Web
	Basic concepts
	Requirements for the user browser software
	Requirements for the network infrastructure
	Connecting to the Print Exec® LT Web
	Creating new jobs
	Welcome page

	Chapter 12 The folder
	Introduction
	Folder
	Reinforcement unit
	Belt unit
	Full belt detection

	Chapter 13 Media and supplies
	Loading rolls of media
	Clear the chip tray
	Adding the toner
	Changing the tape roll in the reinforcement unit

	Chapter 14 Maintenance
	Cleaning the reference roller
	Maintenance of the Reinforcement Unit
	Clearing the waste box
	Cleaning the reinforcement knives

	Chapter 15 Problem solving
	Introduction
	Clearing original jams
	Clearing paper jams
	Paper jam in the manual feed
	Paper jam in the fuser section
	Paper jam in the paper roll compartments
	Paper jam behind the chip tray
	Paper jam in the vertical transport unit
	Paper jam underneath roll 1, roll 3 and roll 5's triangular feed unit
	Paper jam in the first fold section of the folder
	Clearing a paper jam in the high-capacity output unit of the folder
	Problems with the Reinforcement Unit
	Clearing paper jams in the Reinforcement Unit
	Clearing tape jams in the Reinforcement Unit
	No reinforcement strips on the output without an error message
	Other problems

	Appendix A Overview and tables
	Overview of the Océ TDS800 system
	Printer operator panel
	Scanner operator panel
	Product specifications Océ TDS800
	List of available material types and sizes
	Reinforcement strips

	Appendix B Safety information
	General safety information
	Radio interference
	Symbols
	Instructions for safe use
	Safety data sheet for the Océ TDS800
	Safety data sheet Océ TDS800 print engine
	Safety data sheet Océ TDS800 scanner
	EPA Energy Star®

	Appendix C Miscellaneous
	Notation conventions
	Reader's comment sheet
	Addresses of Océ organizations

	Index

